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ASSY Manufacturing 

There are three ASSY Manufacturing Types, ASSY1, ASSY2, and ASSY3. The ASSY manufacturing types are 
used for assembly operations, where an item may go through several processes before it is considered a 
finished good. Each of these MFG Types utilize BOMs with processes attached that call out work centers, 
tools, labor and quality requirements. These processes can be reused over and over simply by attaching 
them to multiple BOM’s. Employees can clock into specific processes and record the number of items 
that have been processed. For ASSY1 and ASSY2 the components are backflushed at the time of labor 
reporting. For ASSY3 components are backflushed at final assembly by default, unless the 'Backflush Each 
Process' option is checked for the MFG Type. The actual labor is collected and the progress of each work 
order and its processes can be tracked using the Assembly Track and AssemblyData modules. Final 
Assemblies (dispositions of finished goods) is reported using AssemblyData or the Assembly Track 
modules (not production reporting).   

Below describes the basic differences between the three ASSY MFG Types. The main differences lie in 
the way they are finite scheduled. 
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MFG 
Type 

 

Work Centers BOMs Finite Scheduling Reporting Production 

ASSY1 Work Centers are 
associated to the 
processes, No 
Assembly Lines 

No work center or 
Assembly Line is 
associated to the BOM 

Processes are scheduled on 
work centers in scheduling 

Labor reporting is done for 
each process and 
components are backflushed 
during labor reporting 

ASSY2 Work Centers are 
associated to the 
processes, and to the 
Assembly Line 

No work center or 
Assembly Line is 
associated to the BOM 

Processes are scheduled on 
work centers in scheduling 
similar to ASSY1 except only 
the work centers that are 
attached to the assembly 
line are available for auto 
loading. The system first 
determines the Assembly 
Line based on the first 
process and then limits the 
available work centers to 
those assigned to the 
assembly line. 

Labor reporting is done for 
each process and 
components are backflushed 
during labor reporting 

ASSY3 Work Centers are 
associated to the 
processes, and to the  
Assembly Line 

An Assembly Line is 
associated to the BOM 

Work orders are scheduled 
on work centers in 
scheduling 

By default, Final Assembly is 
used to report production. 
Items are added into 
inventory and material 
attached to each process is 
backflushed. Users can enter 
good parts and labor for each 
process. 

Optionally, components can 
be backflushed when 
reporting labor instead of at 
final assembly if the 
'Backflush Each Process' 
option is checked for the 
MFG Type. 

Note: There is an 'Assembly' MFG Type available but it is based on the Generic MFG Type. It does not 
apply to the ASSY MFG Types. It conforms to the Generic MFG Type except the cycle time for the 
Assembly MFG Type defaults to hours instead of seconds. 
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Set Up 

ASSY Manufacturing Types 

The ASSY1, ASSY2 and ASSY3 manufacturing Types, or user defined equivalents must be added as an 
available type to choose from when creating Bills of Manufacture. The ASSY manufacturing types are 
added on the MFG Types list. To access Mfg Types go to Sys Setup->System Parameters->Lists. (This list is 
also available from the BOM form in the Configure menu). 
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To Add the ASSY  Manufacturing Type, follow the steps below: 

Click on the ADD [+] function key located on the Navigator bar. 

From the ‘Select Mfg Type’ form choose ASSY1, ASSY2, or ASSY3 from the Predefined tab, or create a 
user defined MFG Type.  

Note: For JobShop for Assembly Manufacturing, the user defined MFG Type cannot be called JOBSHOP 
because there is already a system defined JOBSHOP MFG Type used for the original JobShop module. 

User Defined - This tab is used to create user defined manufacturing types. Enter the name in the Mfg 
Type field and select the manufacturing type the user defined type should default to from the drop down 
list of system supported manufacturing types. Once the manufacturing type is selected, the options on 
the right side of the MFG Types screen will be updated based on the selected default type. When a user 
defined type is created without having the predefined ASSY type created, the system will still make the 
Assembly Track and Assembly Process Maintenance modules visible after logging back in. 

Report Names Assign the appropriate reports by clicking on the button to right of these fields and 
selecting the report from the list.  Or use the Assign Default Report Names speed 
button at the top of the form to assign the default BOM and WO reports. (This does not 
assign any of the other reports). 

The reports can be EPlant specific if desired. Select the EPlant ID and then select the 
report using the search button. When generating reports using speed buttons, the 
report that prints will be based on the EPlant the user is logged into. 

Labor Set the labor cost element associated with the ASSY Mfg Type using the drop down list. 

Enter the default Labor Rate. This value will be used as the default if no rate is specified 
on the Processes. (Note: The hierarchy for labor is employee level and then MFG type. 
The system cannot use MFG cell as the operation may not be attached to a BOM when 
standard labor is calculated). 

Labor posted from Time & Attendance - When checked the labor will not post to translog 
from floor dispositioning. Labor will be posted from Time & Attendance only. 

Use Labor Rate to calculate Actual Labor - If this option is checked, when calculating 
actual labor in Actual Costing, instead of using the employee charge rate, the system will 
use the Mfg Type Labor Rate. 

Overhead Set the overhead cost element associated with the ASSY Mfg Type using the drop down 
list. Enter the default Rate. 

(Note: The overhead cost element can only be set to Labor based for ASSY MFG types). 

General Tab Fields: 
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Process Certification (This only applies to ASSY1) Select the desired process certification from the drop down 
list. The Certified tab in Assembly Process Maintenance will adjust depending on the 
selection made here. There are two choices: 

▪ Certified Jobs – (Default) - Users can specify job requirements for running the 
process. This will limit which employees can log into a specific process. Only those 
employees with an active certification level high enough for the specific job can log 
into the process. 

▪ Certified Employees – With this option selected individual employees will be certified 
on a process rather than a job. 

No Supervisor required 
for Final Assembly 

This option controls whether a supervisor is required to enter the Final Assembly in 
AssemblyData. 

Note: The ‘Process Certification’ and 'No Supervisor Required for Final Assembly' 
settings will be determined by the default predefined ASSY MFG type for any user 
defined MFG Types based on the ASSY type.  The reason for this is the potential to 
have the same process linked to multiple BOM's. 

Dispo IN and OUT 
Locations  

A disposition In and Out location can be entered here. Click on the ellipsis button and 
select a location from the pick list. The Mfg Type dispo designated locations will fit into 
the hierarchy after the Mfg Cell dispo designator locations for both IN and OUT 
locations. This option is also available on user defined MFG Types that are based on the 
ASSY Type. 

Use Percent Complete 
Reporting 

(For ASSY1 and ASSY2 MFG Types) - If this option is checked, when reporting labor for an 
ASSY1/ASSY2 work order/process, a percentage can be reported against a process 
instead of entering a quantity.  In Assembly Track and JobShop, the Progress bar in the 
Process Details will display the last percent complete that was reported.  Material 
attached to the process being reported on will not be backflushed until Final Assembly 
Reporting. 

Consume Raw Material 
by Process 

If the 'Use Percent Complete Reporting' option is selected this option is available. If this 
option is unchecked, in Assembly Track-> Labor Reporting, the Report Consumed 
Materials tab will be hidden. Material will be backflushed upon Final Assembly.  If this 
option is checked, in Assembly Track-> Labor Reporting, the Report Consumed Materials 
tab will be visible to enter a value of components to be backflushed. Upon Final 
Assembly the system will not backflush material. 

Use Yield % on BOM If this box is checked the BOM 's associated to the MFG Type will say 'Yield %'  instead 
of 'Scrap %'. 
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Backflush Each Process (For ASSY3 only). If this option is checked, when clocking out of a process in 
AssemblyData or labor reporting in Assembly Track, the system will backflush the 
components.  When performing Final Assembly, it will not backflush the components. 
This allows users to be able to finite schedule a work order to an Assembly Line and still 
allow for backflushing at each process.  

Note: If this option is not checked, the Processing Time on the BOM must be 
calculated using the Process Throughput Map button. If it is not calculated the 
system will have no way to know when material(s) are required so it will assume it 
will end on the last day. 

Launch Final Assembly 
Reporting on 
designated process 

If this is checked users can designate a single process in the Assembly BOM that will launch 
the “Final Assembly Reporting” form. The Assembly BOM can only have one process 
designated as “Final Assembly Reporting”. 

Do not round up 
dependent demand  

With this checked the dependent demand will not be rounded up to the next whole number 
on dependent work orders. This applies to all MFG Types except MBATCH and JobShop. This 
also applies to the 'Explode Forecast' tool in the Forecast module. When exploding a Sales 
Analysis Forecast, the quantity for dependent demand will be rounded up to the nearest 
whole number unless this option is checked for the relevant Manufacturing Type. If this 
option is checked, the quantities will be calculated and displayed with full decimal precision to 
mirror the BOM Tree explosion. 

Specifically for ASSY MFG Types:  

▪ When this option is not checked: Dependent demand will be rounded up to the next whole 
number on dependent work orders. This may cause parent work orders to start prior to the 
dependent work order completing. This is due to the Work Order End Date of the dependent 
work order being calculated based on the Cycles Required where as the projected end time in 
Assembly Track is calculated based on the rounded up quantity to complete. The parent work 
order will start based on the dependent demand work order end date. 

▪ When this option is checked: Dependent demand will not be rounded up to the next whole 
number on dependent work orders and therefore does not cause a discrepancy between the 
work order end date and the projected end time in Assembly Track. 

Use SN Labels to 
Control MTO 
Dispositions 

When this option is set to Yes, MTO releases will be combined on work orders rather than 
getting a work order for each release (including multiple customers/orders). All other 
allocation functions of MTO will remain the same, only bucketing is different. When printing 
labels, the Order # drop down will reflect the customer for that order on the label. This option 
can be set at the Manufacturing Type level, which will override the default setting in System 
Parameters->Purchase Order and Sales Order Setup tab. Choices in the drop down are System 
Default, Yes, and No. ‘System Default’ will look at the global setting. A selection of ‘Yes’ will 
enable the ‘Use SN Labels to Control MTO Dispositions’ functionality for the specific 
Manufacturing Type. If ‘No’ is selected the functionality will not apply to that particular 
Manufacturing type. 
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Auto Substitute BOM When this setting is enabled, when attempting to add a work order to the first position (in EIQ 
or ShopData), the system will look to see if the BOM on the work order is already scheduled in 
the first position on a logical work center. If the same BOM is already scheduled/running on a 
logical work center, and the user is trying to add it to a different logical work center then a 
substitute BOM will be created before adding the work order. A security enabled warning 
message will appear: “Attempting to schedule this work order on a different logical work 
center than the currently running BOM. What do you want to do?" The warning message that 
surfaces will give the user the option to 'Create a substitute BOM' or 'Do not create substitute 
BOM'. There is also a “Do not show again” check box. Note: This option is visible on all MFG 
Types but will not affect anything unless the MFG Type also has 'Logical Work Center Support' 
enabled. 

Plug Value This is used for informational purposes only. 

Please refer to the help files for additional information on the MFG Types form. 
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ASSY1 Work Centers 

Work Centers need to be created in the Work Center module and then they can be associated to 
Assembly Processes as qualified work centers. Processes can be scheduled onto work centers in the 
Finite Scheduling module and/or assigned within the Dispatch List.  

Select New from the Work Center pick list, and then select the Manufacturing Type or Cell from the 
selection criteria form. 

For the ASSY MFG Type the following form will appear: 
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Work Center Description Information 

Work Center # Enter a unique identification number. This is an alphanumeric field that may hold up to 10 
characters. 

To enter a list in numerical order, the user may need to “pad” the first machines with a 0. For 
example, enter work center one as “1” and work center eleven as “11”, work center 11 will 
display on the pick list just after work center 1. The user should enter work center one as “01”, 
work center two as “02” and so on for them to show in numerical order. 

Description Optional. Used for further description of the work center. This field is displayed on the work 
center pick list. It should be used to fully describe the work center. 

This field can also be used to designate the machine number should the user ever choose to 
renumber work centers. If work centers are renumbered the actual work center number should 
not be changed due to the effect on the historical data. However, the user can use the 
description field to include the work center number which can be changed if necessary without 
affecting the historical data.  

Inactive If this box is checked the work center will be hidden from pick lists. 

Center Type The Type is used to “group” similar work centers, usually by size or other similar measurement 
of throughput. This mechanism allows the system to understand that you have one or many 
machines that share common characteristics. 

Select the center type from the pick list. If the desired center type is not in the list, select the 
New button to create a new center type. Enter the center type name in the field on the pop up 
box. The EPlant will automatically populate with the EPlant the user is logged into, or select the 
Assign EPlant button to select the EPlant. 

EnterpriseIQ needs this information so that a capacity can be derived. By assigning a “Type” to 
the work center, EnterpriseIQ can determine where it needs to be scheduled, and if capacity is 
available. 

The Type is assigned to the work order which assists scheduling by telling the system where the 
job can be run. 

EPlant Name Used with the Enterprise module to define the EPlant associated to the work center. 

Manufacturing 
Cell 

Use this field to attach a work center to a designated cell. Click on the arrow down near this 
field, and choose the appropriate cell from the pick list. 

 

Manufacturing 
Type 

Manufacturing type describes the work center as belonging to a particular “type” of 
manufacturing such as ASSY1. 

Center Rate, 
Start Up Cycles, 
Setup Hours 

These fields are informational only (they are not currently used as all costs for quoting are 
calculated from the processes). 

Time Fence A work center may store a Time Fence, used with the Auto Loading feature of the scheduling 
module (the system also maintains a Global Time Fence value). This value, stored in days, will 
hold the position of any job(s) scheduled on this work center for the number of days listed here. 
During Auto Loading, EnterpriseIQ will not move or reschedule jobs within this time fence. 
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Exclude from 
Auto Load 

Check this box so this work center will be excluded from being auto loaded in the finite 
schedule. 

Reject Codes 

From the Reject Codes tab users can assign a list of reject codes to a Work Center to limit the reject 
codes that can be selected in RT and ShopData for the work center. When entering rejects, the reject 
entry forms will restrict the reject code picklist to the reject codes linked to the work center. If no reject 
codes are linked to the work center then all the reject codes will be available.  

Note: This does not apply to ASSY1 work centers. The system uses the Reject Codes associated to the 
Process for filtering purposes and not the reject codes associated to the work center or BOM. 

Documents 

Internal and external documents can be associated to the work center on the Documents tab. These 
documents will also be visible from AssemblyData. 

Note: See the Work Center section in the help files for additional information on all of the features in the 
Work Center module. 
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Assembly Lines for ASSY2 and ASSY3 

The Assembly Lines are used for the ASSY2 and ASSY3 MFG Types. Select the Assembly Lines icon  
on the Manufacturing tab of the launcher bar. 

Select New from the pick list, and then select the Manufacturing Type or Cell from the selection criteria 
form. Only ASSY2 MFG Types will be available from this form. 

For the ASSY2 MFG Type the following form will appear: 

 

(Note: The Assembly Line icon will become available on the launcher bar after the ASSY2 or ASSY3 MFG 
Types are created and the user logs out and back into the system). 

Assembly Line Description Information 

Assembly Line 
# 

Enter a unique identification number. This is an alphanumeric field that may hold up to 10 
characters. 

Description The description of the Assembly Line.  



ASSY Manufacturing Page 15 of 358 

 

Assembly Line 
Type 

The Type is used to “group” similar assembly lines. This mechanism allows the system to 
understand that you have one or many assembly lines that share common characteristics. 

The Type field can be manually typed in or entered from the user defined list by selecting the 
drop down arrow. To create the list right click on the field and select ‘Edit User Defined List’. 
Select the Add (+) button to enter additional records. 

EPlant Name Used with the Enterprise module to define the EPlant associated to the assembly line. 

Manufacturing 
Cell 

Use this field to attach an assembly line to a designated cell. Click on the arrow down near this 
field, and choose the appropriate cell from the pick list. 

 

Manufacturing 
Type 

Manufacturing type describes the assembly line as belonging to a particular “type” of 
manufacturing such as ASSY2. 

Time Fence An assembly line may store a Time Fence, used with the Auto Loading feature of the scheduling 
module (the system also maintains a Global Time Fence value). This value, stored in days, will 
hold the position of any job(s) scheduled on this assembly line for the number of days listed 
here. During Auto Loading, EnterpriseIQ will not move or reschedule jobs within this time fence. 

Inactive Check this box to mark the assembly line as inactive, which hides it from pick lists. 

Assembly Line Work Centers 

The bottom section is where the specific work centers that are part of the assembly line are associated 
to the line. 

Select the insert record (+) button and select the work centers from the pick list. Only ASSY1 work 
centers that are not already associated to an assembly line will be available to choose from. 

Disposition Designators 

Disposition designators (in and Out) can be associated to an Assembly Line. To associate disposition 
designators to an Assembly Line, select 'Disposition...' from the Options menu and select the desired 
location to be associated with In and/or Out transactions. 

 If the ASSY3 work order is scheduled on an Assembly Line the system will use the line's disposition 
designators before the ones associated to the MFG Cell and Type. 

The hierarchy would be as follows: 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Designated Assembly line IN/OUT location (if the work order is scheduled in Finite Scheduling) 

5 MFG Cell Dispo locations 

6 MFG Type Dispo. Designators 

7 FIFO 

8 Temporary 
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Documents 

Internal and external documents can be associated to the work center on the Documents tab. These 
documents will also be visible from AssemblyData 
 

Assembly Processes Maintenance 

From the Assembly Process module users can create an unlimited number of processes that can be 
associated to BOM’s. The processes are tracked using the Assembly Track and AssemblyData modules. 
These processes can be used over and over in multiple BOM's to provide information as to what 
processes are required to manufacture the item(s) associated to a specific ASSY type BOM. 

From the main launcher bar on the Mfg tab select the Assembly Processes Maintenance speed button. 
Select New from the pick list and the following form will appear: 
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From this form users will add all the information related to a specific process within their facility. The 
information below will describe the fields and tabs in detail. 

Main Section Field Listing (Alphabetical Order) 

Batch Process Check this option to indicate the process is done in a batch. This tells the system it takes the 
cycle time to do the amount of items listed in the multiples of field. 

Examples: 

Multiples Of = 1000,  Yield = 100%, Cycle Time = 2hrs.  

1 takes 2 hrs 

500 takes 2 hrs 

1001 takes 4 hrs 

2001 takes 6 hrs 

 

Multiples Of = 1000, Yield = 95%, Cycle time = 2 hrs. 

100 takes 2.11 hrs 

Center Type Select the center type from the drop down list or pick list. The list will contain all center 
types that have been created in the work center module specific to the EPlant. This is used in 
Rough Cut Capacity. 

Note: Processes attached to a BOM must have center types with the same MFG Cell as the 
BOM in order for the system to calculate the rough cut capacity correctly.  

Class The class defaults to AS and cannot be changed. 

Cycle Time The time required to perform the process. Used with Multiples Of/Multiplier field and UOM 
to determine the rate of production. Enter the cycle time based on the UOM selected. The 
cycle time must be greater than zero. 

Description This is a description of the process. It is a 25 character alpha numeric field. 

Employee Certification 
Not Required 

This will only be visible if the Process Certification is set to Certified Employees for the MFG 
Type. If this option is checked on the process, the employee certification check will be 
skipped when clocking into a task in AssemblyData. 

EPlant This is the EPlant associated with the process. This will populate automatically based on the 
EPlant the user is logged into when creating the process. The ‘Assign Plant’ button is 
available to edit the EPlant. 

Exclude from Finite 
Scheduling 

If checked the process cannot be finite scheduled either manually or by auto load.  

Exclude from Task 
Clock Reporting 

If this is checked, when clocking out of the assembly process the good parts/rejects form will 
not appear. The system will just clock the user out of the task. 

Note: If this is checked material cannot be added to the process. (The Materials tab will be 
read only). 

Inactive When this option is checked the process is considered inactive and will be hidden from pick 
lists. 
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Line Clearance 
Required 

With this checked a supervisor must clear the assembly line prior to an employee clocking 
into a process. This only applies to users who are utilizing AssemblyData. It does not apply to 
Assembly Track. 

Move Qty Move Quantity is the total number of parts that can be completed before moving to the next 
process. This is used in calculating throughput of an ASSY routing. This only applies to the 
process the move quantity is assigned to (it does not propagate to subsequent processes). 

Note: Move Quantities creates work order like entities by dividing the move 
quantity into the work order quantity.  Each entity is calculated separately which 
can drastically increase the time it takes to process Update Schedule, add a work 
order to the schedule or recalculate Assy work center start and end times. This time 
increase is more prominent with a low move quantity and a high work order 
quantity because the number of calculations the system has to complete are 
increased. 

Note: Move Qty plus the Move Time Hrs will be added to following process even if 
the full Move Qty was reported in Labor Reporting. For example: ASSY1 BOM with 2 
processes: Process 1 has a Cycle Time of 1 Hour, Move Qty of 4, and Move Time of 
1, and Process 2 has a Cycle Time of 1 Hour and does not have Move Qty or Move 
Time. Prior to reporting any labor/good parts, the projected start of Process 2 will 
start 5 hours after Process 1 starts (4 * 1 + 1). After reporting 4 good parts and 
running update schedule, the Move Qty + Move Hrs are still added to the following 
process. 

Move Time Hrs Move Time is the time it takes to move from one process to the next process.  

Note: 'Move Time Hrs' does not look at the shop calendar. 'Move Time Hrs' 
continues even after the shifts end. 

For example: Shop Calendar has one shift, 8 hrs/day, 5 days/wk, starting at 7:00:00AM 
(ending at 3:00:00PM). The ASSY1 BOM has two processes. Process 1 has a one hour cycle 
time, 1 move qty, and 'Move Time Hrs'. Process 2 has a one hour cycle time. There is not a 
labor/material/machine constraint. 

When adding a work order with a quantity = 1 on 3/30/2021 

3/26/2021 2:00:00PM – 3:00:00PM to finish process 1 

3/26/2021 3:00:00PM – 10:00:00PM for the move time (move time still continues even 
though shift ends at 3:00:00PM) 

3/29/2021 7:00:00AM – 8:00:00AM to finish process 2 
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Multiples of 

Multiplier 

This field can be set to 'Multiples Of' or 'Multiplier'. Select the button next to the field to 
choose the option. This defaults to 'Multiples Of'. The caption will change based on the 
selection. 

▪ Multiples Of - When this is checked the system will divide the value entered in this field into 
the cycle. If the Multiple Of field is blank or 0, the system will assume it is 1 when using this 
field for calculations. 

▪ Multiplier - When this is checked the system will multiply the value entered in this field by 
the cycle. 

For example: If the value in this field is 10, and the Cycle Time is one hour, and Batch Process 
is not checked: 

If set to 'Multiples Of' it will take one hour to do ten items, or .1 hour per item (1 / 10 = 0.1) 

If set to 'Multiplier' it will take 10 hours to do one item (10 * 1 = 10) 

If Batch Process is checked then the results will be the same for both because it can be done 
in a batch: 

If set to 'Multiples Of' it will take one hour to do ten items, or 1 hour per item ((1 / 10) *10) = 
1 

If set to 'Multiplier' it will take 1 hour to do one item ((10 * 1) / 10) = 1 

Process # This field will automatically populate with a process number but can be changed to a user 
defined value that more defines the process created. This is a 15 character alpha numeric 
field. 

Rework Process When this option is enabled, users will be allowed to login to the process at any time 
regardless of whether Sequential Processing is checked on any of the other processes 
associated to the BOM. Processes that are marked as a Rework Process will be excluded from 
the % Completed calculation in Assembly Track. 

Note: 'Rework' processes should be created with a cycle time = 0.  Otherwise, this cycle 
time will be included in standard cost and overall production hours. 

Sequential Processing With this option checked the next process will not start until the process marked sequential 
processing is finished. 

▪ If it is not complete an employee will not be allowed to clock into the next process.  

▪ Also, in the AssemblyData Dispatch List->Report Quantity option, if the prior process is 
marked sequential processing, and is not completed, a pop up error stating, ‘Cannot Report 
Quantity. Process # xxx was not completed’ will appear, and the employee will not be able 
to report a quantity. 

Note: This check box does not apply to process dependencies. By default Process 1 
is sequential to Process 2 and 2 is sequential to the 3rd. To make these processes 
independent of each other users must rearrange the dependencies using the 
'Process Dependencies Chart' in the BOM. 

Setup Hrs Enter the time it takes to set up for this process. (Process setup time will only show up in the 
finite schedule and not assembly track). 

This value is also used to calculate the process throughput of an ASSY routing. It is assumed 
the setup time is only done once per process. 
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Supermarket Check this box if the process is relevant to the Supermarket application. The Supermarket 
application allows the ability to Task In to a group and pick the required component parts 
needed for the group of work orders selected. Users can gather the required parts, organize 
them, report time spent to perform the picking function, and backflush the components.  

Take Down Hrs Enter the time it takes to take down the equipment for this process. This is not used in 
calculations. 

UOM The unit of measure of the cycle time value. Select a UOM from the drop down list. The 
choices are: seconds, minutes, hours, or days. 

Yield % Enter the yield percent associated to this process. For example, what is the percentage of 
usable time. 

 
 

Qualified Work Centers 

Multiple work centers (created in the Work Centers module) can be associated with a process. The 
process will be listed on the Dispatch List in AssemblyData for all work centers listed in this section.  
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To add qualified work centers select the insert record (+) button. Click on the Work Center # or 
Description field then click on the ellipsis button to bring up the pick list of work centers. (This list will 
only show 'ASSY1' work center types and will be filtered based on EPlant). Select the work center from 
the pick list. Once selected, all three fields will contain information. Continue this process until all 
qualified work centers have been added. 

The user can jump to a work center from the right click option. 

Runs the Best – Which work centers where the process runs the best can be established by selecting the 

‘Runs the best’ button . This opens a form to enter the work centers where the process runs the 
best. To enter this information select the insert button and enter the sequence number. Then select the 
work center from the drop down list in that field. A performance % and comment may also be entered. If 
a Perform % value is entered the lower section will display a  bar chart reflecting this information. This 
information can be used to filter the scheduling pool when inserting processes into the finite schedule. 

 

 
 

Process Certification Selection 

Users can choose to set the Process Certification to either Certified Jobs or Certified Employees. This 
setting is found on the Manufacturing Types form (please see ASSY Manufacturing Types above for 
details). The default is Certified Jobs. 
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Certified Jobs 

If the Process Certification is set to Certified Jobs for the manufacturing type the tab In Assembly 
Processes Maintenance will say Certified Jobs. 
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Users can specify job requirements for running the process. This will limit which employees can log into a 
specific process. Only those employees with an active certification level high enough for the specific job 
can log into the process. 

Employee jobs are linked to employees through the Employee Maintenance module. In order to specify 
certified jobs users must: 

▪ Create the list of job descriptions. 

▪ Associate the specific job description to employees with certification information in the employee 
jobs list. 

▪ Associate the Job Descriptions to the processes. 

Job Descriptions 

Access the Job Descriptions form the Employee Maintenance module (on the Sys Setup tab or Payroll). 
Select Employee Jobs from the File menu, and then select Job Descriptions from the Employee Jobs File 
menu. Select the Add (+) button in the top section and enter in a Job Description. Continue this process 
until all job descriptions have been entered. 
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Employee Jobs – Close the Job Description window to access the Employee Jobs form to begin 
associating the Job Descriptions to the employees. 

 

From the Employee Jobs form, highlight the desired employee and select the Add (+) button. Click in the 
Job Descrip field then select the ellipsis button to bring up the Job Description pick list. Select a job from 
the pick list. Enter in a certification level and certification expiration date if applicable. Each employee 
can have multiple job descriptions associated to them. 

Note: The Job Description field on the Employment Info tab in Employee Maintenance does not link the 
employee to the ‘Employee Job’ for the purpose of the Certified Jobs in Processes. The linking must be 
done in the Employee Jobs form. 

Associating Job Descriptions to Assembly Processes 

Once Job Descriptions have been created and associated to employees the job descriptions can then be 
assigned to processes. From the Certified Jobs tab in Assembly Process, select the ellipsis button in the 
Job Description field. Select the Job Description from the pick list. Enter the Certification Level required 
for the job description for this process. Continue this process until all required job descriptions have 
been added. 
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Certified Employees 

If the Process Certification is set to Certified Employees for the manufacturing type this tab will say 
Certified Employees. 
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This is a list of employees that are certified to run the specific process. Use the Search button to view a 
pick list of the employees associated to the process. Inactive employees can be hidden using the 'Hide 
Inactive Employees' toggle button. Logging into a process in Assembly Data will be restricted to only 
certified employees. This does not apply to labor reporting in Assembly Track. 

To add employees select the insert record (+) button to bring up the pick list of employees. Use the 
toggle buttons on the pick list or the Shift and Ctrl buttons on the keyboard to multi-select the 
employees to be added. 

The Certified documents section displays any External documents that have been associated to the 
process. Upon adding a document the employee is marked as ‘Not Certified’ and the line item is red. To 
certify an employee for all of the associated documents highlight the employee and select the ‘Certify 
Selected Employee’ speed button. A confirmation button will appear – select Yes to continue. The 
document text will turn black; the status will say ‘Certified’, and the system date and time the employee 
was certified will populate in the Certified Date field. 

An employee can be certified on all processes containing the same document by selecting the drop down 
arrow from the certify employee speed button and selecting that option. 

To certify an employee on a single document, right click on the document and select 'Certify This 
Document'. The specific document will marked as Certified. Employees must be certified on all 
documents before being allowed to log in to the process. 

If the external document is updated to a new revision the employee will not be certified any more for 
that document and the status will display ‘Certification Revision Mismatch’.  Select the ‘Certify Selected 
Employee’ button to certify the employee to the latest document revision. 

Note: If there are no certified employees listed, and there are external documents associated to the 
process, any employee will be able to clock into the process. 

Certification Tests can be associated to documents. When an employee that is not certified on the 
document attempts to clock into a work order they will receive an error, 'There are pending certification 
training tests required for this Work Order.  Would you like to take the test now?' If Yes is selected the 
system will present the employee with the test questions and multiple choice answers.  As the user 
progresses through the test, the percentage of correct answers will be compared to the Pass Percent on 
the Certification Training to determine whether the employee passes or fails. If a Certification Test is 
associated to the document it will be listed in the Certification Test field in the Certified Documents 
section. If the employee passes the test the document will be marked certified for all instances where 
the user/document exists in BOMs, Processes and Employee Training records. (Please see the Document 
Control section of the Quality manual for more information on setting up Certification Tests). 
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Inspections 

This option will be available to customers with the DELMIAworks Quality module. The Inspections tab 
allows users to associate SPC Quick Inspections to the process. To add inspections select the Add (+) 
button, click on the ellipsis button in the Inspection field and select an Inspection from the pick list, or 
select New to create a new quick inspection. Enter a Name, Description, and Sample Count. The sample 
count will default to 2 but can be adjusted to a greater value. This ensures that the group will be valid for 
analysis in SPC. 

 

From the Inspection tab place a check in the Pre-Inspection and/or Post-Inspection box as it applies to 
the added Inspection. To complete the quick inspection set up, right click and select Jump to Inspection. 
Select the newly created inspection from the pick list. The Inspection Setup form will appear for the user 
to enter the inspection details, parameters, gages, etc. 

Pre-Inspection & Post-Inspection 

If Pre-Inspection is checked and 'Inspection Required' is active on the SPC inspection group, operators 
are prompted to complete pre-inspections at the beginning of the assembly process when they task in to 
the process. If Post-Inspection is checked and 'Inspection Required' is active on the SPC inspection group, 
operators are prompted to complete post-inspections at the end of the assembly process when they 
report production. The Pre-Inspection and Post-Inspection settings affect the DELMIAworks Assembly 
module, Task Clock, as well as Assembly Data.  

When operators are prompted to complete inspections and click the 'Continue' button, the Quick 
Inspection module will appear where they can complete the required inspections. Once Pre and Post-
Inspections are completed, operators can proceed to the assembly process or continue reporting 
production respectively.  
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Materials 

To associate material(s) with a process select the insert (+) button to bring up the master inventory pick 
list. Select the item and enter the number of parts per information for the process.  When attaching 
material to a process, parts per can be a positive or negative number but it cannot be null or zero.  A 
warning will appear if parts per is not entered. A 'User Defined Worksheet' can be created to calculate 
the Parts Per field based on values entered by the user in the worksheet. To utilize the worksheet select 
the ellipsis button in the Parts Per field. Please see the User Defined Worksheet section in this manual 
for information on creating worksheets. An unlimited number of inventory items may be associated with 
a process.  

Notes: 

Components and packaging for an ASSY BOM must be attached to a process associated to the BOM.  
The Add component to item and Add packaging to item buttons are not available from the ASSY BOM 
Item Details tab). 

Blends are attached as components and therefore the blend will be backflushed during labor reporting; 
not the components of the blend. 

If an attached component is manufactured using an Outsource BOM, and the item changes, users should 
always clone the BOM and not just change it to a new item. This will prevent out of balance costing 
issues. 

Attaching Packaging and Components 

To attach a packaging item or a component, complete the following steps:  

➢ Select the insert (+) button to bring up the master inventory pick list.  

➢ Select the item from the pick list.  Note: The user must enter the items into inventory before 

using this feature. However, items may be created on-the-fly by selecting the "New" button 

from the pick list.  

▪ For Components: Enter the number of components per part. 

▪ For Packaging: Enter the Parts Per Package. The parts per package calculation needs to know how 
many parts will be put into the packaging item selected. In the case of a box, for example, you will 
enter how many parts will be placed in the box. The system then removes the number of boxes 
based on the number of parts produced. For example, if putting a total of 5,000 parts in a box, with 
1000 parts each in 5 bags with a single twist tie per bag, the number of parts per package would be 
5,000 for the box, 1000 for the bag and the tie. The quantity price break information comes from the 
price breaks in the Buying section for the inventory item. The buying price information can be 
changed from this screen and price breaks may be deleted or added. If the buying information is 
changed here it will also change in the buying section in master inventory for the inventory item.  
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➢ Startup Qty - A start up quantity can be entered in this field for the attached material. During 

the update schedule process the system will check if a start up quantity is required and if so 
the required material quantity will be added to the first day of production for that specific 

process (taking into consideration offset days). The requirements will be visible in the 
Material Exceptions and Staging reports. The quantity entered here will not effect the 
standard cost of the item unless the 'Include in Std Cost option is checked. The system will 
use the inventory item’s standard calc quantity to determine the costs. Note: The system will 

only apply the startup qty to the consumed components as long as no labor reporting 
(process wip) took place for the parent item. For instance: Item A consumes Item B. The 

demand for Item A is 100, Item A needs 10 startup parts of Item B. As long as there is no 
labor (process wip) reported against Item A, the system will add 10 to Item B (during 
update schedule).  

➢ User Fields - There are three alphanumeric and three numeric user defined fields that are 

associated with the attached process/item in relation to the BOM. The user may change the 
label text of these fields from the BOM only, (not from Process maintenance) by right 

clicking on them and then typing the new label. They can be edited from either place. 

➢ Material Info - Material Information can be entered in the memo form accessed by clicking the 

ellipsis button in this field. 

Circuit Board Processing 
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➢ Location Reference - For users with the 'Circuit Board Processing' license the Material Info field 

will be called Location Reference instead. This field is used to enter the locations on the 
circuit board for the material. Select the ellipsis button in the field and enter the locations. 

The locations must be entered with a comma as a separator. 

➢ Parts Per - This field is used to enter the number of locations references. 

Location Reference Validation - Select the button in the upper left corner of the Material tab  to 
validate the location references for all attached materials. The Validation will loop through all materials 
and check for duplicate strings (separated by commas) and raise an exception if duplicates are found. 
The exception message will show the duplicate strings. For example: 'Location Reference with duplicated 
strings: [c1]'. The Validation process will also count the number of location references and raise an 
exception if the count does not equal the Parts Per. The exception message will show both the count and 
the current Parts Per. For example: 'Location Reference has 16 locations instead of 15'. If the Location 
references are valid no message will surface. 

Additional Materials Information: 

The user can right click and select 'Jump To Inventory' to access the master inventory details for the 
highlighted item. 

Attached materials can be rejected throughout the assembly process from AssemblyData and/or 
Assembly track. 

Note: A null or zero quantity is allowed. An Authorization Required form will appear with the Process and 
Item # information stating, "Field 'Parts Per' is 0". Select OK to continue or Cancel to return to the form 
to enter a value. Security can be placed on this message. 

Note: In order to process transactions, such as rejecting components, users must have a recipe card for 
all levels of manufactured items, or check the 'Disable Cost Calculation' checkbox (Inventory on the 
Standard Costing tab) if costing should not affect the item. (See the "Costing" manual for details on 
recipe Cards and settings). 
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Outsourced Items and ASSY Manufacturing 

When part of the process requires an outsource vendor to perform an operation an Outsource BOM 
should be created for that item. It is necessary to have a separate Outsource BOM in order to track the 
Outsource inventory (In-Transit) locations. The outsource item must change item # when it is received 
back from the outsource vendor. (The child item that is sent to the vendor becomes the parent item 
when received back from the vendor).  At that point the outsource parent item can be consumed by an 
Assembly Process. If the outsource item does not have a BOM setup and is just attached to a process 
there would be no item # change which means there would be no outsource child inventory tracking. 

For example: 'A1 OS EX' is an ASSY1 finished goods item that consumes 'OSP ASSY1' which is an 
Outsource parent item (Outsource BOM) which consumes 'A1 OS T CHILD' which is an Outsource child 
item manufactured using an ASSY1 BOM. 
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The 'A1 OS T CHILD' item is added to the Outsource BOM as a component. The 'OSP ASSY1' item is added 
to the Materials tab of the 'OS STP' Process which is attached to the 'A1 OS EX' ASSY1 BOM. 

Work Orders will be created for each ASSY1 BOM and the Outsource BOM. 
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When the Outsource item is setup with a BOM the Outsource Central module can be used to create Ship 
Orders, receive items, and track the status of the inventory. 

 



ASSY Manufacturing Page 34 of 358 

 

A Ship Order is created which is used to ship the child item to the vendor to manufacture the parent 
item. The item will be in inventory in an In transit location. A PO is created for the vendor. The parent 
item is then received using the standard receiving process. The child item is 'backflushed' from inventory 
out of the In Transit location and the parent is added to inventory during receiving, and is ready to be 
consumed while manufacturing the finished good item. 

Please refer to the Outsource Central documentation available from Help->Contents in the module or on 
MyDELMIAworks for more details. 

Note: Outsource Central is not required but provides tools to manage outsource inventory more 
efficiently. Users can create Outsource BOMs and use POs and Receiving, or Scheduling and Production 
Reporting to make the inventory transactions. 

 

Outsource Items  without Outsource BOMs 

For users that do not want to 'break' an ASSY BOM to handle an outsource operation the outsource item 
is not associated to an Outsource BOM but is just added to the materials tab of an assembly process. The 
following outlines the steps to handle outsourcing in this manner. Keep in mind users will not be able to 
track inventory for the parent and child as with the above method. 

➢ Create an inventory item describing the outsource process. 

➢ Assign the outsource cost element. (The cost of the item/process would automatically roll up 
to the finished goods item). 

➢ Attach the inventory item to the outsource process of the materials tab of the Assembly 

Process. 

➢ Place a PO for the outsource inventory item, selecting the appropriate Outsource vendor. 

➢ Receive the outsource inventory item into inventory. 

➢ The outsourced item will be backflushed once they the finished goods item is dispositioned. 

 
 

Reject Codes 

Rejects codes can be associated to a process. These reject codes will then be the only ones available 
when entering rejects for attached materials in AssemblyData and Assembly Track. If no specific reject 
codes are assigned to a process then the user will be able to select from all reject codes associated to the 
EPlant they are logged into. 

Select the insert (+) button and select the reject code(s) from the list. Multiple codes can be added at 
one time by using the Shift and Ctrl buttons on the keyboard or the toggle buttons on the form. 
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Auxiliary Equipment 

Auxiliary equipment can be added to a process and then supervisors can select the specific equipment 
used in Assembly Data while performing the Line Clearance function.  This information can be used in 
custom reports. 

Note: If a process does not require a Line Clearance the tools cannot be selected in Assembly Data. The 
information entered here would be informational only. 

To associate auxiliary equipment select the insert record (+) button. Use the toggle buttons on the pick 
list or the Shift and Ctrl buttons on the keyboard to multi-select the equipment to be added. 

New auxiliary equipment can be added to the list by selecting the Auxiliary Equipment Maintenance 

button . The list of existing auxiliary equipment will appear. Select the Insert (+) button and to add a 
new equipment. 

To link the auxiliary equipment to a piece of equipment in the Maintenance, Repair and Overhaul (MRO) 
module select the Tooling Info speed button. Select the insert record button and multi-select the MRO 
equipment to link to the auxiliary equipment. The MRO equipment will display in the Associated Tools 
section in AssemblyData during a line clearance. 

The system will store which MRO equipment ID’s were actually used in the line clearance process. The 
table is for history reporting and is called SNDOP_CLEAR_LINE_PMEQMT. 

 
 

Standard Cost 

The standard cost for labor and overhead for the process is input on this tab. 

Labor: 

▪ Select the Labor cost element using the drop down list. 

▪ Next, click on the ellipsis button in the operator field to bring up the Process Labor form (Note: 
Security can be placed on this form including the Labor rate field). 

▪ Enter the number of operators and the employee level required. Multiple operators and types may 
be associated to the process. Users can access the Employee Level list by clicking the icon in the top 

left corner of the form . (Security is available on this button). 

If the user would like to see what the standard cost for the Labor would be immediately, calculate 
the standard labor cost by clicking on the calculator button. This button calculates the standard cost 
for labor using the cycle time, number of operators, multiple of, and labor rate. (The labor rate is 
based on the rate associated to the employee levels. If the Default employee level is used, and does 
not have a labor rate populated (it is null), the system will use the labor rate associated to the ASSY 
MFG Type). 
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Note: If the Cost field is not calculated after a change has been made to the cycle time, number of 
operators, multiples of, and/or labor rate, then this number may be different than the Costed BOM. This 
happens because when recalculating the standard costs on the parent item, it takes the information 
associated to the process and uses those numbers to calculate the standard cost for Labor so the 
standard cost is accurate. 

Break out Labor Costs including Setup is unchecked (System Parameters->Inventory tab) 

▪ ((Cycle time in hrs / multiple of) / (Yield/100)) * Labor rate * # of operators 

Break out Labor Costs including Setup is checked 

When this parameter is checked there will be two fields for labor costs, Cost and Setup Cost: 

▪ Cost (Production Labor) = (Cycle time in hrs / multiple of / (Yield/100)) * labor rate * # of non-
setup operators 

▪ Setup Cost = Setup Hours * Set up operators * labor rate 

Production Cost example: If the multiples of is one, yield is 100, the cycle time is 10 hours, and one 
non setup operator is attached with a labor rate of 45.00 and a half a non setup operator is attached 
at 55.00, the standard cost for labor would calculate to 725.00. 

(((10 * 1) * 45) + ((10 * .5) * 55)) / 1 = 725.00 

Another example: Multiple of = 5, Labor rate = 10, operator = 1, and the cycle time = 15 minutes 

((15 minutes /60 minutes) * 10) / 5 = (.25 * 10) / 5 = 2.5 / 5 = .50 per item 

Setup Cost Example: If there is one Setup Operator with a labor rate of 20.00, the break out 
parameter is checked, and the process has one hour of setup, Setup Cost = 20: 

1 * 1 * 20 = 20.00 

Note: The setup cost for the item will carry over to Standard Costing (in Inventory) and uses the item's 
'Standard Calc Qty' to determine the cost per item. In this example, if the 'Standard Calc Qty' for the item 
is 1000, the setup cost per item would be 0.020 (20 / 1000 = 0.020). 

The Cost Element hierarchy for labor when reporting Process WIP as follows: 

1 Employee Maintenance > Misc. tab 

2 Assembly Process Maintenance > Standard Cost tab 

3 MFG Type > Labor/Overhead tab 

4 "Labor" (text) 
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Variable and Fixed Overhead: 

▪ Select the Overhead cost element to associate to the Variable and Fixed costs using the drop down 
list. 

▪ A Center Cost can be entered if the cost is different than the default Variable and Fixed Overhead 
rates entered for the MFG Type. 

▪ If the user would like to see what the standard cost for the Variable and Fixed Overhead would be 
immediately, calculate the standard overhead cost by clicking on the calculator button. This button 
calculates the standard cost for overhead as follows:  

((Cycle time in hrs / multiple of) / (Yield/100)) * Rate * # of Non Setup Operators 

Note: If a Center Cost is entered here this will be the rate used for the calculation, otherwise the 
system will use the Overhead Rate assigned to the default ASSY1 Mfg Type. 

*same calculation is used on Process and in Inventory 

Note: If the Cost field is not calculated after a change has been made to the cycle time, rate, multiples of, 
or yield, then this number may be different than the Costed BOM. This occurs because when standard 
costs on the parent item are recalculated, the information associated to the process(es) are used to 
calculate the standard cost for Overhead so the standard cost is accurate. 

Note: The standard cost for labor and overhead can be recalculated for all processes at once by selecting 
‘Calculate Overhead for ALL processes’ and/or ‘Calculate Labor for ALL processes’ from the Options 

menu. 

Note: The Translog cost element for OVERHEAD is populated according to the following hierarchy: 1) The 
element for OH on the Process (on BOM), 2) If that is not populated, the system will use the overhead 
cost element on the ASSY MFG Type. 

Upon moving to a different process or exiting the form, if any of the following fields have been modified: 
Cost Elements for Labor, Overhead and Fixed Overhead, Operators, and Variable and Fixed Center Costs, 
a Confirmation asking ‘Calculate the standard labor and overhead costs for this process?’ with Yes and No 
buttons will display. If Yes is selected, the system will calculate the standard labor, variable overhead, 
and fixed overhead costs. If No is selected, the costs are not recalculated. Security is available on this 
confirmation. There is also a 'Do not show next time' check box. 
 

Documents 

Internal or External documents can be added to the process. The documents can be set to print with the 
BOM, Work Order, All, or None. These documents will also be visible from the AssemblyData module. 

The External documents added here will be listed on the Certified Employees tab. These are documents 
that describe the certification requirements for processes. 

The functionality of this tab is the same as is found throughout EnterpriseIQ, such as printing, adding, 
and editing. 
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User Fields 

These fields are informational only and are provided so that you may enter other information about the 
Assembly Process. EnterpriseIQ provides ten text based fields, each 60 characters in length, and ten 
numeric fields, each supporting up to 15 digits and up to 6 decimal places (nine digits before the decimal 
and 6 after). EnterpriseIQ does not use these fields in any reports or forms, but they may be used in any 
user defined reports. 

Defining Label Text - Users can define the name of the user field. Place the cursor over the text and right 
click, then select “Define Label Text” from the drop down menu. Enter a new label and press [OK]. All 
records will now reflect this change. 

 

 

 
 

User Defined Worksheet 

A user defined worksheet can be created to allow other parameters to be entered and calculated to 
return a value to the Parts Per field (OPMAT.PTSPER_DISP column) on the Materials tab in the Assembly 
Process Maintenance form. Select the 'User Defined Worksheet Maintenance' option from the Options 
menu in Assembly Process Maintenance to access the worksheet pick list. Select a worksheet from the 
pick list or select New to create a new one. 

Note: Only a DBA is allowed to create user defined worksheets. 
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Code Enter a Code for the worksheet. 

Description Enter a description of the worksheet. 

Table Name Select the table name from the pick list accessed by clicking the ellipsis button. 
Currently the only supported table is OPMAT.  

Column Name Select the column name from the pick list accessed by clicking the ellipsis button. 
Currently the only supported column is PTSPER_DISP.  

Once the above information has been entered save the record and then select the Define Structure 
button from the middle section. From the Define Structure form create the columns for the view. 

 

This is the same form used to create User Defined Forms through out EIQ. 

Click the + button on the navigator to create each field.   

Column Name in 
the View 

This is the Column name used by the system for the user defined reports. It 
is the name shown in the views. The system identifiers of User# should not 

be changed. 

If they are changed, users cannot enter a name something that is Oracle 
related such as: Date, Numeric, Char, Data, Query, or Select. Users can enter 
values such as: InventoryDate or Inventory_Date, BoxNumber or 
Box_Number. 
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Field Type 

 

The structure of the field. Choose from the drop down options: 

▪ C - Character field 

▪ N - Numeric field 

▪ D - Date field 

Field Kind Select Data, Query, or Linked from the drop down list. This field will default 
to Data if left null.  

▪ Data - This is the default and will display the entered data. 

▪ Query - If Query is selected a SQL Statement must be entered in the pop up 
form accessed by clicking on the ellipsis button in the SQL Statement field. 

▪ Linked - If this is selected a database (parent) field is linked to the user 
defined field from the pick list. The system will populate the value from the 
user defined field over to the field in the parent table. It does not work the 
other way, if you change the parent field it does not change the field on the 
user defined form. See the User Defined Forms section of the Using 
EnterpriseIQ manual for more information. 

Label Enter the name of the field that will be displayed on the form. 

Use Component For Character field types only, the user can select a Use Component feature: 

▪ DBEDIT - Select this to have the field be entered manually by the user.  

▪ DROP-DOWN - This option will allow the user to select the data from a drop 
down list, or type it in the field manually. If DROP-DOWN is selected enter 
the Drop Down Text in the bottom section. 

▪ CHECKBOX - This will make the field a check box. 

▪ DROP-DOWN-LIST - This option will require the user to select the data from 
the drop down list only. The Drop Down Text is entered in the bottom 
section. 

▪ MEMO - This component type will allow users to select an ellipsis button in 
the user defined field and enter up to 250 characters in a pop up form. 

Parent Column 
Name 

This feature is used to define relational user fields. Users can specify a 
Parent Column for a field on the form that uses the DROP-DOWN or DROP-
DOWN-LIST components (both the parent and the child must be a one of 
these). Only columns from the current form can be selected. Then in the 
Drop Down Text section users define the relationships that will dictate which 
child options can be selected if a specific parent option is chosen. See the 
User Defined Forms section of the Using EnterpriseIQ manual for more 
information. 

If a user selects values for USER1, and USER2, then changes USER1, USER2 
should be cleared prior to posting of the form (this should cascade down to 
multiple children of children...) 
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SQL Statement This is used to enter a SQL Statement for a query kind user field. Select the 
ellipsis button to enter the SQL Statement in the pop up box. 

Users can create queries that will use user fields to calculate the value for 
another user field.  

Example Query: 

select trunc((nvl(bar_length,0) - nvl(bar_end_loss, 0)) 

                     / 

                    iqmisc.no_zero( (nvl(part_length,0) + nvl 

(cutoff_per_part,0) + nvl(stock_allow,0)))) 

from v_ud_worksheet_cutoff 

where parent_id = :id 

Example Worksheet 

This example is to determine the parts per bar that can be made based on factors such as bar length and 
bar end loss. 
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Once the columns have been created, select the 'Create View' button to view the user defined 
worksheet. 
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The Result Column is the field to be used in the Parts Per for materials attached to the process. The new 
form will be visible when adding materials to the process by clicking on the ellipsis button in the Parts 
Per field. 

As values are entered in the user defined fields, the system will calculate the Query field(s) based on 
those values using the associated SQL(s). The Result Column field will populate the Parts Per field. 
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Editing a Process 

The information on a process can be edited. When a change is made to the Multiples Of/Multiplier, Yield 
%, UOM, and/or the Cycle Time fields, a Confirm box will appear asking if the user wants to propagate 
the changes to all BOMs where this process is used.  

  

The number of BOMS that will be affected is listed in the message. No is the default. If the user answers 
Yes then the changes will be made on all of the BOMs where this process is used, and each BOM will be 
recalculated.  If the user answers No, then just this Process record will be updated. Security can be put 
on the Yes and No buttons. There is also a 'Do not show next time' check box that can be checked so this 
message will not appear again unless it is turned back on (in System Parameters->Lists->Dialog Check 
Boxes). 

 
 

Additional Features in Assembly Process Maintenance 

Routing Notes 

Select the Routing Notes speed button to add up to 2000 characters of routing information related to 
the assembly process. These notes can be added to reports, such as the Assy Traveler. 

Clone Process 

Select Clone Process from the File menu to clone the process. Enter the New Process # and Description in 
the fields on the pop up form. All the details from the original process will be carried over to the cloned 
process, including documents, inspections, employees, runs the best, etc. 
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Authorized Work Centers 

Authorized Work Centers can be established for ASSY1 and ASSY2 Processes to control where a work 
order associated to the process can be scheduled. If a user attempts to add or move a work order in the 
schedule, or perform a setup from scheduling (not RealTime™), they will receive an Authorization 
Required Status Exception message. The system does not evaluate whether the work center is 
authorized or not during Auto Load, in the Dispatch list, or Assembly Track. 

To access Authorized Work Orders select the speed button in the upper section of the Assembly Process 

form , or select Authorized Work Centers from the Options menu. A form will display that lists all 
work centers that are associated to the EPlant and Manufacturing Type that is associated to the Process.  
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By default all work centers in the form are marked as Authorized. Also, when a new work center is 
created, that is associated to the same EPlant and MFG Type, it will automatically be added to this list 
and marked Authorized. The Authorized check box can be unchecked to mark a work center as not 
authorized to run work orders associated to the Process. In order to check or uncheck the Authorized 
check box for multiple work centers at once use the toggle buttons or the Shift/Ctrl keyboard buttons to 
select the work centers to change. Then from the right click menu select 'Check Selected' or 'Unselect 
Selected' to update the Authorized check box for the highlighted work centers. 

Users can sort based on any column in the table. This form also includes a 'Filter Dataset' button to filter 
the list. 

The Authorized check box is also visible in the Runs the Best list. It is a read only field so changes cannot 
be made from Runs the Best list. Users can right click and jump from Runs the Best to the Authorized 
Work Centers form. 

Note: When a Process is cloned the authorized work center information populates based on the 
EPlant/MFG Type query. In other words, if work centers were unchecked in the Authorized Work Centers 
form for the 'cloned from' process, they will be checked on the new process. The system does not 
assume that the authorized work centers will be the same for the cloned process. 

Status Exception 

For unauthorized work centers the Status Exception message will state, "BOM is not Authorized to run 
on this work center". The pop up message includes an OK and Cancel button, and a 'Do not show next 
time' option. Security is available on this pop message. 
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If the user has security for the OK button it can be selected to continue to add or move the work order in 
the schedule and add it to the production report for the unauthorized work center. If Cancel is selected 
the work order will not be added/moved. 

Note: There is not a parameter (setting) associated to this feature, the system will always evaluate for 
authorized work centers. 

Note: This is separate functionality from the Runs the Best feature which has it's own warning when the 
scheduling parameter ('Verify Work Center from Runs The Best list') is checked. 
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Checklists 

Checklists can be associated to Assembly Processes. The checklist will display when a setup is initiated 
for a process with a setup checklist, from EIQ RealTime™, ShopData, and RTStation. Checklists can also 
be associated to work centers and BOMs. During a setup the web based Setup Checklist form will appear 
for the user to enter responses to the checklist items. If a BOM/Process and Work Center both have 
checklists the checklist will be combined on the same form with the Work Center's checklist listed first. A 
checklist history is stored for the work center or BOM/Process and can be reviewed at anytime, or used 
for reports. 

Note: This requires the IIS Server to be setup in order to view the web based checklist. See the IIS 
Installation TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf for more 
information. 

Setup 

To begin to use the checklist functionality checklist templates will need to be created. Select the 'Setup 

Checklist Templates' button at the top of the Assembly Process module  to access the checklist for 
the process. The Process # will appear in the title bar. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf
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From this form select the template button to access the pick list of checklist templates. Select the 'New' 
button on the pick list to create a new template. The Checklist Template form will display with a new row 
created for the user to enter the checklist information. 

 

Enter the data in the form. The top section is a description of the checklist. 

Checklist 
Description 

Enter the description of the checklist (up to 150 characters). 

Note Enter additional information about the Checklist (255 character limit). 

EPlant This will populate automatically based on the EPlant the user is logged into when 
the checklist is created. Users will only be able to see checklists for the EPlant they 
are logged into. 

Enter the actual checklist items associated to the highlighted checklist record. 

Sequence # The sequence of the checklist item. The sequence can be changed using the up 
and down arrow buttons. 

Text The description of the checklist item. This is a list of steps involved in completing 
the corresponding Checklist. 

Critical Check this box if the checklist item is critical. Critical items must have the status 
column on the checklist populated with Y, N, or N/A in order to complete the 
setup checklist. 
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Note A list of responses can be created which will apply to all checklist items. When the 
employee performs the checklist item they will be able to select from the drop 
down list, or manually enter a note (if allowed) in the Note field to further 
describe the outcome of performing the step. 

To create the list, right click and select 'Edit User Defined List'. Enter the list 
details in the text field. The Drop Down Style can be selected from the list: 

▪ Drop Down - Free form data entry. 

▪ Drop Down List - Predefined Text only. 

▪ System Default - Will be based on the setting in System Parameters 

Once the checklist template has been created it can be assigned to Assembly Processes. 

Assigning a Template 

From the Process where the template is to be applied, select the 'Setup Checklist Templates' button at 
the top of the Assembly Process module. Select the ellipsis button in the 'Setup Template Checklist' field. 
Select a template from the pick list. 

As setups are performed for processes with templates, the system will pop up the web based checklist 
for employees to respond to the checklist items. This will populate the Checklist History portion of the 
Setup Checklist form. 

Checklist History 

Setup Template 
Description 

This is the template description associated to the historical record. 

Setup Date The date/time the work order was setup. 

Work Order The work order number. 

Created On Date and time checklist record was created. 

Created By The user name that created the record. 

The checklist results 

Sequence # The sequence of the checklist item. 

Text The description of the checklist item.  

Critical This box is checked for a critical checklist item.  

Status  The status entered during the checklist process for the item. This will be 
populated with Y, N, or N/A. 

Note The checklist note entered by the employee. 
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Checklist 

During a setup the web based Setup Checklist form will appear for the user to enter responses to the 
checklist items. If a BOM/Process and Work Center both have checklists the checklist will be combined 
on the same form with the Work Center's checklist listed first. 

 



ASSY Manufacturing Page 53 of 358 

 

Users can select Yes, N/A, or No for each question. There is also a comment field to enter notes for each 
checklist item. Once all of the checklist items have been addressed select the Submit Checklist button at 
the top. If a response is not entered for a critical checklist item (critical checklist items will have a red 
asterisk next to the number) upon submitting a popup with a Yes and No button will appear stating, 
'There are critical items on the checklist that are not marked with a decision. Continue?'.  If No is select 
the user is returned to the checklist to enter a response. If Yes is selected, or if there are no un-answered 
critical items, a message indicating the checklist has been submitted will display. Select Close to exit the 
checklist. The work order setup will then be completed. 

Checklist History 

The information entered from this form is visible from the Setup Checklist form in the Checklist History 
section. 
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Tool Info 

To associate the process with a specific tool select the Tool Info button . The Tool Info form will 
appear: 

 

Click on the ellipsis button to bring up the Preventative Maintenance Info form to link a tool to the 
process. 

 

Select the Pick button to choose from existing PM equipment or select New to create a new tooling 
equipment number. 

Good parts reported in Assembly Track for a process updates all tools (with UOM of 'cycle') attached to 
that process.  All tools attached to the process display in AssemblyData (with line clearance selected on 
the process), and only those tools that have been selected for 'use' have the cycles updated in MRO for 
good parts reported on the process. 
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Where Used 

From the Options menu select Where Used to bring up a list of the configurations (active and inactive) 
that use the process. 

 

Right click and select 'Jump to BOM' to access the Bill of Manufacture. 

Substitute Process 

A process can be substituted with another process for configurations. Highlight the desired 
configurations using the toggle buttons or the Ctrl/Shift buttons on the keyboard. Right click and select 
Substitute Process. Select the substitute process from the pick list and a confirm box will appear stating, 
'About to substitute marked process(s) with selected process # - are you sure you want to continue?'. 
Select Yes to continue or No to cancel and return to the Where Used form. Once Yes is selected the BOM 
is updated. 

Note: Once an ASSY work order is scheduled in Assembly Track, no changes should be made to the BOM.  
If substituting a process on a BOM that has already been scheduled in Assembly Track, an error will 
appear stating that the WO is already scheduled in Assembly Track. 
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Work Center Type Overhead Cost Update 

Select this function from the Options menu to update the Center Rate on multiple work centers at one 
time. The left side displays the center types and their corresponding Overhead Center Costs. The right 
side of this form displays the process(es) that have the highlighted center type assigned. If the center 
type has a variable and/or fixed overhead rate assigned they will display in the bottom right section. 

 

 

To update the center rates select the process(es) that need to be updated using the toggle buttons. If the 
default rates are to be used select the Apply button. A different variable and fixed rate can be entered in 
these fields and applied to processes without updating the Master Center Type. Select OK on the confirm 
pop up window and the system will apply and recalculate the selected process(es) standard overhead 
costs. 

Note: The system allows either entering a positive number or the field can be left null effectively wiping 
out existing process overhead rate and forcing the use of the default system overhead rate. 

Note: This does not use the Master Center Type Cost element, it is just applying the center rates. 

Jump to Master Center Type is available from the right click menu in the left section. 

Jump To Process is available from the right click menu in the right section. 

Calculate Overhead or Labor for All Processes 

These options (Options menu) allow the user to calculate the labor and/or overhead for all processes at 
one time. 

Note: When ‘Calculate Overhead for All Processes’ is selected, the system will only recalculate the 
Variable Overhead cost.  To calculate the Fixed Overhead, users must manually calculate by pressing 
the calculator button next to the Fixed overhead cost field. 
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ASSY1 and ASSY2 Bills of Manufacture 

The ASSY1 and ASSY2 manufacturing types are used for assembly manufacturing that requires multiple 
processes. Utilizing these manufacturing types will allow the user to associate multiple processes to a 
single BOM rather than creating multiple Generic BOM’s. This type of BOM is tracked using the Assembly 
Track and Assembly Data modules. Additionally, processes can be scheduled on the finite schedule. 

To create a new ASSY1 or ASSY2 bill of manufacture select the BOM button on the Mfg tab of the 
launcher bar. Select the ASSY1 or ASSY2 manufacturing type from the selection criteria form and the 
following screen will appear: 
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Below is a detail listing of all fields per tab on the ASSY1 BOM form: 

General BOM Info 

Mfg # Up to 50 characters can be entered in this field. The number entered here is the 
number of the actual standard.  

Each configuration number and routing number combination must be unique. If the 
user enters a Mfg #/Routing # combination that already exists, a prompt will be 
issued informing that a duplicate number was entered. The user will need to reenter 
a new Mfg or routing number. 

Note: To view the STANDARD ID for the BOM select the Alt F1 keys and a pop up will 
display the ID (for example, Table = IQMS.STANDARD, ID = 46825). 

Routing Seq # This field can be used for informational purposes to define the routing step 
sequence of the BOM when there are several steps. This field displays in the BOM 
pick list. 

Description Description of the ASSY BOM. Typically describes the part and process. 

Customer Type in the first couple of letters of the customer's name and the system will 
hyperbrowse to that customer. Another method is to select the customer from the 
pick list. This is not a required field, but is often used to associate a job with a 
particular customer. 

If you are a proprietary producer, you may leave this blank or list your company as 
the owner. 

Inactive A BOM can be marked inactive. This will `hide' the BOM from pick lists. To view an 
inactive BOM the pick lists have a new button in the lower left corner to `view 
inactive' items. 

1st Article Ins Date Enter in the First Article Date using the drop down calendar (Optional). This is the 
date that the BOM was first approved for use in a production run. This field is for 
information purposes only. 

This field description can also be changed by right clicking on the field and selecting 
the Define Label Text option. Enter in a user defined caption in the New Value field. 
The customized caption is based on Manufacturing Type. If the caption is changed 
for an Injection BOM, all of the Injection BOM's will have that same caption but not 
other types of BOM's such as Generic. 

EPlant Name This field is used to designate the configuration to a specific EPlant. It is not a 
required field if EPlant is not being used. 

BOM Control # The BOM Control number will change automatically when someone makes a change 
to the configuration. This field cannot be edited. This field will not update 
immediately. In order to see the change, the user would have to exit the BOM 
module and come back in. 

The field consists of today's date, time and EnterpriseIQ user ID of the person who 
made the change. 

From RFQ# Request for Quote Number. This information originates from the Quote module and 
only displays if the standard was imported from a Quote. This field cannot be edited. 
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Schedule Information The user can enter up to 250 characters of information that will display when a work 
order is scheduled in the finite schedule to a work center that uses this BOM. Since 
ASSY1 type work orders are not scheduled in the finite schedule this field is 
informational only. It will not display in Assembly Track or Assembly Data. The 
information can be printed using the Print button from the BOM or added to a 
report. 

Mfg Type This field shows the TYPE of manufacturing this BOM will be used for. In this case it 
will display ASSY1 or ASSY2. 

Cell Manufacturing Cells are use to designate separate areas in your facility. Separate 
scheduling is done for each cell.  

Please refer the Manufacturing Cells section in the help files for more information. 

Max WO Batch Size Enter the maximum work order batch size if desired. This will break up the sales 
order releases into multiple buckets if necessary on the work order(s). For example: 
The sales order release is 2000 pieces, and the Max WO Batch is 500. Assuming zero 
on hand the system will create four work orders for 500 pieces each.  The Must 
Start dates on multiple work orders created from a BOM with a setting for Max WO 
Batch Size are incremented based on the estimated production time. The system 
starts with the original must ship date and backs up in groups based on the batch 
size. The difference is put into the last record. The must start is the must ship of the 
preceding record. This guarantees it will finish exactly on the requested must ship 
date. 

FG Lot # A finished good lot number can be assigned at the BOM level. When reporting Final 
Assembly this lot number will automatically populate the Lot # field. If you do not 
want this field to automatically populate check the 'Do not default FG Lot # during 
Final Assembly' box on the General tab, then the Lot # field will be blank and users 
can enter the lot number manually. 

Std Quantity The standard run quantity used to calculate the standard processing time. This value 
is entered on the Process Throughput Map form accessed by selecting the 
Throughput Map button. 

Processing Time This is the calculated processing time.  Select the Throughput Map button to 
calculate the standard processing time of the BOM. When the user clicks on the 
Throughput Map button and calculates the Standard Processing Time, the cycle time 
in the STANDARD table will be populated which will be visible in the BOM Tree 
report.   

Enter the Std Quantity then select the 'Apply Selection Criteria' button. A graphical 
representation of each process will be displayed in the right hand window.  

(See example below in Process Throughput Map and Process Dependencies). 

Tool Information Multiple Tools may be linked to a configuration. This is informational only for ASSY 
type BOM’s. 

To link a tool to the configuration, click on ADD (+) button then click on the ellipsis 
button in the Tool Eq # field to bring up the MRO Info form. 
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Note: When an ASSY BOM is created, the efficiency factor will default to 100% regardless of the default 
efficiency factor under Miscellaneous Parameters.  Yield is setup on the processes, so efficiency factor 
on the BOM is unnecessary. 

Right Click Options: 

From the General BOM tab users can right click and select: 

▪ Trace BOM - This opens the Trace form to view changes made to fields setup in Trace for the 
Standard table.  

▪ Jump to Process Monitoring Mfg # Setup - For users with a license for RT Process Monitoring, this 
option will jump to the Process Monitoring Mfg # Set up module with the current BOM highlighted. 
For more information see the RT Process Monitoring TechNote https://my.iqms.com/cfs-
file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf. 

▪ Jump to Sales Configuration Template - When this option is selected, if the BOM is only associated to 
one sales config template, that sales configuration template will open. If the BOM is associated to 
multiple sales configuration templates, a pick list of templates will display to choose from. 

 

Process Throughput Map and Process Dependencies Chart 

 

https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf
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Example: 

ASSY Type BOM with four processes: 

Seq Setup Hrs  Cycle 
Mins  

Move Qty Move Time 
Hrs 

1     4      5    100       1 

2     4      2    400       1 

3     4      5    100       3 

4     4      4   

Std Quantity = 1000 

Processing Time = 139.666667 

To access the Process Chart select the 'Apply Selection Criteria' speed button  and a chart of the 
processes will appear. 
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Putting the cursor on a bar will display the Production Hours, Setup Hours, Slack Hours, and Total Hours. 

Users can enter a Start Date and modify the Move Qty, Move Time, Cycle UOM, Cycle Time, and Setup 
Hours of any of the processes attached to the BOM. This allows the user to see how long a job will take 
for the entered Std Quantity and when the job will be completed based on the entered Start Date. If the 
Start Date is left blank, the system will default to the current date and time. (Note: Changing the move 
qty and move time in the throughput map will change the move qty and move time on the process on 
the BOM). 

Slack time is informational only, and will be displayed graphically as gaps between process bars and 
indicates the idle time needed before the process can continue. Any time there is a process with a faster 
cycle time than the one before it, there will be slack time gaps in that process. This is because the 
process has to wait for parts from the previous process to be produced before it can continue.  

Slack time (Mouse over) Slack time can also be any non-production time on the shop calendar that falls 
within the production run. This includes off hours, weekends and holidays. This slack time value will be 
shown in the mouse over of a process bar segment that includes slack time.  This time will be included 
in the Total Hours calculation but will not affect the actual Production Hours. This type of slack time will 
not be represented as a graphic gap, but is included in the length of the bar.  Note that when 
calculating the throughput map, adding a start time (as opposed to just a date) corresponding to the 
start of the first shift of the day will prevent including Slack Time hours in the first process representing 
the time between midnight and the start of the first shift. 

Chart Options: 

▪ Link Color Toggle - If Link Color Toggle is unchecked, the link color is the same color as the child 
process.  If Link Color Toggle is checked, then the link color is the same color as the parent process. 

▪ Show/Hide Labels - Toggles the time labels for the lines on or off.  

▪ Show/Hide Legend - Toggles th color legend on or off. 

The show/Hide toggle options are only available if a Start Date was entered. 

NOTE: If a user happens to have more than one item on an ASSY BOM, the user will only be able to see 
the processing time of one item at a time.  In order to see the time of the other items, highlight the 
item on the Item Details tab first and then enter the selection criteria in the Throughput Map. 

Process Dependencies Chart 

The Processing Dependencies Chart screen allows users to specify processes that run concurrently. The 
system will use the longest cycle time of concurrent processes when calculating the total processing 
time. 

This can be accessed by selecting the Process Dependencies speed button  from the Process 
Throughput Map, from the Items Details tab, or the Attached Material Details tab on the BOM.  
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Each rectangle represents a process. The connecting lines can be added, deleted, or moved (change the 
parent): 

▪ To add a connecting line, right-click on a process and select Add Connection. Drag the end of the line 
to the child or parent process. Once the other end of the line rests on the desired process, double 
click the end of the connecting line. The system will put the arrow on the correct end (parents always 
pointing to children).  

▪ To delete a line, click to select a connecting line and hit the delete key.  

▪ To change the parent of a connector, right click and select 'Disconnect Parent', then move the arrow 
to the correct parent and double click it. 

To move a process, click on the process first, then click on it again and move. A process cannot be 
deleted off the chart. 

Note: When a user changes the positions of the process boxes this does not carry over to determine the 
actual sequence of these processes. Dependencies are created using the connecting lines. 

Dependencies Example 

For example, there are four processes that are all dependent on the prior process (none can be done 
concurrently) as shown above.  
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The Processing Time is calculated as the Cycle time plus the set up hours for all four processes 
(5+2+3+4+1+1+1 = 17). 

If the dependencies are changed this will affect the processing time. In the example below the first two 
processes can be done at the same time, and the third process is dependent on the second one. 
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The Processing Time is 11 hours (5+1+4+1 = 11).  

 

If this is changed slightly to where the third process is dependent on the first one instead, the processing 
time would be 14 (5+1+3+4+1 = 14). 
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Item Details 

From the Item Details tab the user will enter the manufactured item as well as the processes required to 
produce the item. 

Note: ASSY1, 2 or 3 BOMs  are not intended to be used for family tools, therefore only one 
manufactured item can be added. Once a single item is added to the Item Details tab, the Add item + 
button and right click options will not be available. 

First enter the information for the manufactured item. The information entered here will create an 
inventory record for the item automatically. 

Select the ‘Add a New Part Number’ (+) button in the middle of the form. A pop up screen will appear to 
enter the item details. 
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Class Shows the class of the item that you are adding to the BOM. When you first 
enter this screen, the class field will default to `FG' for Finished Goods item. 

Item # Enter in the inventory item part number. This number must be unique. 

Rev This field is optional though very important for tracking revisions to parts. It is 
used to distinguish between similar part numbers. (EnterpriseIQ sorts and 
stores unique part numbers based on Class, Item Number, Rev and EPlant). You 
can use it to track any revisions made to the part and can also be retrieved in 
reports. 

Unit This is the Unit of Measurement for the item. Select the unit from the drop 
down list. 

Description Enter a short description or common name of the item. The description entered 
here will be used throughout the system to identify this item. 

Extended Description Second part description field-use up to 100 characters for the description. 

Drawing Optional. The number entered here is used to track the drawing number for the 
part. Use up to 30 characters. 

ECNO Optional. This user defined field normally carries an engineering change 
number, but it can also be used to hold additional information about the part, 
such as a UL number. 

User Numeric field 

On this screen there is an additional field called User Numeric. This field is only used for EDI or Crystal 
reports. (The field is in the table Partno and is called Nuser1).  The label of this field can be changed by 
right clicking and typing a new label text. 

Inherited Component 

This only applies to ASSY1 BOMs. Users can select the ellipsis button in the field to access a picklist of 
components associated to the process that are marked Serialized Inventory Control (SIC). Select the 
desired item from the list. The field can be cleared with the delete key.  

At the time of final assembly, for a top level part that has an inherited serial associated to it, when the 
part is being dispositioned, the system will clone the component serial and then the 
MASTER_LABEL.SERIAL field of the component serials will be copied to the new produced 
MASTER_LABEL.SERIAL record at the same time that the component MASTER_LABEL record serial fields 
are updated to the master_label.id of the component serial that was just consumed prepended with a 
"~". 

For example:     ID               Serial 

         1001            1000 –This serial is now consumed and copied onto the parent, the 
next line will be what it looks like after that action. 
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         1000          ~1000 

The serial # that was copied to the parent item will also be visible in the 
MASTER_LABEL.INHERITED_SERIAL field so that the user will have the parent/child relationship available 
for reporting purposes.  

Note: Both the manufactured item and inherited components must be marked Serialized Inventory 
Control (SIC). The system does not police users against selecting an item as an inherited component and 
then converting that item to non-SIC at a later time. 

Note: The quantity on the label for the inherited serial will always be one because of the 1:1 ratio that 
has to be maintained to ensure that the serials get merged up to the top level manufactured item. Users 
can have quantities greater than one on their work orders but will have to enter in the inherited serials 
one by one for all of the parts on that work order. The system will check the quantity of good parts being 
reported to ensure that it is equal to the number of labels/serials selected during Final Assembly. 

To utilize this feature the ASSY1 Mfg Type must have the following settings: 

▪ Use Percent Complete Reporting = ON 

▪ Consume Raw Material by Process = OFF 

Documents Attached to the Item 

EnterpriseIQ supports attaching unlimited notes and documents to any item number. Use the 
Documents button to access the internal and external documents linked with the finished goods item 
number. This same list of documents can be accessed from within the AssyData and the Inventory 
module. 

Note that the Documents button provides direct access to the Item Number documents, as opposed to 
the Documents tab which provides access to documents concerning the configuration. 

The user can add, edit, and delete documents from the maintenance form that is displayed. Any changes 
made to the documents from this area will be reflected when viewing the documents for this item from 
within the Inventory module and AssyData. 

Routing Notes 

 In the Item Info section of the Items Details tab is a speed button to access a routing note field. This is a 
2000 character note field used for work instructions for routings. This information will print on the 
Routing Packet report available in work orders. 

Attached Materials 



ASSY Manufacturing Page 70 of 358 

 

 



ASSY Manufacturing Page 71 of 358 

 

In the lower section of the Items Details tab the  specific information associated to the highlighted 
Attached Materials will be displayed. this will include the Operation, Item information such as number, 
description, class, and revision. This will also show the Parts Per and UOM fields which can be edited 
from here. If the parts per or unit of measure is changed from the BOM it will update the information in 
the process as well. 

Note: In order to process transactions, such as rejecting components, users must have a recipe card for 
all levels of manufactured items, or check the 'Disable Cost Calculation' checkbox (Inventory on the 
Standard Costing tab) if costing should not affect the item. (See the "Costing" manual for details on 
recipe Cards and settings). 

Right Click Options from the Items Details tab 

The right click options will depend on the record the user right clicks on.  

When right clicking on a manufactured item the options are as follows: 

▪ Add Item - When highlighted on the manufactured item, this will open the Add Inventory Item to 
BOM form, which can also be performed by selecting the plus button. 

▪ Change Item - When highlighted on the manufactured item, this will open the Edit this BOM 
Inventory Item form to make changes. It is the same function accessed from the Edit Item button.  

▪ Delete Item - This will delete the attached item after selecting Yes on the confirm box. 

▪ Jump to Inventory - This feature will take you to the inventory module for the highlighted item. 

▪ Jump to Transactions/Locations - This will access the Transactions module for the highlighted item. 

▪ Jump to BOL Data - This will access the BOL Data form for the item. 

▪ Jump to Inspection Setup - This option will only be available for users who own the quality modules. It 
allows the user to jump to the Inspection Setup for the inventory item. 

▪ Add Process - This will open the pick list of processes to select from. 

▪ Add Process Like - This will add a process like another process by cloning it. (See the Add Process 
section). 

▪ BOM Tree - This screen allows the user to see all required inventory for the manufactured item along 
with the requirements per item. This information can be exploded for a specific quantity. Click on the 
BOM Qty Explosion button and enter in a quantity. The information displayed will show the 
requirements per item, the required amount of material to manufacture the quantity entered, On 
Hand inventory, as well as non-committed material on hand. This function will show the user how 
much of the material in inventory that is not allocated towards existing orders. Select the Material 
Exception List button to open the BOM Tree Material Exceptions list. This list displays only the 
materials associated to the BOM. For more information please see BOM Tree in the Inventory 
section. 

▪ Routing Tree - This screen displays the work center routing tree for the highlighted item. 
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▪ Routing Diagram - This feature brings up a color coded, visual routing diagram of the processes 
involved to make the highlighted item. The boxes can be expanded (right click - expand) to view 
additional information. The additional information available is: On Hand, Non Committed, Std Cost, 
and Ext Cost. To set a quantity click on the BOM Qty Explosion speed button. Then right click on a 
box to see the additional information you selected in parameters for the quantity. For example, if the 
BOM explosion qty is set to 1000 and the purple material box is expanded, the amount of material 
required for that quantity will display along with any other options selected under parameters, such 
as on hand quantity. From this form the user can also jump to Inventory, BOM, or the Material 
Exception list. 

▪ Trace Item - Allows the capability to trace changes to fields set up in the trace tables (System 
Parameters->Options->IQTrace Tables). 

When right clicking on an Process the options are: 

▪ Add Process - This will open the Processes pick list to choose or create a new process.  

▪ Add Process Like - This will add a process like another process by cloning it.  

▪ Edit Process - This will open the Process form for the highlighted operation.  

▪ Delete Process - This will remove the process from the BOM, but not from the system. 

▪ Edit Process  Routing Note - This option will pop up the Routing Notes form to add/edit the notes. 

▪ Final Assy Reporting - If the MFG Type has the 'Launch Final Assembly Reporting on designated 
process' option checked, from this right click option users can designate a single process in the 
Assembly BOM that will launch the 'Final Assembly Reporting' form when labor is reported. 

▪ Routing/Seq# - This allows the user to edit the sequence # (the order is appears in the tree) for the 
process. 

▪ BOM Tree, Routing Tree, and Routing Diagram as described above. 
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Add Process 

An unlimited number of processes may be added to an item. The processes added are essentially the 
steps the part goes through to become the item specified in the item details section. Each process can be 
tracked through the Assembly Track module. 

To add a process select the Add Process button or right click in the white area and select Add Process. A 
pick list of existing processes will appear. Select the first process from the pick list or select the New 
button to create a new process. Continue this step until all required processes have been added in the 
order they are performed. 

Note: The same process can be added multiple times to the same BOM. 

Processes with Attached Materials: 

The information for attached materials is in the lower right section on the items details tab. This section 
lists the Item#, Description, and the parts per requirements as well as the unit of measure for materials 
associated with a process. 

Note: Components and packaging for an ASSY BOM must be attached to a process associated to the 
BOM.  The Add component to item and Add packaging to item buttons are not available from the ASSY 
BOM Item Details tab. 

Editing Attached Materials - If the material attached to a process is changed, all BOMs that have that 
process attached will be updated with the new material.  To only affect a single BOM it is best to create 
a new Process (or 'clone' a process using the Add Like feature) or create a substitute BOM with the 
changed material, then only that BOMs material will be changed. 

Add Like Process 

A process can be 'cloned' on the fly when building the BOM. To add a process like another process select 

the 'Add Process Like to Item' button  or select 'Add Process Like' from the right click menu. A pick 
list of existing process will appear to choose from. Select the process to be cloned. A form will appear 
with the next process number and the same description from the like process populated in the fields. 
Changes can be made to the process # and description. 
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Select what should be included in the cloning process by checking the box(es): 

▪ Include Qualified Work Centers 

▪ Include Certified Employees/Jobs  

▪ Include Inspections 

▪ Include Materials 

▪ Include Reject Codes 

▪ Include Auxiliary Equipment 

▪ Include Documents 

The system will copy over the corresponding information. The new process will be added to the BOM. To 
make changes to the Process, right click and select Edit Process and make the desired changes, such as 
materials, cycle times, etc. on the Process Maintenance form. 

Note: Changes can be made to a BOM associated to a work order in Assembly Track. Assembly processes 
can be edited or added and the changes will be reflected in Assembly Track. Additionally, a process may 
be deleted or the process sequence changed as long as the process is not scheduled in the Finite 
Schedule. When removing a process from a BOM, the sequence number for the remaining processes will 
automatically be updated.  
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Details tab - Attached Process and Material Details 

The Details tab contains additional options for the attached materials and processes. 

 

If a process has attached materials users can establish parameters for the backflushing of those 
materials. 

Material Details 

Scrap % This field would be used to assign a unique scrap % to the attached item 
which takes into account fall out from using the item during the process. 

Exclude from Calc With this checked the scrap percentage will not be included in the 
dispositioning or backflush calculations. Disposition and backflushing will 
only look at usage and not include scrap. 

Exclude From Backflush When selected this option will keep the attached component from being 
dispositioned (either through labor reporting or manual transactions with 
backflush) and will not be included in standard costing. The attached 
component will not show up in the material exception reports. 
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Offset Days This allows you to specify where in the run the materials will be needed. The 
offset days affects when the system tells you to bring in the material in the 
material exceptions List (Scheduling). 

Users determine the time that the BOM is going to run. The time each 
process is going to run is not broken out separately. The system looks at the 
BOM as a whole and by default tells the user to bring in all of the materials 
at the same time. But this may not be logical so this field allows users to 
establish when the materials will be needed. 

For example, if a job is going to run for two weeks the components for the 
last process may not be needed until the last day of the run so users can 
control when they are brought in instead of bringing them in at the 
beginning of the job. 

Process / Operation Details 

The user can edit the rate of production for a process within a BOM by editing the fields listed below. 
The information entered in this section will be specific to that BOM.  This does not affect the original 
process. 

Note: To change the cycle time associated to the process, right click on the process from the BOM, select 
Edit Process, and make the changes on the Assembly Process form. A Confirm box will appear asking if 
the user wants to propagate the changes to all BOMs where this process is used. The number of BOMS 
that will be affected is listed in the message. No is the default. If the user answers Yes then the changes 
will be made on all of the BOMs where this process is used, and each BOM will be recalculated. If the 
user answers No, nothing will be updated. Security can be put on the Yes and No buttons. There is also a 
'Do not show next time' check box that can be checked so this message will not appear again unless it is 
turned back on (in System Parameters->Lists->Dialog Check Boxes). 

Multiples Quantity of parts produced in one cycle. 

UOM Cycle time UOM. Select a UOM from the drop down list. The choices are: 
seconds, minutes, hours, or days. 

Cycle Time Enter the cycle time based on the UOM selected. 

Yield Enter the yield percent associated to this process. For example, what is the 
percentage of usable time. 
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Process Level Scrap % This is a progressive scrap percentage that will affect any materials attached 
to previous processes in the ASSY1/ASSY2/ASSY3 BOM. Once a Process Level 
Scrap % is entered, the Yield will change to 100%.  Users can either enter a 
Yield or Process Level Scrap %.  Process Level Scrap % will be included in 
calculating the processing time in the throughput map and work order 
production hours.  This scrap % will affect material requirements and the 
standard cost of any materials attached to previous processes. If any 
processes are running in parallel, the system will calculate the worst case 
process scrap path.  

Example 1: 

 

The worst case path is highlighted in red. The combined process scrap factor 
for A is 0.9 * 0.7 * 0.6 = 0.378 

Example 2: 

 

The worst case path is highlighted in red. The combined process scrap factor 
for A is 0.9 * 0.8 * 0.7 * 0.6 = 0.3024 
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Move Qty Move Quantity is the total # of parts that can be completed before moving 
to the next process. 

Note: Move Qty plus the Move Time Hrs will be added to following 
process even if the full Move Qty was reported in Labor Reporting. 
For example: ASSY1 BOM with 2 processes: Process 1 has a Cycle 
Time of 1 Hour, Move Qty of 4, and Move Time of 1, and Process 2 
has a Cycle Time of 1 Hour and does not have Move Qty or Move 
Time. Prior to reporting any labor/good parts, the projected start of 
Process 2 will start 5 hours after Process 1 starts (4 * 1 + 1). After 
reporting 4 good parts and running update schedule, the Move Qty + 
Move Hrs are still added to the following process. 

Move Time Hrs Move Time is the time it takes to move from one process to the next 
process. 

Note: 'Move Time Hrs' does not look at the shop calendar. 'Move 
Time Hrs' continues even after the shifts end. 

For example: Shop Calendar has one shift, 8 hrs/day, 5 days/wk, starting at 
7:00:00AM (ending at 3:00:00PM). The ASSY1 BOM has two processes. 
Process 1 has a one hour cycle time, 1 move qty, and 'Move Time Hrs'. 
Process 2 has a one hour cycle time. There is not a labor/material/machine 
constraint. 

When adding a work order with a quantity = 1 on 3/30/2021 

3/26/2021 2:00:00PM – 3:00:00PM to finish process 1 

3/26/2021 3:00:00PM – 10:00:00PM for the move time (move time still 
continues even though shift ends at 3:00:00PM) 

3/29/2021 7:00:00AM – 8:00:00AM to finish process 2 

Dependent On This will list the process that this process is dependent on based on the 
Process Dependencies chart. This chart can be accessed from this screen by 
selecting the Process Dependencies speed button.  

Final Assy Reporting If the MFG Type has the 'Launch Final Assembly Reporting on designated 

process' option checked, users can designate a single process in the 
Assembly BOM that will launch the “Final Assembly Reporting” form when 
labor is reported. The Assembly BOM can only have one process designated 
as “Final Assy  Reporting”. If the user checks this box on a process and then 
also checks it on another process associated to the BOM, the box on the first 
process will be un-checked by the system. 

This setting can also be entered by right clicking on a process and selecting 
'Final Assy Reporting'. The process that has this option checked will display 
an asterisk (*) in front of the process description in the tree. 

If the BOM is cloned, this setting will copy over to the cloned BOM. 
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Use for Label For ASSY BOMs with multiple processes that each have attached packaging 
items the user can specify which process to use for the label. Only one 
process/operation can be marked 'Use for label.' When printing the label for 
the manufactured item, the package is the #1 sequence packaging item 
marked ‘use for label,’ the box quantity is the parts per for the packaging 
item, the Volume is volume of packing item, and the weight is the weight of 
the package. 

When printing batch labels in pick tickets for an ASSY BOM, the system will 
look at this setting on the BOM to determine which package to use to get 
the Labels quantity, Parts/Pkg, Weight and Volume.  If the BOM does not 
have a process with Use for Label checked, then the system will default to 
the first package item found starting with process Sequence 1. 

Grouping Process Check this box if the process will be grouped using the licensed Assembly 
Track By Group module.  

Process Dependency 

Select the ellipsis button in the 'Dependent On' field to open the Process Dependency form. 

 



ASSY Manufacturing Page 80 of 358 

 

This form shows the current process on the left and any Parent Processes it is dependent on on the right. 
The parent processes can be edited from this screen by adding/deleting processes. To change a parent 
process, select the delete button to remove the current process. Then select the insert button and select 
the ellipsis button in the Process # field. Select the desired parent process from the pick list. Only the 
processes with a lower sequence number will be listed. Once a change is made here, the Process 
Dependencies Chart will also change based on the dependencies. 

Packaging Details 

The fields listed below will be available for packaging items associated to a process: 

Seq # Shows the order of each item attached. The sequence number will default to the order the 
item is added in. The sequence of the items can be changed by dragging and dropping 
them in a different order. 

Note for Packaging: The largest packaging item or the one that will be associated to the Bill 
of Lading should be Seq #1. The default method for calculating BOL’ s uses Seq #1 
packaging items to calculate the BOL data such as class. 

Gross Weight (Pkg 
Only) 

This field is used to enter the ENTIRE (final) weight of the packaging item (box). Includes all 
parts, bags, ties, etc. 

The Bill of Lading is based on pounds per cubic feet. Pounds per cubic feet are calculated 
based on box weight and the volume of the package. 

Tare Weight This is the weight of the empty packaging item.  

This information is used when BOL's are being calculated based on individual component 
weights. The program will add up all of the tare weights for the packaging and the net 
weight for the Finished Good based on the parts per in the BOM. 

Ret Contnr (Pkg 
Only) 

This is for returnable containers and will only be used by the EDI module. 

Verify ASN 
Quantity (Pkg 
Only) 

This is used for EDI only. 

In the BOM, all returnable packaging items that need to appear on the EDI 856/DesAdv 
outbound transactions should be specified as packaging components and have the Ret. 
Container box checked. In addition, any returnable packaging items in which the quantity 
can vary per shipment (usually tops & bottoms), should have the Verify ASN Qty box 
checked on the BOM. For the inner returnable packaging item, the Seq # MUST be set to 
1. 

Documents and User Fields associated to a Process or Material: 

The Document tab contains Internal or External documents associated with the attached process/item in 
relation to this BOM. These documents can be selected to print with the BOM, Work Order, both, or 
none. 

The User Fields tab contains three alphanumeric and three numeric user defined fields that are 
associated with the attached process/item in relation to the BOM. The user may change the label text of 
these fields by right clicking on them and then typing the new label. These fields are also visible from the 
Materials tab in Process Maintenance. They can be edited from either place. 
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Documents Tab 

Each manufacturing configuration may have its own set of process instructions (or notes) such as 
machine setup notes and process notes. Instructions are stored in memo fields which can hold an 
unlimited amount of information. The documents can be set to print with: BOM, Work Order, Routing 
Packet, All, or None. 

Internal 

The screen acts exactly like a word processor. The user can add, edit, delete, or print documents from 
here. Graphic images may also be imported into the document or text area. EnterpriseIQ supports .BMP 
or.WMF graphic files only. 

External 

This section enables the user to be able to insert or open documents created in different applications 
such as Microsoft Excel Chart/Worksheets, Microsoft Word Documents, Acrobat Reader, Word pad, 
Bitmap images, etc. and map the path to these documents so that anyone can access them. 

 
 

User Fields and User Defined Form Tabs 

User Fields in BOMs 

User fields can be accessed on the User Field tab or select Options|User Fields to access the six 
alphanumeric and five numeric user fields. These user definable fields are used for informational or 
reporting purposes only. 

Note: The user defined captions entered in the New Value fields will display for all MFG types. 

User Defined Form in BOMs 

User defined forms allow the user to create a unique form to store information beyond the scope of the 
original BOM. Once established, this form is available to all BOMs. The User Defined form can be 
accessed from the User Defined Form tab, from the speed button, or from the Options menu. 

See the 'User Defined Forms' section in the EIQ help file or the Using EnterpriseIQ manual for more 
information. 
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Auxiliary Equipment Associated to BOM 

You can associate auxiliary equipment with a configuration. By doing so, EnterpriseIQ can check for 
availability of the equipment when the job gets scheduled and notify the scheduler of any conflicts. 
EnterpriseIQ does not use the rate field for finished goods costing purposes, only for quoting. Costing is 
completely based on the press cost field found in the Work Center information screen or if overridden on 
the inventory item’s standard cost tab (Center Cost field). Center rate is used for quoting; center cost is 
used for job costing. 

 
 

Visual BOM Routing 

The EnterpriseIQ Visual BOM Routing module is a tool which enables the user to create bills of material 
in a more visual way or view existing BOM’s visually. This option is very similar to the Routing Diagram 
option available from the items details tab of a BOM except the Visual BOM Routing module has add and 
edit capabilities. (Please refer to the help files for more information). 
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ASSY3 Bills of Manufacture 

The BOM for ASSY3 MFG Type BOMs is mostly identical to a ASSY1 and ASSY2 BOM except for the areas 
noted below: 

 

 

An ASSY3 BOM is associated to an Assembly Line Type. Select the type from the drop down arrow or the 
pick list. This list is based on the types associated to the assembly lines created in the Assembly Lines 
module. (See Assembly Lines for ASSY2 for more information). 
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ASSY1 and ASSY2 Quote 

Quotations can be created for the ASSY1 and ASSY2 manufacturing types. The basic functionality in 
creating an ASSY quote is the same as for any manufacturing type. The main difference is an ASSY quote 
can have multiple processes like an ASSY BOM. This document will reference the fields in a quotation 
that only pertain to the ASSY manufacturing type. For a complete discussion on all fields in a quote 
please refer to the Quote documentation. 
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General Tab: 

Max WO Batch Size Enter the maximum work order batch size if desired. This will break up the sales 
order releases into multiple buckets if necessary on the work order(s). For 
example: The sales order release is 2000 pieces, and the Max WO Batch is 500. 
Assuming  zero on hand the system will create four work orders for 500 pieces 
each. 

Std Quantity The standard run quantity used to calculate the standard processing time. This 
value is entered on the Process Throughput Map form accessed be selecting the 
Throughput Map button. 

Processing Time This is the calculated processing time.  Select the Throughput Map button to 
calculate the standard processing time of the BOM.  

Enter the Std Quantity then select the 'Apply Selection Criteria' button. A 
graphical representation of each process will be displayed in the right hand 
window.  

(See example in the ASSY1 Bills of Material). 

Item Details 

Users can add processes from the Quote Process pick list or from the Assembly Processes.  

 Select the 'Add Assy Process' speed button and choose a process from the pick list. New Assembly 
Processes cannot be added from the quote module. 

 Select the 'Add Quote Process' speed button to select an existing quote process or select New to 
create a new quote process. 
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The information entered for a Quote Assy Process is basically identical to the information in Assembly 
Process maintenance. Please refer to that section for field details (see Assembly Processes 
Maintenance). There are a few differences discussed below. 

One difference is when attaching materials, users can attach master inventory items or quote items.  
Attaching material(s) is accomplished as follows: 

➢ From the Materials tab on the Quote Assy Process select the ellipsis button in the Item # 
field. A three part form will appear: 
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➢ Select the item from either the Master Inventory list or the Quote Inventory list. Drag the 

item from the one of the lists up to the Currently Attached Materials list. 

➢ Next, enter the Quantity per Item. The Quantity per Item is how many pieces will be 
consumed for each of the selected items manufactured. Continue this process for all 

materials required for the process. If the material is a manufactured item that will need to 
be quoted the user can select the RFQ Required box. The item will be marked in red 
indicating an RFQ is required. Once the RFQ for the item is created the item will be marked 

in black. This feature is used in the top down quoting method. This option will be grayed out 
when adding a new quote inventory item from the 'Modify Quote Inventory Item' form. Once 
you drag the newly created item to the Currently Attached Materials section the box will be 

enabled on the 'Edit Attached Material' form. This will indicate that the item needs to be 
quoted, in other words it is something you manufacture that does not have a quote created 
for it yet. 

➢ Modify the Quantity and Price Break information for the material, if necessary. 

➢ To exit, click on File|Exit or click on the [X] in the upper right hand corner of the screen. The 
selected materials will now be displayed in the visual view to the left under the process they 

are attached to and the details for the selected material will be displayed in the lower right 
hand portion of the screen. 

Another difference is on the Standard Costing tab. There is a field to enter the Standard Rate. This value 
is used in quoting only to establish the process cost. A value entered here will flow to the 'Process Cost' 
field on the calculations screen. The system will multiply the Standard Rate times the cycle time in hours 
times the multiple of value to calculate the process cost per item. (The Labor and Overhead standard 
costs flow to the 'Prod Cost' field on the calculations screen).  

Note: The Standard Rate field is not available on a non quote process, so when an ASSY Quote with a 
process that only utilizes the Standard Rate field is converted to a BOM it converts without costs. 

See quote calculations in the next section for details. 
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Process Labor Cost Break out Setup Costs is unchecked 

((Cycle time in hrs / multiple of) / (Yield/100)) * Labor rate * # of Operators 

Break out Setup Costs is checked 

There are two fields for labor when break out setup costs is checked: 

Cost (Production Labor): (Cycle time in hrs / multiple of / (Yield/100)) * labor 
rate * # of Non Setup Operators 

Setup Cost: Setup Hours * Setup Operators * labor rate 

Process Overhead Cost ((Cycle time in hrs / multiple of) / (Yield/100)) * OH Rate * # of Non Setup 
Operators 

Note: If a Center Cost is entered here this will be the rate used for the 
calculation, otherwise the system will use the Overhead Rate assigned to the 
Mfg Type. 

Process Fixed Overhead 
Cost 

((Cycle time in hrs / multiple of) / (Yield/100)) * Fixed OH Rate * # of Non Setup 
Operators 

Note: If a Center Cost is entered here this will be the rate used for the 
calculation, otherwise the system will use the Fixed Overhead Rate assigned to 
the Mfg Type. 

The calculations tab will use the sum of the labor associated to each process plus the sum of the 
overhead costs to determine the Prod Cost value. The sum of the costs of the operations will be used to 
determine the Process Cost. 

The Labor hierarchy for an ASSY quote is: 

1. Employee Level 

2. Default Operator Labor Rate from Rates and Parameters in Quoting. 

3. Labor rate from Mfg Type 

Note: Only the ASSY MFG Types includes Mfg Type within the Quoting module labor hierarchy. 
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ASSY3 Quote 

The ASSY3 Quote form and functionality is basically identical to the ASSY1 and ASSY2 types except an 
Assembly Line Type is associated to the quote and the Max WO Batch field is not applicable. 
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ASSY Quote Calculations 

Calculation Samples 

The calculation samples provided below are based on information from the following Quote ASSY 
Processes screen shots and a Quote Quantity of 100. All percentages or amounts shown in the calculated 
fields have been rounded off. The Markup By is set to Percentage and the fixed overhead costs are zero. 
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This process is a Batch Process.  See ASSY1 Bills of Manufacture for how the Cycle Time is calculated for 
a Batch Process. 
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This process uses a Standard Rate rather than calculated labor and overhead which will populate the 
Process Cost row on the Calculations tab. 
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The field listing below outlines and shows the calculations for each field. 

Optm % MarkUp If a quote is Optimized, the resulting percent change is displayed here. The optimized 
percentage is the percent of change between the original calculated unit price and the new 
optimized unit price. The column will be blank if the quote has not been optimized. 

Example: 
The price is optimized from $1.00 to $1.25. The Opt % Markup field displays 25 indicating 
that the quoted price is 25% higher than the calculated price. 

All percentages are based on the calculated price. 

Unit Cost The cost to make the product per unit. 

Calculation: 

a.  Total Cost / Quote Quantity 
b.  730.00 / 100 
Unit Cost = 7.30 

Unit Price Suggested sales price per unit. 

Calculation: 

a. (Total Revenue / Quote Quantity) + Commission 
b. ( 884.68  / 100) + 0.4423 
Unit Price = 9.2891 

Price/1000 The price for 1000 units of product. 

Calculation: 

a. Unit Price * 1000 

b. 9.2891 * 1000 
Price/1000 = 9,289.1310 

Profit/Total Margin This will display either the Markup % or the Gross Profit Margin % depending on which 
option is selected in the Margin Display section on the Calculations Parameters screen. The 
default is set in Rates and Parameters.  

Calculation if Markup % is selected: 

a.  ((Total Revenue – Total Cost) / Total Cost) * 100 
b.  (884.68 - 730.00) / 730.00) * 100 

c.  (154.68 / 730.00) * 100 

Markup % = 21.19 

Calculation if Gross Profit Margin is selected: 

a.  ((Total Revenue – Total Cost) / Total Revenue) * 100 
b.  (884.68 - 730.00) / 884.68) * 100 

c.   (154.68 / 884.68) * 100 

Gross Profit Margin = 17.48 
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Cost % Total cost as a percent of the Unit Price. 

Calculation: 

a.  (Total Cost / Total Amount) * 100 
b.  (730.00 / 884.68) * 100 
Cost % = 82.52 

Prod % The production costs as a percentage of the total price. 

Calculation: 

a.  Prod Cost / Total Revenue * 100 
b.  (221.83 / 884.68) * 100 
Prod % = 25.08 

Material % The material costs as shown as a percentage of the total price. 

Calculation: 

a.  Material Cost / Total Revenue * 100 
b.  (441.25 / 884.68) * 100 
Total Material % = 49.88 

Net Value/Hr This is the effective hourly press rate, after removing extra charges, materials and labor. It 
is calculated by taking the Total Revenue less Extra Charges, Material Cost, Production 
labor and Setup labor then dividing by the quote quantity, and multiplying by Prod Hours. 

Calculation: 

a.  ((Total Revenue - (Material Cost + Extra Charges + Labor Cost)) / Prod Hours 

b. ((884.68 - (441.25 + 0.25 + 93))  / 8.434 

c.  (884.68 - 534.50 / 8.434 

d.  350.18 / 8.434 

 
NetValue/Hr = 41.52 

Yield/Hr The total yield per hour for the Quote Quantity. Essentially the amount made per hour 
after material costs (plastic, components, and packaging) and commissions, but before 
labor costs. 

Calculation: 

a.  (Total Revenue - Material Cost) / Prod Hours 
b.  (884.68 - 441.25 / 8.434 

 
Yield/Hr = 52.58 
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Prod Hrs Production Hours required for the Quote Quantity. 

Calculation: 

Non Batch Process = (Cycle Time per Hour/multiples of/(yield/100) * Quote Quantity) + 
setup hours 

Batch Process = Takes the cycle time to do the amount of items listed in the multiples of 
field.  

((Cycle Time per Hour/multiples of/(yield/100) * (Quote Quantity/Multiples Of - if less than 
quote quantity) + setup hours) 

a. (((0.033333/1/1) * 100) + 1.5) + ((0.166666 * 1 * 1) + 0.1 * 2) + ((0.033333/1/1) * 100) 

b. 4.8333 + 0.26666 + 3.3333  

Prod Hrs = 8.43 

If a Process Scrap % is entered on the process the Production Hours will use that value 
instead of the yield. When a process scrap % is entered the yield will change to 100%.  
Users can either enter a Yield or Process Level Scrap %.  (See Attached Process and 
Material Details for details on Process Level Scrap). 

Oper Hrs Total number of operator hours required for production. 

Calculation: 

a.  Production Hours * total number of Operators associated to processes (including set 
up operators). 
b. 8.43 * 4 
Oper Hrs = 33.72 

Prod Labor Total Production Labor 

'Break Out Setup Costs' is checked 

Sum of the (Prod Hours * Non Setup operators * Labor Rate) for each process * Quote Qty 

a. ((0.033333 * 1.5 * 12) * 100) + (0.166666 * 1 * 12)  

b.  59.994 + 1.99992 

Prod Labor =  62.00 

Break Out Setup Costs' is not checked 

Sum of the (Prod Hours * operators * Labor Rate) for each process * Quote Qty 

a. ((0.033333 * 1.5 * 12) * 100) + (0.166666 * 1 * 12)  

b.  59.994 + 1.99992 

Prod Labor =  62.00 

 

Setup Labor Total cost for setup labor. 

Sum of the (Setup Hours * setup operators * Labor Rate) for each process 

a. (1.5 * 1 * 20) + (0.1 * 0.5 * 20) 

b. 30 +  1 = 31.00 
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Overhead The sum variable and fixed overhead costs for all processes without a Standard Rate * 
Quote Qty 

a. (1.25 + 0.038333) * 100 

b. 125 + 3.8333 

Overhead = 128.83 

Prod Cost The total production cost for the Quote Quantity. Based on the sum of the labor and 
overhead standard costs for all attached processes multiplied by the quote quantity. 

Calculations: 

'Break Out Setup Costs' is not checked 

a. Sum of all processes ((Cycle time in hrs / multiple of) / (Yield/100)) * OH Rate * # of 
Operators * Quote Qty + ((Cycle time in hrs / multiple of) / (Yield/100)) * Labor rate * # of 
operators * Quote Qty +(( Cycle time in hrs / multiple of) / (Yield/100)) * Fixed OH Rate * # 
of Operators * Quote Qty 

b. ((0.033333/1/1) * 25 * 1.5 * 100) + ((0.033333/1/1) * 12 x 1.5 * 100) + ((0.033333/1/1) * 
20 * 1 * 100) + (0.166667 * 23 x 1) + (0.166667 * 12 * 1) + (0.166667 * 20 * 0.5) 

Prod Cost = 259.17 

 

'Break Out Setup Costs' is checked 

a. Sum of all processes (((Cycle time in hrs / multiple of) / (Yield/100)) * OH Rate * # of 
Operators * Quote Qty) + (((Cycle time in hrs / multiple of) / (Yield/100)) * Labor rate * # of 
operators * Quote Qty) + (Setup Hours * # of Setup operators * Labor rate) + (((Cycle time 
in hrs / multiple of) / (Yield/100)) * Fixed OH Rate * # of Operators * Quote Qty) 

b. ((0.033333/1/1) * 25 * 1.5 * 100) + ((0.033333/1/1) * 12 * 1.5 * 100) + (1.5 * 1 * 20) + 
(0.166667 * 23 * 1) + (0.166667 * 12 * 1) + (0.1 * 0.5 * 20) 

Prod Cost = 221.83 

Note: This can also be simply calculated by summing up the Prod Labor, Setup Labor, and 
Overhead values 

Example: 62.00 + 31.00 + 128.83 = 221.83 

Process Cost Cost for processes with a Rate instead of standard costs. 

Calculation: 

a. Sum of all processes with standard rate (Cycle time in hrs * Rate * Multiple Of) * Quote 
Qty 

b. 0.033333 * 20 * 1 * 100 

Process Cost = 66.67 

Prod MarkUp The amount the production is being marked up. 

Percentage Calculation: 

a.  Prod Cost * (Prod % Markup/100) 
b.  (221.83) * (0.20) 
Prod MarkUp = 44.37 
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Total Prod Cost The total production amount, including markup. 

Calculation: 

a.  Prod Cost + Prod MarkUp + Process Cost 
b.  221.83 + 44.37 + 66.67 
Tot Prod Cost = 332.87 

Tbl % MarkUp or 
Fixed MarkUp 

The production markup percentage as specified in the Calculation Parameters section. 

Comp Cost Total cost of components needed for this quoted quantity.  Pricing is based on default 
price breaks and number of units required.  The units required takes into consideration 
the scrap percentage associated to the component if any. 

Calculation: 

a. (Quote Qty *  parts per) * 1 + Scrap %) * component cost 

b. (((100 * 1) * 1 + .05) * 2.75) + (((100 * 1) * 1) * 1.5) 

Comp. Cost = 438.75 

If the Attached Components Scrap Calculation in Rates and Parameters is set to 'Based on 
(1/1-Scrap)', the calculation would be: 

(100 * (1/1-0.05)) * 2.75 + (((100 * 1) * 1) * 1.5) = 439.47 

Process Level Scrap % will be included in calculating the Comp Cost, and Pkg Cost of any 
materials attached to previous processes. For example, if there is Process Level Scrap of 
10% on a process the comp cost would be increased to 487.50 ((((100 * 1) * 1 + .05) * 2.75) 
+ (((100 * 1) * 1) * 1.5) * (1/1-.10) 

Pkg Cost Total Packaging cost for the quoted quantity. Pricing is based on quantity price breaks and 
number of units. The items required takes into consideration the scrap percentage 
associated to the packaging item if any. The system will round up to the nearest whole 
packaging item required and multiply times the cost to determine total Pkg Cost. 

Example:  

Parts per packaging item = 10, Scrap % = 0, quote qty = 100, cost = 0.25  

Calculation: 

a. ((Quote Qty/parts per) * 1+ Scrap %) * pkg cost  

b. ((100/10) * 1) * 0.25 

Pkg Cost = 2.50 

With a 10% process level scrap the Pkg Cost would be 3.00 as it rounds up to a whole 
package. 

2.50 * (1/1-.10) = 2.7775 rounded up is 3 
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Material Cost Total cost of material associated to all processes for the quote quantity. 

Calculation: 

a. Comp. Cost + Pkg Cost 

b. 438.75 + 2.50 

Material Cost = 441.25 

 

Material MarkUp The amount the materials are being marked up. 

Calculation: 

a. Tot Material Cost * (Mat % Markup / 100) 
b.  441.25 * (0.25) 
Matr MarkUp = 110.31 

Total Matrl Cost The total material amount, including markup. 

Calculation: 

a.  Tot Matl Cost + Matr MarkUp 
b.  441.25 + 110.31 
Total Matr Cost = 551.56 

Fix or Tbl % MarkUp The material markup percentage as specified in the Calculation Parameters section. 

Extra Charges Additional charges not accounted for in the normal quote input screen such as extra 
shipping charges, mold maintenance, color changes, etc. This information comes from the 
information entered on the 'Extras Charges, Commission' tab. 

Extra Charges = 0.25 

Commissions Sales commissions will be added into the item price based on Total Price or Gross Margin 
and one of two calculations. 

Calculation example: 

a. Total Price: Total Revenue / Qty * Commission%/100 

b.  (884.68 / 100) * 0.05 
c.   0.4423 

Total Revenue Total revenue for the Quote Quantity including the Optm % MarkUp. 

Calculation: 

a.  (Total Prod Cost + Total Matr Cost + Extra Charges) * (1 + (Optm % MarkUp / 100)) 
b.  (332.87 + 551.56 + 0.25) * (1 + (0/ 100)) 
c.  884.68 * 1 
Total Revenue= 884.68 

Total Cost The Total Cost to produce the Quote Quantity (break even). 

Calculation: 

a.  Prod Cost + Process Cost + Material Cost + Extra Charges 
b.  221.83 + 66.67 + 441.25 + 0.25 
Total Cost = 730.00 
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Total Profit Total Profit that will be made on the Quote Quantity. 

Calculation: 

a.  Total Amount - Total Cost 
b. 884.68 - 730.00 
Total Profit = 154.68 

VAP% Value Added percentage. 

Calculation: 

a. (Total profit / (((Unit Price - Commissions) * Qty) - Material Cost)) * 100 

b. 154.68 / (((9.3124 - 0.4656) *100) - 441.25) * 100 

c. 154.68 / 443.43 

VAP% = 34.88 % 

Note: VGM % is not applicable to ASSY MFG type quotes. 
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Convert ASSY Quote to BOM 

To convert a quote to a BOM, follow the steps below.  

➢ Select the quote to convert from the quote pick list.  

➢ Click on the Calculation tab and then click on the Convert... button at the top of the screen, 
or select File/Convert to BOM... from the main menu. The following screen will appear.  
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➢ To review the information on all items and attached packaging/components, click on the Full 

Expand button. This allows the user to identify all items that are not currently in Master 
Inventory prior to converting the quote and to make any changes to the item number or 
description of new items prior to conversion.  

➢ Click on each item attached, make any changes as necessary and click on the Apply button 
to save the changes. A red check mark will appear in each folder that is reviewed. Note: A 
description must be entered for each item or the quote cannot be converted to a BOM, 

because the description field is mandatory in BOMs.  

➢ Enter the new Manufacturing Number. 

➢ DO NOT enter the BOM Labor information. This does not apply to the ASSY MFG Types as 

the labor comes from the attached processes. If BOM labor is added the standard cost of the 
item will be incorrect. 

➢ Click on [Convert] to proceed with the conversion process. The system will create the new 

configuration and automatically add any new item(s) to the Master Inventory along with the 
quantity and price break information. The packaging items' sequence numbers in the BOM 
will be based on the order they are attached to the quote.  

The quote can also be converted to an existing BOM. Instead of creating a new BOM number type in an 
existing BOM number. All of the settings that are not available in the Quote will be preserved as it was 
on the BOM before the conversion. For example the Dispo by Cycles check box on attached components 
will stay as it was on the original BOM before the conversion from the quote.   

NOTES: 

More than one manufacturing number may be required if the quote has manufactured sub-components 
attached that exist only as quoted items.  

When converting a quote to a BOM, any attached components that are created during the convert will 
have the prices breaks written to the "Buy" pricing in inventory. However, if the item is associated to a 
Vendor RFQ the AKA Buying tab will be automatically populated with the vendor(s) and price break(s) 
from its Vendor RFQ.  

The following message may appear if some of the items were not reviewed:  
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When the quote has been converted the user will receive a prompt that the conversion was completed 
successfully. Click on [OK] to return to the main screen.  

Convert to BOM and Create a Sales Order  

To convert a quote to a BOM and create a Sales Order at the same time, follow the steps above until all 
items have been reviewed and you are ready to convert to the BOM. Instead of clicking on the [Convert] 
button, click on the [Convert/Order] button to proceed with the conversion process and create the BOM 
and the Sales Order. If a customer is not associated to the quote the user will receive a warning and will 
not be able to continue creating the sales order, however the quote will still be converted to a BOM.  

When the quote has been converted the user will receive a prompt that the conversion was completed 
successfully and the Sales Order form for the quoted item will be shown on the screen. If a Sales Order 
Note is associated with the customer (Customer Maintenance->Misc tab) it will appear on the screen 
with the sales order.  
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Work Orders for ASSY 

Work Order’s for ASSY Mfg Type BOM’s are generated during the Update Schedule process as with all 
work orders. The fields and functionality is basically the same as for all work orders. Two exceptions for 
ASSY Work orders are the ability to right click and Jump to Assembly Track and the Stop Production 
feature.  
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Stop Production - If the work order is marked Firm, the Stop Production check box will appear. This allows 
the scheduling department to put a stop to all work related to a work order regardless of where in the 
factory the order is being processed. This prevents employees from being able to log into the work order 
in AssemblyData. If an employee attempts to log in to a stopped work order, they will get a message: 
“Work order xxxxx is stopped for production. Unable to login.” To restart the production just un-check 
the Stop Production box. Note: This does not prevent a user from Labor Reporting in Assembly Track. 

Substitute BOM’s - When creating a substitute BOM for an ASSY work order, new processes will be 
created and attached to the substitute BOM.  This will allow the user to add/modify material without 
affecting the original BOM. If the work order is scheduled in Assembly Track the system will not allow the 
user to create a substitute BOM for that MFG number. The user must un-schedule the work order then 
they can create sub-bom and re-schedule.  

Hard Allocation - When adding a substitute item during Hard Allocation for ASSY WO’s, the cost for the 
substitute item is picked up in Final Assembly. During Process WIP the cost of the original components 
attached to the BOM will Credit and Debit FG Inventory, Credit Variance and Debit  WIP.  During Finish 
Process WIP the cost of the substitute item will credit the inventory account and the difference between 
the substitute item and original component will go to variance.  

Changing the Quantity - When releases for an ASSY1, 2, or 3 work order are first created, the system 
records the quantity and original quantity of the release.  The original quantity should not be changed 
because it is used in the calculations for the running quantity, progress %, and hours to go, and also 
updates the process quantity appropriately when taking into account rejects for any process. However, if 
a user does manually changes the Delivery quantity, a dialog surfaces warning that this would change the 
original work order quantity. The user can select Yes or No with security available on the Yes button.  A 
'Do not show next time' checkbox is also on the form.  Changing the quantity will then refresh the 'Qty' 
and the process 'Qty To Complete' in Assembly Track. 

If a user would like to change the WO quantity without changing the original work order quantity, do not 
modify the quantity of the existing WO release.  To increase the work order quantity, a new work order 
release must be added.  To decrease the work order quantity, delete the existing release and add a new 
one with the correct release quantity. 

Deleting a work order - If a user attempts to delete an ASSY work order and it is in Assembly Track an 
Authorization required status exception will appear stating that the work order is in Assembly Track. 
Select OK to continue deleting the work order which will also remove it from Assembly Track; or select 
Cancel to not delete the work order. Security can be put on the OK button to prevent users from deleting 
ASSY work orders that are in Assembly Track. 

When the user tries to delete an ASSY1 or ASSY2 work order (through Assembly Track or the work order 
module) the system will check the translog to verify if PIT is posted. (Note: the option 'Use Standard Cost 
during Post Transactions' must be checked in System Parameters, Inventory Setup tab).  If some 
records have not been posted, an exception error will be raised.  The user can override the exception to 
go ahead and delete the work order.  Security can be setup on this exception error. 
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When the system tries to auto-remove firm work orders, the system will run the same check.  Even if 
some records have not been posted, the system will remove and delete the work order. NOTE: This is 
also true for substitute BOMs.  If unposted transactions still exist, the system will delete the work 
order, however, the substitute BOM will not be deleted.  After posting the PIT transactions, it is 
recommended to then delete the substitute BOM. 

Note: If a work order is deleted or archived (from the work order, Assembly Track, or Assembly Data) 
prior to the total work order quantity being reported, the WIP Inventory will be cleared out so that 
perpetual to GL stays in balance. A GJ Prepost record is generated for the quantities of remaining WIP 
inventory (in the ARINVT_WIP table) at the time of deleting or archiving the work order. Labor and 
overhead are included when using standard costing, but they are not included when using actual costing. 
This GJ prepost entry cannot be edited. The table is cleared once the GJ entry is posted. 

For more information on work orders please see the Work Order help files. 
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Assembly Track 

The Assembly Track module is used to track ASSY type manufacturing operations, enter labor, and 
produced part information. From the Assembly Track module users can also update the schedule, view 
material exceptions, rough cut capacity, labor capacity, and more. 

If the customer does not have Time & Attendance, Assembly Track can be used to report final assembly, 
and enter labor reporting as well. If you have Time and Attendance, then this information can  be 
captured in AssemblyData (see below). 

To access the Assembly Track module, select the Assembly Track speed button from the Mfg tab on the 
launcher bar. Select the MFG Type or MFG Cell from the selection criteria form. (Only MFG types that are 
based on an ASSY MFG Type will be displayed). This filter can be selected from Filter button or from the 
File menu in Assembly Track to switch to a different MFG Type/Cell. 

A Confirm pop-up will appear asking if the user would like to recalculate all work orders processes 
production start and end time. Select Yes to recalculate, or No to not recalculate. If it is not desired that 
this pop-up not appear each time check the ‘Do not show next time’ box. This function is also available 
on the Assembly Track form. The user can recalculate the processes production start and end time for all 
work orders or for the highlighted work order by selecting one of these options from the drop down 
arrow next to the calculator speed button. 
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The top section shows work orders that are for the ASSY manufacturing type that have been added to 
Assembly Track from the ASSY scheduling pool. Once added to Assembly Track the work orders are 
marked Firm. The top section is sorted by work order and cannot be changed. Use the Search button to 
access the pick list to find specific records. 

The middle section displays the associated process number(s), process description(s), and a progress bar, 
the quantity that has been reported as completed the process, and the time in hours remaining for the 
process. 

The lower section displays reject information and sales orders. 

Filter button - Select this button  to access the Selection Criteria form to choose a different 
assembly MFG Type or Cell to view. 
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Assembly Track Top Section 

The top section displays all of the work orders that have been added to the Assembly Track. 

Alphabetical field listing for the top section: 

% Completed The Calculation for this column is (OrigQty – Qty / OrigQty) * 100.  

% Reject Total Reject % = [Sum (Reject Cost from all processes) / (standard cost of the item 
* WO Qty)] * 100 

Class Item’s class. 

Completed During Final Assembly, if the user checks the completed option and chooses 'No' to 
delete the work order, the work order will not be deleted and the work order will 
be flagged as 'Completed' and will be highlighted in yellow. 

Note: When marking a work order ‘completed’ or deleting a work order, if 
the processes 'Qty to Complete' is not zero, a warning will appear stating: 
‘Open processes, cannot complete. Costing will be out of balance.’  
Security can be set on this warning.  If the user continues to delete the 
work order, this information will be written to the Event Log. (This 
message will not appear for ASSY3 work orders because the material is 
backflushed during Final Assembly and the transactions all appear in Finish 
Process WIP). 

Description / Ext 
Description 

Description and Extended Description of the item. 

EPlant ID This is the EPlant ID associated to the work order. 

FG Lot # This is the FG Lot # associated to the item.  

If both the 'Increment/Change Lot # at Setup' and 'Use WO # as Lot #' Scheduling 
Parameters are checked the FG Lot # field will populate with the WO #. 

Users can right click and select 'Change FG Lot #' to set the lot number to the next 
sequential lot number. When performing a Final Assembly or when printing 
barcoded labels, the system will default to this Lot #. 

Firm This will be checked if the work order is marked Firm. 

Force Start Time When this is checked the system will not change the ASSY_START_TIME when 
recalculating Assy Start & End Time. 

Item# This is the item number associated with the work order. 

Labor % Used [Sum (time to produce good parts) / WO Prod Hrs] * 100 

** Time to produce good parts (per process) = [Cycle time / multiple of / 
(yield/100)] * Sum (process quantity from table: TA_LABOR.process_qty) for that 
WO/Process 

Note: Processes that are marked as a Rework Process will be excluded from the % 
Completed calculation. 
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Mfg # This is the Mfg # (BOM) associated to the work order. 

Must Start This is the calculated must start date for the work order. 

OrigQty The original quantity the work order was created for. 

Priority Note 1 & 2 The Priority Notes from the work order. These can also be modified from here, by 
typing in the field, which will update the work order. 

Production Hours The total number of production hours required from the work order. 

Projected End Time The projected end date/time for the work order.  It is calculated from the final 
process Projected End Date. This is based on the Start Time. 

To calculate this field select the ‘Calculate this work order processes production 
start and end time’ (Calculator) speed button to update this field. 

Note: Select the drop down arrow next to this button to calculate this for all work 
orders. 

This field will be color coded Green if the Projected End Date is before the WO End 
Date and Red if the Projected End Date is after the WO End Date.   The WO End 
Date is based on the Sales Order Release Date – the Ship Time. 

Qty The required work order quantity. This will be updated based on the number of 
parts reported through Final Assembly. 

Note: The quantity will be increased when a Reverse Disposition is done (in 
IQRF or WMS) on the ASSY item. 

Quality Issues This will be checked if any records exist for the item on the work order in 
CAR/CAPA, ECO, Deviation, PPAP/Product PQ, or MRB.  A Show Quality Issues 
right click option is available to bring up a screen showing the quality issues, and 
allows jumping to those issues. 

Reject Cost Total Reject Cost = Sum(Reject Cost from all processes) 

Release Date The first release date from the sales order that does not have a zero quantity. 

Rev Item’s revision. 
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Start Time This is populated with the Must Start date when the work order is added to 
Assembly Track.  This field can be edited by the user by selecting a different date 
from the drop down calendar. If the Start Time is changed select the Calculator 
speed button to re-calculate the Projected End Time. 

Material requirements are calculated from the start time if the work order is in 
Assembly Track. 

Note: An item with two releases for the same date will have the same Must 
Start Time and therefore the same Start Time. 

Note: If the Scheduling Parameter ‘Evaluate Negative Consumption’ is 
enabled, the Start Time for dependent work orders will be overwritten and 
be based on the Must Start Date. 

Note: If the start time is left blank and the record is posted, the Start Date 
will return to the last posted date. 

WO# This is the work order number generated by the system to produce the items 
required to meet demand. This field will be in red text if the work order is on the 
Material Exception list. 

Work Order Print Date The date/time the work order was printed. 

Work Order Printed By The user name who printed the work order. 
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Right Click Options – Top Section: 

▪ Report Final Assembly – This option is used to report the number of items that are complete (have 
gone through all processes). This function will add the manufactured items to inventory. Please see 
Report Final Assembly for more information. 

▪ Insert WO – This option will open the Add to Assembly track form. It performs the same function as 
selecting the insert (+) button. 

▪ Change FG Lot # - Select this option to bring up the Set FG Lot # form to allow the user to change the 
lot #. When performing Final Assembly in Assembly Track or AssyData, or when printing bar-coded 
labels, the system will default to the entered FG Lot #. Ensure unique lot # per item - When this 
option is checked the system will assign a unique lot number for each item in a family tool. Exp. Date 
- If the item has the 'Expiration Date is Mandatory' option checked (Inventory->Additional tab) this 
field will be visible. For a new lot number a date must be entered or the user will get an error. Select 
the date from the drop down calendar. 'Retain Assigned Lot # for this Work Order' - When this option 
is checked the system will populate the FG Lot # in the Work Order table (WORKORDER.FG_LOTNO), 
and the lot number that is assigned will not be changed by the system later with the work order 
number if the global Scheduling Parameter 'Use WO # as Lot #' is checked. General - This tab shows 
the last number used when Next Lot # was selected for any item. 

▪ Rework Reporting - When this option is selected the Production Reporting by Work Order (PRW) 
module will open with the work order pick list filtered on the REWORK Mfg Type. See Rework 
Reporting for details. 

▪ Throughput Map - This displays the Projected Process Throughput Map for the highlighted work 
order. This is a graphical view of the required processes. The left axis displays the Process # and 
Description, and the percent complete. (The start and end times consider the MFG Cell calendar). For 
more information see Process Throughput Map and Process Dependencies. 
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▪ Show Quality Issues - If records exist for the item on the work order in CAR/CAPA, ECO, Deviation, 
PPAP/Product PQ, or MRB this option will be available. Select this option to bring up a screen 
showing the quality issues. Users can right click to jump to those issues from the pop up form. 
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▪ Jump To's: Work order, BOM, Inventory. 

▪ Costing Info - This option displays the actual and standard cost details and totals, as well as variances 
for the final product. 

Note: The user can also see costing information in the Process Cost module, however, only if final 
assembly has been reported on that work order.  If the work order has been deleted, the user can only 
see the costing information from Process Cost, again, only if final assembly has been reported on that 
work order. For reporting, the 'Assembly Process Cost Detail' (PC_dtl_assy.rpt) report should be used for 
ASSY work orders as it uses different composite tables to gather the data, and not the 'Process Cost 
Detail' report (pc_dtl.rpt). 

Actual Cost Calculations 

Actual Overhead is the total hours entered into Assembly Track or Assembly Data for all of the processes 
multiplied by the Mfg Type’s labor based overhead rate, and divided by the total transaction quantity to 
arrive at a per-piece cost. 

Actual Labor is calculated using the employees charge rates from Employee Maintenance multiplied by 
the total hours for each rate. The total labor dollars is then divided by the total transaction quantity. 

Actual Materials is the sum of the actual costs multiplied by the transaction quantity for all attached 
materials. 

Example: 
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Trans Qty = 100; Total Hours = 205; Overhead Rate = 25; Employee Charge Rates =15 (100 hours) and 25 
(105 hours) 

Actual Overhead = Total Hours * OH Rate / Trans Qty = (205 * 25) / 100 = 51.25 

Actual Labor = Sum of the (Labor Hours * Actual Employee Charge Rate) / Trans Qty 

                        = [(100 * 15) + (105 * 25)] / 100 = 41.25 

Actual Materials = Sum of the (Actual Cost * Trans Qty) / Trans Qty 

                              = [(100 * 1.15) + (100 * .046)] / 100 = 1.196 

 
 

Assembly Track Processes Section 

The middle section displays the specific Process information associated with the work order highlighted 
above. 

Process # Process sequence number. 

Dispatch ID This is the ID for the process from the SNDOP_DISPATCH table. 

Process Details The process operation number and description. This text will be bold if the 
process is scheduled in finite scheduling. 
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Progress Progress % = (Qty / WO qty) * 100 

Note: The progress percentage takes into account any rejected mfg parts and 
updates the progress percent for each process where more components will be 
needed. 

Example of progress percentage: (A BOM with 3 processes.  The processes have 
attached components with parts per = 1.  WO qty = 200) 

After reporting 200 good parts and 3 rejected mfg parts on process 1, the 
progress % of process 1 = 100. 

200 good parts, 3  rejects = 100%  (200/200) 

After reporting 100 good parts and 5 rejected mfg parts on process 2, the 
progress % for process 1 will now be 97.5% (because now process 1 needs 5 more 
components) and the progress % for process 2 will be 50%.  

200 good parts, 3  rejects = 97.5%  (200-5)/200 

100 good parts, 5  rejects = 50%    (100/200) 

After reporting 50 good parts and 10 rejected mfg parts on process 3, the 
progress % for process 1 will now be 92.5%, progress % for process 2 will be 45%, 
and the progress % for process 3 will be 25% 

200 good parts, 3  rejects = 92.5%  (200 – 5 – 10)/200 

100 good parts, 5  rejects = 45%    (100 - 10)/200 

50 good parts, 10 rejects = 25%    (50/200) 

Progress bar colors - compares the actual parts per hour versus the standard parts 
per hour. 

▪ Actual parts per hour = qty / sum(time out – time in) for that process / # of 
Processes the employee was logged into simultaneously 

▪ Standard parts per hour = 1 / [Cycle time / multiple of / (yield/100)] 

If Actual is 100% or greater than standard, then the bar is green 

If actual is 95 – 99% of standard, then the bar is yellow 

If actual is less than 95% of standard, then the bar is red 

Qty Completed Sum of the process quantity (from table: TA_LABOR.process_qty) for the specific 
WO/Process. 

Rejects This column represents only Mfg Parts rejects. 

Hours To Go [Cycle time / multiple of / (yield/100)] * (WO Qty – Qty). 

Continue to Next Process If the process has the Sequential Processing option checked this option will be 
available (otherwise it will be grayed out). The user can check the ‘Continue to 
Next Process’ box for processes that are complete. Once it is checked an 
employee will be allowed to log into the next process through Assembly Data. If 
this is not checked it will prevent an employee from clocking into the next process 
in Assembly Data. 

(This information resides in the Ptorder_sndop_complete table.  If an operation 
number shows in there, then users can log into the next process). 
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Qty To Complete The number of items to be completed. 

Projected Start Time Projected start time for the process. 

Note: For ASSY1 work orders scheduled in the first position of a RealTime™ work 
center the parts to go and hours to go are updated based on RealTime™. If the 
work order is not placed on a RealTime™ work center in the first position, the 
parts to go and hours to go will reduce based upon reporting Good Parts on the 
process in Assembly Track. However, the hours to go will not always match the 
projected start and end times of the process. The hours to go represents the 
actual time to produce the parts. The projected start and end times take into 
consideration slack time. Slack time is the idle time needed before the process 
can continue. Any time there is a process with a faster cycle time than the one 
before it, there will be slack time gaps in that process. This is because the process 
has to wait for parts from the previous process to be produced before it can 
continue. 

If not scheduled in Finite Scheduling, the Projected Start Time and Projected End 
Time is calculated using the Process Throughput algorithm. 

Projected End Time Projected end time for the process calculated using the process throughput 
algorithm. 

Note:  

▪ When the MFG Type option 'Do Not Round Dependent Demand' is not checked: 
Dependent demand will be rounded up to the next whole number on dependent 
work orders. This may cause parent work orders to start prior to the dependent 
work order completing. This is due to the Work Order End Date of the dependent 
work order being calculated based on the Cycles Required where as the 
projected end time in Assembly Track is calculated based on the rounded up 
quantity to complete. The parent work order will start based on the dependent 
demand work order end date. 

▪ When the MFG Type option 'Do Not Round Dependent Demand' is checked: 
Dependent demand will not be rounded up to the next whole number on 
dependent work orders and therefore does not cause a discrepancy between the 
work order end date and the projected end time in Assembly Track. 

Must Start This is the Must Start for the process. It is calculated as follows:  

First Process must start date = WO Start Time from Assembly Track Top Section. 
Subsequent processes must start is based on the process throughput algorithm. 

Note: The ‘Evaluate Negative Consumption’ option in Scheduling must be utilized 
in order for the system to calculate the Must Start times correctly for dependent 
processes.  If dependent work orders are found to be out-of-sync for Must Start 
dates in Scheduling and the middle grid of Assembly Track, users should either 
remove these work orders from both Scheduling and Assembly Track and then re-
load them, or alternatively users can manually change the Start Time of 
dependent orders in the top grid of Assembly Track to get the Must Start times 
back in sync for the dependent processes. 

Work Center # If the process is scheduled, this field will be populated with the work center # that 
the process is scheduled on. It cannot be edited from this field. 



ASSY Manufacturing Page 121 of 358 

 

Color Coding 

▪ Green - If Actual progress is 100% or greater than standard, then the bar is green 

▪ Yellow - If actual progress is 95 – 99% of standard, then the bar is yellow 

▪ Red - If actual progress is less than 95% of standard, then the bar is red 

▪ Light Blue - Constraining Process – The process that is the constraint will be flagged in light blue. This 
indicates where the bottle neck is, basically the process that will take the longest. 

▪ Bold - The Process Details field will be bold if the process is scheduled in the finite schedule. 

▪ Red Outline - When a material on a process is on the Materials Exception list, the 'Dispatch ID' field 
will be in red text. When right clicking on the process and selecting Materials Required, the 'Item #' 
field of the material that has the exception will be in red text also. Any materials marked 'Exclude 
from Backflush' on the BOM will not be affected. This allows for better visibility. 

Right Click Options – Middle Section 

▪ Materials Required – This will display the material(s) required for the process. It includes the items 
details such as UOM and Rev, Qty Required, On Hand, Non Committed, Exclude from Backflush check 
box, and Hard Allocated. Right click to Jump To Inventory. If the item is on the material exception list 
it will be highlighted in red. Reporting against the process reduces the 'Qty Required', (reporting Final 
Assembly against the WO does not reduce the 'Qty Required' for the process). 
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▪ Show Details – Displays the labor and equipment usage details. This is described in greater detail in 
the Show Details section below. 

▪ Costing Info – This option displays the concurrent actual cost details for the process. The system 
keeps track of the actual costs based on a 'bucket' for the total good parts that have passed through 
the process and three 'buckets' (Labor, Overhead and Components) for the total costs incurred. The 
total costs incurred buckets will store the total expenditure of labor, overhead and component usage 
at actual cost.  Rejected components will also be included in the component cost bucket. During 
Final Assembly, the process cost buckets will be used to calculate the actual cost by dividing the 
process total good parts by each cost bucket.  By summing all processes an actual cost per item will 
be calculated. When the final assembly is posted the system will update each process bucket by 
subtracting the final assembly quantity from the process good parts bucket and subtracting the final 
assembly quantity * the per unit cost for each cost bucket. 

 

Actual Cost Calculations 

Actual Overhead is the labor hours entered into Assembly Track or Assembly Data multiplied by the 
Mfg Type’s labor based overhead rate, and divided by the total process quantity to arrive at a per-
piece cost. 

Actual Labor is calculated using the employees charge rates from Employee Maintenance multiplied 
by the process hours for each. The total labor dollars is then divided by the total process quantity. 

Actual Materials is the sum of the actual costs multiplied by the transaction quantity for all attached 
materials. 

Example: 

   

   

Process Qty = 1940; Process Hours = 6; Overhead Rate = 25 
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Actual Overhead = Process Hours * OH Rate = 6 * 25 = 150.00 

Actual Labor = Sum of the (Process Hours * Employee Charge Rate) 

                        = [(3 * 25) + (3 * 15)] = 120.00 

Actual Materials = Sum of the (Actual Cost * Trans Qty) 

                              = [(555 * 0.25) + (425 * 0.23) + ( 960 * 0.23)] = 457.30 

WIP Act Cost = Sum of Components, Labor and Overhead / WIP Quantity = (150 + 120 + 457.30) / 
1940 = 727.30 / 1940 = 0.374897 
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Note: The Process Cost/Actual Cost may be higher if components are rejected on the process because the 
cost of the rejected component will be part of the actual cost on the FG item. If the reject should not be 
part of the actual cost than the component can be rejected through Transactions and Locations or PO 
Receiving. 

▪ Dispatch List Priority – This opens the Process Dispatch List. Please see  Process Dispatch List) 

▪ Labor Reporting – Users can report actual labor and quantities from Assembly Track using this option 
which is described in more detail below (see Labor Reporting).  

▪ Edit Labor - This option allows users to edit the hours and quantity for a specific labor record. (See 
Edit Labor below for more details). 

▪ Edit Process Details – This option allows the user to edit the process details such as UOM and cycle 
time for the specific BOM/Process combination. Editing any field except the Setup Hrs and Take 
Down Hrs will not change the information for the process in Process Maintenance. If the Setup Hrs 
and Take Down Hrs fields are modified it will change the information for the process in Process 
Maintenance. 

   

▪ Jump To Process Maintenance - This will jump the user to the highlighted process. 

▪ Jump to Schedule – This will jump the user to the Finite Schedule. 

▪ Jump to Work Center - Will jump the user the process is scheduled on. (This option is for ASSY1 and 
ASSY2 only). 

▪ Quick Inspection -  Users can jump to Quick Inspection for either the Inventory Item or the Process. 

▪ Finite Schedule This Process – (For ASSY1 and ASSY2 only). This option allows the user to easily 
schedule the process in the finite schedule. (It will not be available if the process has already been 
scheduled). A form will appear listing the work center(s) based on the processes’ qualified work 
center list.  
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The list displays Date Available (the next available start time based on the work center’s current 
schedule) and Runs the Best information. If a process does not have qualified work centers setup, a list 
of all work centers with an ASSY MFG Type or default to the ASSY MFG Type will be available to choose 
from. Select the work center and click OK to add the process to the schedule for the selected work 
center. The process will be added to the bottom. 

▪ Finite Schedule this WO - (For ASSY3 only). This option allows users to schedule the ASSY3 work order 
onto the correct assembly line. The pick list will display the available assembly lines.  Once the WO 
is scheduled, all of the processes in Assembly Track will be in bold. 
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Assembly Track Rejects Section 

The Rejects section displays the component reject information that is entered during labor reporting. 

Rejected Item # / 
Description /Class / Rev 

The rejected item number, description, class and revision level. 

Total Rejects The sum of rejects of the item for the specific WO/Process. 

% Rejected [Total rejects / (WO qty * parts per of component)] * 100 

Reject Cost Total rejects * standard cost of the component 

 

Right Click Options – Rejects Section 

▪ Jump To Inventory 

▪ Show Details – This displays the Reject Details. The user can right click from this form and select ‘Void 
Reject Entry’ to void the reject entry and add the components back into inventory. See Labor 
Reporting for more information. 

 
 

Sales Orders 

This section displays the sales order(s) associated to the WO. The fields include Order #, Customer, PO#, 
Item information, Promise and Request dates, WO Release Quantity, and Job Sequence. If the line item 
on the sales order has been put on hold the Order # field will display in red. The user can right click and 
select Jump to Sales Orders to access the order. 
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Adding work orders to Assembly Track 

To begin tracking an ASSY type work order from the Assembly Track module, select the insert (+) button 
at the top of the form, or right click from the top section and select ‘Insert WO’. A list of ASSY type work 
orders will appear. This list includes all work orders that have not been added to Assembly Track. It 
includes the WO#, Mfg#, Item information (item #, description, rev, class, and EPlant), the quantity to be 
produced, the first release date from the sales order, the number of production hours required, priority 
and firm designations, and the must start date. The work orders listed may be displayed in a different 
color. 

▪ Red text in the WO# field indicates the work order is on the material exception list. 

▪ Blue text indicates the work order is generated from the Forecast module. 

▪ Light Blue - If the work order has been marked a priority the priority field will have a Y in it with a 
light blue background. 

Days Out Filter - Enter the number of days to filter the records displayed based on the must start date. 
The scheduling pool can be limited to only view jobs where the must start date is so many days from 
today. To filter the list to include only work orders for a certain time frame enter in the number of days 
out in the Days Out Filter field. The list will then display only those work orders that have a must start 
date within that period or are past due. 

Jump To’s – From this screen the user can right click and select: Jump to Work Order, BOM, or Inventory. 

Once the work order is added to Assembly Track it is automatically marked Firm and the ASSY_RUN field 
in the work order table is set to ‘Y’. 

The Scheduling Parameters 'Increment/Change Lot # at Setup' and 'Use WO# as Lot #' are applicable 
when adding work orders to Assembly Track. If they are both checked, the FG Lot # will be populated 
with the work order number. 

Note: The 'Exclude back to back same Mfg #' parameter does not apply when adding work orders to 
Assembly Track. It is only considered when scheduling ASSY work orders to the Finite Schedule. 
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Note: Changes can be made to a BOM associated to a work order in Assembly Track. Assembly processes 
can be edited or added and the changes will be reflected in Assembly Track. Additionally, a process may 
be deleted or the process sequence changed as long as the process is not scheduled in the Finite 
Schedule. 

Potential Error Messages: 

▪ If a user tries to add a WO that has been deleted, the following error will appear: 

▪ Encountered the following error: "At end of table. It is possible the selected work order(s) got 
deleted causing the above error – please try again". After clicking OK, the Add To Assembly Track 
form will automatically close. 

▪ If a user tries to add a WO that is already in Assembly Track, the following error will appear: 

▪ "Encountered the following error: Key violation. ORA-00001: unique constraint 
(IQMS.UNQ_SNDOP_DISPATCH) violated ORA-06512 : at « IQMS.ASSY1_MISC », line 191 ORA-
06512: at line 1. Please try again". After clicking OK, the Add To Assembly Track form will 
automatically close. 

▪ If a user attempts to add a WO to Assembly Track while Update Schedule is running they will see 
several warnings: 

▪ The first warning states, "Timeout - Unable to proceed". After selecting OK on that warning a 
confirm message will display, "Update Schedule is currently running. Duplicate work orders may 
be created. Are you sure you want to add this work order?" This message has a Yes and No 
button, as well as a 'Do not show next time' check box. Security can be placed on the Yes button 
and check box. If Yes is selected the work order is added to Assembly Track but may be 
duplicated. If No is selected another message will display stating, "Failed to acquire shared lock. 
'Update Schedule' process is currently in progress. Please try again later". 
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Removing a Work Order 

To remove a work order simply highlight the work order in Assembly Track and select the minus (-) 
button. A pop up confirmation box will appear, to continue select OK. This will just remove the work 
order from Assembly Track but not from the system (the ASSY_RUN field will revert to 'N’. There is also 
an option on the confirmation box ‘Delete workorder from the system’.  If this is checked the system will 
pop up a screen asking the user if it should be deleted or archived. 

 

▪ Selecting Delete will remove the work order from the system. 

▪ If Archive and Delete is selected the work order information is written to the Hist_Workorder table. 
Archived work orders are read only when viewing them.  

Viewing Archived Assembly Track Work Orders 

Archived work orders can be viewed from Assembly Track>File>View Archived Assembly Track Work 
Orders, or via the drop down menu item 'Search Assembly Track Archived Work Orders' on the 
binoculars icon on the Assembly Track form.  
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Right Click Options 

Work Order Section: 

▪ Jump to BOM 

▪ Jump to Inventory 

▪ Jump to Work Order- This access the archived work order. Archived work orders are read only when 
viewing them.  

Processes Section: 

▪ Show Rejects - Shows rejects for the highlighted process. 

▪ Jump to Process Maintenance 

Note: In order to do Actual Cost Work Order reconciliation for removed ASSY Work Orders the system 
will update the required columns in the HIST_ILLUM_RT and HIST_ILLUM_PART tables. 

Note: If a work order is deleted or archived (from the work order, Assembly Track, or Assembly Data) 
prior to the total work order quantity being reported, the WIP Inventory will be cleared out so that 
perpetual to GL stays in balance. A GJ Prepost record is generated for the quantities of remaining WIP 
inventory (in the ARINVT_WIP table) at the time of deleting or archiving the work order. Labor and 
overhead are included when using standard costing, but they are not included when using actual costing. 
This GJ prepost entry cannot be edited. The table is cleared once the GJ entry is posted. 
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Speed Buttons in Assembly Track 

Search - This opens a pick list of work orders in Assembly Track. 

Assign Filter - This accesses the Selection Criteria filter to choose a Mfg Type or Mfg Cell. 

Print Traveler – Select the speed button  at the top of the Assembly Track form to print a traveler 
report.  

Print Work Order - Select the arrow down button next to the printer button and select 'Print Work Order'. 

Note: When printing either one of these reports, the hierarchy is to use the reports associated to the 
MFG Type first and if no reports are listed there, then the reports will be printed based on the ones 
specified in System Parameters. 

Dispatch List - Select the speed button  to access the Assembly Dispatch List. See Assembly 
Dispatch List for details. 

Who is Logged In - Select this button  to show all employees logged into all Work Orders in 
Assembly Track. It will display the employee information, Task Source (AS, WO, or JS), WO#, Process, In 
Time and Elapsed Time. Use the Search button to find a specific employee. This form also includes the 
Form/Table toggle button. 
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Calculate - This button  calculates this work orders production start and end time.   

Auto Load - This speed button  has three functions: 

▪ Auto load non scheduled processes - This option auto loads all non scheduled processes for the 
selected work order. 

▪ Remove from schedule and auto load - This option removes scheduled processes from the schedule 
for the selected work order and auto loads them. This is useful in situation where process 
parameters have been modified. 

▪ Remove from Schedule - This will remove the processes from the schedule for the selected work 
order. Note:  Processes/Work Orders scheduled in the 1st position in Finite Scheduling will not be 
removed from the schedule. 
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Labor Reporting in Assembly Track 

Labor can be reported directly from the Assembly Track module for ASSY1, ASSY2, and ASSY3 processes. 
This allows users to enter the production date, labor hours, and the number of items that were 
processed by a specific employee. When labor reporting records are entered, a zero quantity translog 
record is created for the manufactured item with a transaction type of Process WIP.  For ASSY1 and 
ASSY2 MFG Types a dependent transaction is created for labor and overhead, and the components are 
backflushed.  An entry will be visible from Post Inventory Transactions as a Disposition transaction type 
and Report Process WIP as the Tr. Reason. 

Note: For ASSY3, the labor reporting option is available, however, by default the system will backflush 
material and disposition parts during Final Assembly. 

Note: If the ASSY3 MFG Type has the 'Backflush Each Process' option checked the system will backflush 
components at the time of labor reporting and not during Final Assembly reporting. If 'Backflush Each 
Process' is not checked for ASSY3, the Report Consumed Materials tab will not display. 

Note: For ASSY1, on a process where the BOM has an inherited serial component specified, the system 
will check to see if ‘Use Percent Complete Reporting’ is checked and ‘Consume Raw Material by Process’ 
is not checked. If these are correct the user can proceed as normal. If not, an exception will display 
stating: “Specified BOM is configured to inherit serial component, "Use Percent Complete Reporting" 
must be enabled and "Consume Raw Material by Process" must be disabled on the General Tab of the 
Manufacturing Type Configuration before proceeding”. 

Disposition Hierarchy During Labor Reporting 

When reporting labor for ASSY1 and ASSY2, the following hierarchy is for backflushing the material out of 
inventory.  

1 Hard allocated to the work order 

2 Mfg # default designator 

3 Default designator 

4 Designated work center location (if the process is scheduled in Finite Scheduling) 

5 Designated work center location (if the process IS NOT scheduled in Finite Scheduling, but IS 
scheduled on the Dispatch List) 

6 MFG Cell Dispo locations 

7 MFG Type Dispo OUT location 

8 FIFO 

9 Temporary 

When reporting labor for ASSY3 (Backflush Each Process is checked), the following hierarchy is for 
backflushing the material out of inventory.  

1 Hard allocated to the work order 
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2 Mfg # default designator 

3 Default designator 

4 Designated assembly line OUT location (if the work order is scheduled in Finite Scheduling) 

5 MFG Cell Dispo locations 

6 MFG Type Dispo OUT location 

7 FIFO 

8 Temporary 
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Note: When reporting labor for ASSY3 (Backflush Each Process is NOT checked), there is no hierarchy 
because nothing is backflushed during labor reporting. 

Note: The system will use the disposition hierarchy by default, however users can optionally select the 
location(s) that inventory will be removed from. 

To access the Labor Reporting form, right click on the process completed and select ‘Labor Reporting’ 
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The Labor Reporting form displays and asks for the following information: 
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WO# This is the work order the process is associated to. 

Process # The process number and description that the user right clicked on. 

Employee Select the ellipsis button to access the active employee pick list. Select the 
employee that performed the process from the list. 

Employee certification is not required when entering labor from Assembly 
Track. 

Note: If the selected employee does not have a charge rate assigned in 
Employee Maintenance a warning message will display stating: "Charge 
Rate missing. Emp # [xxxx]. Continue with charge rate of 0 (zero)?" The 
pop up message includes a Yes and No button as well as the 'Do not show 
next time' option. If the user selects Yes, the charge rate will be 0. If No is 
selected or the user clicks the 'X' to exit they are returned to the Labor 
Reporting Form.  

Prod Date The production date populates automatically with the system date but can be 
changed to the actual date the production occurred if different using the drop 
down calendar. The date carries through to the transaction date in translog 
on the FG item and any attached process components. 

RT Production Hours If the process is or has run in RT Monitoring this form will include a field for RT 
Production Hours. The system will calculate the number of production hours 
and good parts that have taken place since the last time this process was 
reported on.  On posting the Labor Reporting record 
ILLUM_RT.PRW_TOTAL_UP_PROCESSED and 
ILLUM_PART.PRW_TOTAL_QTY_PROCESSED will be updated. 

Setup Hours Employees can enter the number of setup hours for the process. Through 
reporting this information can be used to track setup hours for each process. 
(If this field is populated, another row will be created in TA_LABOR where 
IS_SETUP = Y). 

Labor Hours Enter the number of labor hours that the employee performed the process. 
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Good Parts Enter the number of good parts the employee processed.  

Users can report zero or negative good parts and the labor and overhead will 
carry over to actual costing and process costing. 

Note: In the scenario where a phantom item is hard allocated and its 
components are marked ‘Consume All’; if a user is reporting zero good parts 
they will need to set the good parts to 1 and calculate first, then change it 
back to zero so that the phantom components are backflushed in/out on the 
fly. 

Note: If the Good Parts entered is more or less than the work order quantity 
an Authorization required status exception will appear to notify the user. 
Select OK to proceed or Cancel to return to the Labor reporting form. Security 
can be placed on the OK button to not allow employees to enter more or less 
than the work order quantity. 

Lot # This field will automatically populate with the FG Lot # from the work order, 
and will match the FG Lot # when reporting good parts in Final Assembly. 
Note: If lot numbers are entered manually, the Labor Reporting lot number 
must match Final Assembly lot number in order to obtain Lot traceability of 
the backflushed components, which can be viewed in Lot # Tracking after 
reporting Final Assembly. If the labor reporting lot # is different than the FG 
lot #, a confirmation message stating: 'The Labor Reporting lot number must 
match the FG lot number in order to obtain Lot traceability of the backflushed 
components. Are you sure you want to change the Labor Reporting lot 
number?', with Yes/No buttons. Security is available on this form and the 
buttons. 

If the Lot # is mandatory for the inventory item the employee must enter a lot 
number in this field to proceed. If one is not entered an error will appear 
stating: Unable to continue - missing mandatory field 'Lot #'.  If the lot 
number is not mandatory the employee can enter a lot number if desired or 
leave this field blank. 

Comments Enter a comment associated to the labor record. This can be used for 
reporting purposes. 

Continue to next process If the process has the Sequential Processing option checked this option will be 
available (otherwise it will be grayed out). The user can check the ‘Continue to 
Next Process’ box for processes that are complete. Once it is checked an 
employee will be allowed to log into the next process through Assembly Data. 
If this is not checked it will prevent an employee from clocking into the next 
process in Assembly Data. 

Remove process from 
finite schedule 

This option will be grayed out unless the process is currently scheduled in 
finite scheduling. If the option is checked, upon selecting OK in Labor 
Reporting, the process will be removed from finite scheduling. 
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Note: If the process on the BOM is designated as 'Final Assembly Reporting, when the user selects OK on 
the Labor Reporting form the Final Assembly Reporting form will appear to enter Good Parts. See Report 
Final Assembly for details. 

Maintenance, Repair and Overhaul Equipment Cycles Update – When good parts and rejects are entered 
for a process, the total cycles of all tools associated to the process will be updated in MRO. This only 
applies to attached equipment with a unit of measure of Cycles. Note: When good parts are voided or 
when the rejected mfg parts are voided, the cycles of the MRO equipment will be reduced. 

Report Consumed Materials 
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From this tab users can backflush consumed materials with or without reporting good parts. This section 
displays the components associated to the process and includes fields for: Qty Consumed, Parts Per, 
Item #, Description, Class, Rev, and Ext Description. It also indicates whether the components are BOM 
Based or Hard Allocated Based.  If the user enters in Good Parts, click the calculate button to calculate 
the components to consume. If the process has attached materials and the calculate button is not clicked 
on, upon hitting OK a message 'Good Parts' field has been modified, consumed materials must be 
recalculated, Would you like to do it now?' surfaces with Yes and No buttons. If the user clicks 'No' the 
Qty Consumed will not be calculated and no components will be backflushed. If 'Yes' is selected the Qty 
Consumed will be calculated and components will be backflushed. The Qty Consumed field can be 
edited. If 0 good parts are entered the Qty to Consume value must be manually entered. If negative good 
parts are entered the system calculates a negative quantity for the components (including a phantom's 
components) and returns them to inventory. 

Manually Selecting Backflush Location 

By default the system will use the disposition hierarchy when backflushing components, however users 
can optionally select the location(s) that inventory will be removed from. To select the location click on 
the ellipsis button in the Location field and select the location from the pick list. Enter the quantity in the 
Qty field.  
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For Serialized Inventory Control (SIC) items select the insert record button on the navigator bar to access 
the Select Labels form to choose the labels to disposition. Select the ellipsis button in the Enter Serial # 
field to bring up the list of labels to choose from. Highlight the labels to disposition using the toggles 
buttons and press OK. If the user selects the ellipsis button in the location field rather than selecting the 
insert record button a message will appear stating, 'This is a serialized component - use navigator to add 
new labels(s) or delete selected record.Continue to next process'. 

 

Reporting by Percent Complete: On the General tab in MFG Types, if the 'Consume Raw Material by 
Process' box is unchecked, the Report Consumed Materials tab in Labor Reporting will be hidden and the 
user cannot backflush components at the process. They will be backflushed at Final Assembly. If the 
'Consume Raw Material by Process' box is checked, then the this tab will be displayed and the user can 
backflush components at the process. They will not be backflushed at Final Assembly. The 'Consume Raw 
Material by Process' box is defaulted to be unchecked. 

If the user enters in a percentage for % Complete, select the calculate button on the tab to calculate the 
components to consume. If the calculate button is not clicked on, upon hitting OK a message '% 
Complete field has been modified, consumed materials must be recalculated, Would you like to do it 
now?' surfaces with Yes and No buttons.  If the user clicks 'No' the Qty Consumed will not be calculated 
and no components will be backflushed. If 'Yes' is selected the Qty Consumed will be calculated and 
components will be backflushed. If the user enters 0 good parts, the message will not surface because 
there is no parts to calculate the quantity to consume. Users can manually enter in a Qty to Consume 
which will backflush the components. 
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Report Rejects 

Rejects can be entered as part of a labor record or an employee can report just rejects. Select the Report 
Rejects box to enter rejects for attached components or for the manufactured item. 

The mode defaults to Reject Components but can be changed by clicking the ellipsis button in the Mode 
field. A pop up form will appear to select Reject Components or Reject Mfg Parts. 
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Reject Mfg Parts: 

When the reject mode is set to Reject Mfg Parts, an employee can enter rejects for the manufactured 
item from the pop up form. Enter the quantity in the Mfg Parts field and select the reject code from the 
pick list accessed by clicking on the ellipsis button in the Reject Code field. If specific reject Codes are 
assigned to the process, only those codes will be available to choose from. If no specific reject codes are 
assigned to the process then the user will see all based on the EPlant logged into. A FG Lot # can be 
viewed/edited in the Lot # field under the Good Parts field on the main Labor Reporting form. This 
information will populate in the translog. 

When rejecting MFG parts the system will calculate the number of components to be rejected based on 
the quantity of MFG parts rejected. The system will also automatically populate the same reject code 
selected for the Mfg parts for the components. The user can override the quantity of components in the 
Reject Qty field. The reject code can be changed  by selecting a different one from the reject code pick 
lists accessed by selecting the ellipsis button in the components reject code field in the bottom right 
portion of the form. 

Note: If the reject code is changed on the component level, upon doing a Void Reject MFG Part for this 
transaction, the Reject Code that was entered first on the Reject Mode form is the code that will be used 
for the Void transaction.  

Non Conform Location Reject Code 

➢ If the selected reject code has a non conform location associated to it (Reject Codes list) the 
system will do an IN disposition transaction with a reason of 'Non Conform Mfg Rejects' for 
the quantity rejected into the location associated to the reject code. (This does not update 

the Floor Dispo column in the production report). Once the reject is posted a form will 
display to enter the FG Lot #, Non Conform Code and prepare labels. 
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➢ Enter the FG Lot # in the field if desired. If the item has the 'Lot # is mandatory' option 

checked in inventory it is required. Select the Non Conform Code from the pick list accessed 
by clicking on the ellipsis button in the field. This will be the non conform code associated to 
the non conform location in inventory. Labels can be prepared by manually entering in the 

number of labels and quantity per label, or existing label serial numbers can be selected 
from the pick list. 

Note: If no labor is associated to the transaction then the reject is not included in the cost of the part.  
This option to report rejects should be used when reporting labor and good parts.  If only Rejects need 
to be reported they should be entered through the Void->Report Existing As Rejects (Adjustments) 
option – see Void Options. 

Reject Components: 
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Any components that are associated to the process (Materials tab in Assembly Process Maintenance 
module), and items that are substituted or added to an assembly work order through hard allocation, 
will be displayed in the lower components section. Select the 'Include Previous Process' check box to 
include components from all of the processes up to the logged in process. Only processes with 
components will display. If a Non-Material item is attached to a process, the item is not displayed in the 
Reject Components and/or Reject MFG part screen, and cannot be rejected through Assembly Track. If 
any components were rejected during the process the user can enter the reject quantity and reject code 
on the right. 

To enter rejects highlight the correct component and enter the reject Qty in the field. A positive number 
can be entered and reported for previous processes. Select the ellipsis button in the Reject Code field to 
access the pick list of reject codes to select from. If specific reject Codes are assigned to the process, only 
those codes will be available to choose from. If no specific reject codes are assigned to the process then 
the user will see all based on the EPlant logged into. Multiple reject codes can be added for the same 
component. 

From this form users can select the specific location/lot to remove the rejected components from. This is 
optional unless the 'Component Reject Location is mandatory' option is checked for the Manufacturing 
Cell (System Parameters->Lists->Manufacturing Cells). If the option is not checked the bottom section 
will display 'Optional'. If it is checked it will display 'Mandatory'.  If required and a location/lot is not 
selected an error will appear stating: 'Missing mandatory location - operation aborted'. If the Qty 
entered for the location(s) does not equal the Reject Qty an error will display: 'Location total qty is out of 
sync with the rejects qty - operation aborted'. 

▪ For Non-Serialized Inventory Control (SIC) components, select the ellipsis button in the Location field 
and a pick list of locations associated to the component will display. Select a location/lot from the 
list. The quantities of the rejects will be removed from the location(s) chosen (negating the 
hierarchy). 

▪ If the component is SIC, select the ellipsis button in the Location field and a pick list of locations 
associated to the component will display. Once a location is selected, then the labels linked to that 
location will display for the user to choose from. 

Note: Rejected components cannot be over reported or under reported on the location level in relation 
to the totally reject quantity 

Once posted the total rejects will be listed in the lower section of the Assembly Track form. The user can 
right click from a specific item in that section and select “Show Details’ to see the individual reject 
quantities, reject codes and time stamp for that item. 

Note: In order to process transactions, such as rejecting components, users must have a recipe card for 
all levels of manufactured items, or check the 'Disable Cost Calculation' checkbox (Inventory on the 
Standard Costing tab) if costing should not affect the item. (See the "Costing" manual for details on 
recipe Cards and settings). 
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Void Rejects 

If rejects are entered in error the user can void the rejects. Right click in the lower section and select 
Show Details. Highlight the record to be voided, right click and select ‘Void Reject Entry’. Select Yes from 
the confirm box to continue, or No to cancel the void.  

Voiding Rejected Components 

When Yes is selected an ‘Add To Location’ form will appear. If the FGMULTI record still exists the location 
and quantity will automatically fill in. The location can be changed but the quantity cannot. If the 
FGMULTI record does not exist select the ellipsis button in the location field and a pick list of locations 
will appear. Select the location to put the components into and enter the quantity. The quantity must be 
the same as the quantity originally rejected otherwise the user will receive an error: “Total Transaction 
Qty (1.00) must equal 2.00.” 
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For Serialized Items: When voiding a rejected serialized component the system will attempt to add the 
voided quantity to an existing FIFO label. In the rare case of no labels found the system will display the 
following message: ‘This is a serialized inventory. No associated labels found in location 'x' to be credited 
with requested qty. Please have associated label(s) in the specified location and try again later’. 

If component rejects are reported during the Labor Reporting process a manual out transaction will be 
created in translog for the rejected component. 

Voiding Rejected Manufactured Parts 

When Yes is selected a 'Reverse Backflush' form will appear with the quantity populated. Select the 
Calculate button to calculate the materials to add back to inventory. Arrow over the materials to add to 
inventory and select the locations to put them back into. For serialized items, select the ellipsis button 
next to Enter Serial # on the Select Labels to Add form and choose the label. The location will populate 
with location associated to the serial number. 

 

Note: If voiding a MFG Part Reject and the reject code was overridden on the components the Reject 
code for the void will be the one entered first when selected the reject mode. 

Note: If reported rejects were assigned a Non-Conform Code associated with a non-conforming location, 
if the reject entry is voided against those same items, the non-conforming location will be cleared. 
 



ASSY Manufacturing Page 149 of 358 

 

Edit Labor 

The quantity and hours associated to labor records can be edited. Right click on the process where the 
labor needs to edited and select ‘Edit Labor. 

A form will appear displaying the labor records associated to the specific MFG # and Process #. 

 

Highlight the employee on the left whose labor record needs to be edited and the corresponding labor 
entries will appear on the right. Only the Regular Hrs. fields may be edited. Once a record is changed the 
Manually Changed By field will populate with the user ID who made the change. 

Note: The Labor records created from Labor reporting are automatically marked as processed. If you 
cannot find a specific labor record be sure the Hide Processed Records toggle button is not depressed. 
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Show Details 

Right click in the middle section and Select 'Show Details' to display the labor details for the highlighted 
work order and process. 

 

The top section displays the Process information, work order, and item details. 

The lower section is a process log detailing the employees that have performed the process. This 
includes: 

▪ Employee Name 

▪ Process Quantity – The number of items the employee processed. 

▪ Process Hours – The total hours entered in Labor Reporting or calculated based on the clock in and 
out (Time Out – Time In). 

▪ Rejected Records - Quantity of rejected records. 

▪ Time In – The actual date and time the employee clocked into the process 

▪ Time Out - The actual date and time the employee clocked out of the process 

▪ Std Parts / Hr – This is the calculated standard parts per hour for the process. Calculated as: 

         1 / [Cycle time / multiple of / (yield/100)] 

▪ Act Parts / Hr - This is the actual parts per hour for the labor record. Calculated as: 

Qty / sum (time out – time in) for that process / # of Processes the employee was logged into 
simultaneously. 
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▪ Comments – This field displays the comments added from the Clock Out screen in Assembly Data or 
from the Labor Reporting form in Assembly Track. 

▪ Line Clearance ID – This field displays the SNDOP_CLEAR_LINE.ID from the database. 

▪ Note - This is the note the employee entered from the Task Clock. Double click the field to view the 
entire note. 

▪ Process Date - The process date (TA_LABOR.PROCESS_DATE). 

▪ Prod Date - The production date (TA_LABOR.PROD_DATE). 

Color Codes: 

The line item color codes are based on the individual record’s progress which is calculated by comparing 
the actual parts per hour versus the standard parts per hour. 

Actual parts per hr = qty / sum (time out – time in) for that process / # of Processes the employee was 
logged into simultaneously. 

Standard parts per hr = 1 / [Cycle time / multiple of / (yield/100)] 

If actual is 100% or greater than standard, then bar is green 

If actual is 95 – 99% of standard, then bar is yellow 

If actual is less than 95% of standard, then bar is red 

A white line item will appear when an employee is clocked into the process but has not yet clocked out. 

 
 

Equipment Used 

The right pane displays the tool (the PM Equipment # and description) used for this labor record. This 
information can only be added when the record is created using Assembly Data. The information is 
entered during the Line Clearance process. 

Equipment information can be added or deleted. Highlight a labor record and right click on the 
equipment used tab. Select Add or Delete.  If Add is selected, the user can add a tool associated to the 
auxiliary equipment attached to the process.  If Delete is selected, the equipment will be removed.  
Note:  Equipment used is attached based on the Line Clearance.  If Line Clearance was not performed 
in Assembly Data the options to add or delete equipment will not be available. 

Rejects – The Reject details associated to the labor record. The fields on this tab include: the Date, Item 
#, Qty, Reject Code and Description, Reason, Item Description, Class, and Rev. 
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Void Options 

Right click from a labor record and select Void. From the Void menu there are two options: 

Void Good Parts (Reverse Backflush)  

This option allows the user to void the good parts entered on a process record. A reverse Backflush form 
will appear: 
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The Quantity will default to the quantity of good parts reported on the labor record but can be changed. 
Once the quantity is entered select the calculate button for the system to determine the quantity of 
components to put back into inventory. The system will only display the material associated to the 
process step that is being voided. Arrow over the materials to the ‘Add To’ section using the single arrow 
for the selected item(s) or the double arrow for all items and select the location to put the components 
back into. Select OK to complete the transaction. 

When doing a Void (Reverse Backflush) in Assembly Track for items with Serialized Inventory Control 
(SIC) components, after the user selects the serial number(s) to return, then OK, the locations list pops 
up to select a current location or to create new one on the fly. If no location is chosen or created, then 
the user cannot move forward and a message will appear 'Unable to determine master location ID based 
on translog or locations picklist.'  

Note: The Scrap check box is not available on this form because if checked the Post Inventory Transaction 
would be incorrect. 

Note: The button to exclude/include Labor and Overhead is not available on this form. The 
inclusion/exclusion of labor and overhead is dependent on the type of costing being utilized. By design, 
for Standard Costing labor and overhead will automatically be part of the transaction, but not for Actual 
Costing.  

Return Material Only - This same option can be used to just return material back to inventory without 
voiding any good parts. The system will allow a user to enter a void quantity of zero. A pop up warning 
will appear stating, "Transaction Quantity is Zero. Are you sure you would like to continue?". To continue 
select Yes, the material will be added back to inventory (pulled out of WIP and back into inventory).  If 
No is selected the user will be returned to the Reverse backflush screen. Security can be placed on this 
warning box. 

Report Existing As Rejects (Adjustments) 

This option allows the user to report good parts as rejects. A pop up form will appear to enter the Voided 
Qty and Reject Code. 

 

A record will be visible on the Rejects tab on the Process Details form for the Voided Qty. The Progress 
details in the middle section of Assembly track will be adjusted accordingly. 
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Report Final Assembly in Assembly Track 

The Final Assembly function is used to report good parts. The employee can enter the number of finished 
goods that have been completed (gone through all of the required processes). This will add the items to 
inventory and create a record in the transaction log with a reason of ‘Final Assembly’. (Backflushing of 
components for ASSY1/ASSY2 happens during Labor Reporting – not Final Assembly). With matching Lot 
#s for good parts during Labor Reporting and Final Assembly, Lot traceability includes backflushed 
components in Lot # Tracking after reporting Final Assembly. 

➢ Highlight the desired item in the top section of Assembly Track, right click and select Report 
Final Assembly. 

➢ A pop up form will appear to enter the Good Parts, optionally the location, and prepare 
labels. 

Note: If the process on the BOM is designated as 'Final Assembly Reporting, when the user selects OK on 
the Labor Reporting form the Final Assembly Reporting form will appear to enter Good Parts. 
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Enter the quantity of Good Parts. (Note: Zero or a negative number is allowed). If zero is entered in the 
good parts field a warning will appear stating, ‘Zero good parts have been entered.  Continue?’. If the 
user selects Cancel they cannot proceed to the next form. If OK is selected, the system will continue. If 
the quantity of good parts entered is greater than the work order quantity a warning will appear with an 
OK and Cancel button stating, 'Total Good Parts is greater than WO Qty'. Security can be placed on these 
warnings.   

Note: If there are unposted labor records against the work order, a Status Exception showing the work 
order # will appear stating, "There are unposted labor records. Continue?". Security can be place on the 
OK button to prevent users from posting the record. 

Upon finishing Final Assembly if ‘Work Order is Complete’ was unchecked, nothing is posted to translog, 
so in PIT the cost of the consumed components remain in WIP.  If ‘Work Order is Complete’ is checked 
during Final Assembly, the system will write a 0 quantity entry in Translog. Regardless of the quantity 
entered, the system will clear the SNDOP_DISPATCH buckets so that in PIT, the cost of the consumed 
components, labor, and OH of those parts not reported in final assembly would be credited from WIP 
and debited into Variance. 

Note: When a negative value is entered the Post Inventory Transaction (PIT) will display a negative debit 
value instead of a positive credit value. This is because the system does not have IN and OUT in this 
form. It only looks for an IN therefore a negative entry calculates the same as a positive number resulting 
in a negative debit rather than a positive debit.  The journal entry will be correct, the negative debit 
value is converted to a positive credit value. 

➢ Enter a FG Lot # if required or desired. If the item has the 'Expiration Date is Mandatory' 

option checked (Inventory->Additional tab) the Exp. Date field will be populated with the 
lot's expiration date. If the date is required but null an error will display when attempting to 
post stating 'Expiration Date must be entered'. 

➢ Check the 'Completed' box if the work order is finished. After selecting 'OK' the user will be 
asked if the work order should be deleted or not. If it is not deleted it will still be visible in 
Assembly Track but it will be highlighted in yellow to indicate it is complete. Note: When 
marking a work order 'completed' or deleting a work order, if the processes 'Qty to 

Complete' is not zero, a warning will appear stating: "Open processes.  Cannot complete. 
Costing will be out of balance." Security is available on this warning.  If the user continues 
to delete the work order this information will be written to the Event Log. 

When the user tries to delete an ASSY1 or ASSY2 work order through Assembly Track, the system will 
check the translog to verify if PIT is posted. (Note: the option 'Use Standard Cost during Post 
Transactions' must be checked in System Parameters, Inventory Setup tab).  If some records have not 
been posted, an exception error will be raised stating: "Unposted disposition transactions."  The user 
can override the exception to go ahead and delete the work order.  Security can be setup on this 
exception error. 
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A location can be entered by selecting the ellipsis button in the location field. A pick list of existing 
locations associated to the item will appear. The user can choose from one of these or select the New 
button to add a new location. If this field is populated, the parts will be dispositioned into that location.  
This overrides the disposition hierarchy. If the parameter 'Location is mandatory during Final Assembly' 
is checked (Options menu in Assembly Track), if the Location field is not populated, an error message will 
pop up: 'Mandatory field 'Location' must be entered - operation aborted', with an OK button.  When OK 
is selected, the Final Assembly form remains open for the user to enter the location. If unchecked, 
entering a location is optional. 

➢ Prepare Labels by entering the number of labels and the quantity of good parts associated 

with each label. The system will keep track of the balance of items that still need a label in 
the Balance field. If the ‘Print Labels On Final Assembly‘ parameter is checked, or if the item 
is serialized, the user must enter labels for the good parts and the balance must equal zero 
or they will receive an error: “Total labels qty does not match good parts - unable to 
continue”.  The search pick list will display any existing MASTER_LABEL records for the 

selected work order that have not been dispositioned or shipped.  An existing serial number 

can be selected and upon finishing Final Assembly, the system will reprint the label and 
disposition into inventory.  If the parameter is not checked creating labels is optional.  

Note: In IQRF or WMS, a Reverse Disposition can be done for items associated to ASSY MFG Type BOMs 
to allow users to correct the quantity reported during final assembly. Reverse dispositions are done 
based on serial numbers, so in order to use the Reverse Disposition feature labels must be prepared 
during reporting final assembly or existing labels selected in the Prepare Labels section of the Final 
Assembly screen in Assembly Track and AssyData. 

➢ Inherited Labels  - If an Inherited Component was associated to the manufactured item on 

the Item Details tab of the ASSY1 BOM (see the BOM Item Details section for details) users 

are required to select the Inherited Serial numbers to associate with the final manufactured 
item by selecting the Search button in the Inherited Labels section. This will open a pick list 
of serial numbers associated to the Inherited Serial item.  
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The quantity of labels must equal the good parts being reported. If they do not match an error will 
appear stating: "Good parts entered must match the number of inherited consumed labels." 

When the finished part is being dispositioned, the system will clone the component serial and then the 
MASTER_LABEL.SERIAL field of the component serials will be copied to the new produced 
MASTER_LABEL.SERIAL record at the same time that the component MASTER_LABEL record serial fields 
are updated to the master_label.id of the component serial that was just consumed prepended with a 
"~". 

For Example: 

These are the serials for the Inherited Component shown in the Master Label table after being received: 

 

This is the Master Label table after Final Assembly. The Foreign Serial #s 5552, 5553, 5554 are consumed 
and copied onto the parent, and the serial #s for the components updated to the master_label.id of the 
component serial that was just consumed prepended with a "~". In this example below they are now 
~388, ~389, and ~390. 
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The serial # that was copied to the parent item is visible in the MASTER_LABEL.INHERITED_SERIAL field 
so that the user will have the parent/child relationship available for reporting purposes. 

Completing the Transaction 

➢ Select OK to complete the transaction. If a location was not manually selected, for ASSY1 
and ASSY2, items will be put into a location based on the Disposition Hierarchy below: 

If the process IS scheduled in Finite Scheduling: 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Dispo IN of the work center associated to the last process 

5 Dispo IN of the dispatch list work center associated to the last process 

6 MFG Cell Dispo locations 

7 MFG Type Dispo. Designators 

8 FIFO 

9 Temporary 

If the process IS NOT scheduled in Finite Scheduling: 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Dispo IN of the dispatch list work center associated to the last process 

5 MFG Cell Dispo locations 

6 MFG Type Dispo. Designators 

7 FIFO 

8 Temporary 

Note: The Hard Allocated location applies in situations where a manufactured item is used in a higher 
level process and is hard allocated to the higher level work order. 

When reporting Final Assembly for ASSY3 (Backflush Each Process is NOT checked), the following 
hierarchy is for dispositioning the FG item into inventory and backflushing the material out of inventory, 
if a location was not selected manually. 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Designated Assembly line IN/OUT location (if the work order is scheduled in Finite Scheduling) 



ASSY Manufacturing Page 160 of 358 

 

5 MFG Cell Dispo locations 

6 MFG Type Dispo. Designators 

7 FIFO 

8 Temporary 

Note for VIN Generator users: If the work order is associated to MASTER_LABEL records with a VIN 
number, the user will not be able to enter a FG Lot #.  After entering a quantity and clicking Next, 
preparing labels is mandatory (even if the item is a non-serialized control item).  The user can either 
search for an existing serial # or add a label.  Upon posting Final Assembly, the item is dispositioned 
into inventory with the VIN # as the lot #.  The Smart Code, Cost, and Price from the CRM Quote will be 
populated under lot control.  The weight of the item will also be populated under lot control. (For more 
information on VIN Generator please see the Vehicle Identification Number Generator 
https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf TechNote). 
 

https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf
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Rework Reporting in Assembly Track 

From the top section in Assembly Track select 'Rework Reporting' from the right click menu to report 
Rework Mfg Type items using the Production Reporting by Work Order (PRW) module. When this option 
is selected the work order pick list filtered on the REWORK Mfg Type will appear. Select the item to be 
reported from the pick list and the PRW form will open at the Start tab. 

This feature is also available in Assembly Data. 

Start 

 



ASSY Manufacturing Page 162 of 358 

 

This tab will display the Work Order #, Work Order Qty, and Remaining Qty, and the Item information 
based on the selection made from the pick list. To change the work order or item select the ellipsis 
button in the fields and select from the corresponding pick list. The Clear button will remove all of the 
data that was entered to start the production report over. 

Select the WO Completed box if the work order is complete. After clicking on the 'Finished' button on the 
Summary or Costing tab if this box was checked and the work order is marked Firm, the system will ask if 
the user wants to delete the WO, “WO# xxxxx has been marked completed.  Delete this WO?” If the 
work order is not marked firm, it will remain on the schedule for the system to take care of automatically 
when update schedule is run again. 

Right Click 'Jump To' Options available on the Start tab: 

▪ Jump To Work Order 

▪ Jump To Inventory 

▪ Jump To BOM 

▪ Jump To Work Center 

Once the information is complete, select the Next button. 

Quantity 
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From this tab users will enter the quantity reworked. The Lot # will automatically populate with the 
current lot of the MFG#. A Lot # can be manually entered or the user can select the 'Set Next FG lot #' 
button to have the system apply the next lot number. If the WO Completed box is checked, if the 
quantity being reported is less than the WO quantity when clicking ‘Next’, a warning will appear: 
‘Quantity reported is less than the work order quantity.’ This warning has a ‘Do not show again’ option. 
Security can be placed on this warning. 

Prod Hours 

Select the Work Center from the pick list accessed by clicking on the ellipsis button in the field. Then 
enter the production hours.  
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Labor 

Specific employees can be associated to the production report record. Select the + button to add a labor 
record. Then select the ellipsis button in the 'EmpNo' field and select an employee from the pick list. The 
Prod Hours field will populate with the Prod Hours entered on the previous tab. This value can be edited 
to record the actual labor hours associated to the specific employee. Multiple labor records can be 
created by selecting the + button again. 
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Rejects 

Rejects for attached components or for the manufactured product can be entered from the Rejects tab. 

 

From the Mode field select the ellipsis button and choose: Reject Components or Reject Mfg Parts from 
the pop up form. 
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Reject Mfg Parts 

When the Reject Mfg Parts option is selected enter the quantity of rejects in the Mfg Parts field, and 
select the Reject Code from the pick list accessed from the ellipsis button. The eraser button next to this 
field can be used to clear the selected reject code. The system will automatically calculate the reject 
quantity for the components based on the Mfg Parts reject quantity, but it can be overridden by entering 
a different value in the Reject Qty field for the specific component. The Reject Code will default to the 
same code that was selected for the manufactured item but can be changed by selecting a different code 
from the pick list. Additional information can be entered by typing in the Reason field. 

Reject Components 

Select this option to reject the components without rejecting the manufactured item. The components 
associated to the BOM for the manufactured item will display in the middle section. Highlight the item to 
be rejected and enter the quantity in the Reject Qty field in the bottom section of the form. Select the 
reject code from the pick list and enter a reason if desired. 

Disposition 

The Disposition tab the system will do an OUT transaction from the non-conform location and an IN to a 
location based on the disposition hierarchy. (Note: If the disposition IN location is marked as non-
conform then the item will remain in non-conform status, if this is not desired be sure that the IN 
location based on the hierarchy is not marked as non-conform). The transaction will show up in Post 
Inventory Transactions (PIT) as a transaction type of disposition. The system uses the costs associated to 
the Recipe Card. If it is desired that the costs come from the Rework BOM you must recalculate it and 
roll those costs.displays the reworked item. It will populate the 'Add To' and 'Materials Involved' sections 
based on the reported good parts and the BOM information. 
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Summary 

The Summary tab displays the information that was entered in the production report, such as serial #'s, 
labor, locations, rejects, and backflush information. 
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Once the information is reviewed, the transaction can be posted by selecting the Post button. A confirm 
message will display stating, "Are you sure you want to post this production report?" If Yes is selected, a 
'Disposition' type transaction will be made. Selecting No will return the user to the summary tab without 
posting the transaction. If the relieved quantity differs from the Materials Involved quantity by 10% or 
more, a warning will appear when posting the Production Report. If information needs to be edited prior 
to posting select the Back button to return to the previous tab(s). 

From the Summary tab users can right click and choose to copy and paste the summary, or print it (print 
or print preview). 

Costing 

This tab displays the Costing information for the item. This functions just like the Process Cost module.  
For a complete discussion on the process costing module please refer to the Introduction to Process 
Costing topic in the Standard and Actual Costing section of the help files. 
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Finish 

Once the the production report is complete, select the Finish button and select Yes to the confirm 
message. The user will be returned to the Start tab. 

Reverse Disposition  

There is a Reverse Disposition check box on the Start tab to perform a reverse disposition. If this is 
checked, the Quantity tab for non-SIC items will display the 'Enter Quantity' tab only. For SIC items the 
Scan Serial tab will only display. The Disposition tab will  relieve the manufactured product and add the 
materials involved based on the work order.  

Select the work order and check the Reverse Disposition box. The PRW form will display Reverse 
Production for Work Order # xxx in the top blue bar. 
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Select Next to access the Quantity tab. If there is more than one production report for the work order 
another pick list will surface to select the specific Production Report ID to reverse. 

Once the Quantity screen appears, for non-SIC items the user will enter the quantity of production to 
reverse in the 'Good Parts' field, and enter a lot # if applicable. 

 

For SIC items the Scan Serial tab will only display. Select the search button to access the list of serial 
numbers associated to the work order. Select the serial number(s) and press OK. 
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The Disposition form will show the manufactured product coming out of inventory and the materials 
involved will be added to inventory. During the reverse disposition users should not enter any reverse 
consumed materials. All this information will automatically come in based on the original disposition, 
including if they were hard allocated. 

 

 

 

 
 



ASSY Manufacturing Page 173 of 358 

 

Dispatch Lists 

Assembly Dispatch List 

The Assembly Dispatch List allows the user to schedule a process to a work center dispatch list (not the 
actual work center schedule) in order to prioritize the processes to be run on a work center. 

To access the Dispatch List select the speed button at the top of the Assembly Track form . 
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The Left side of the form displays all of the ASSY1 work centers and includes the Work Center #, 
Description, Center Type, Mfg Cell, and EPlant ID. 

The right side is the Dispatch Priority List where the user can select specific processes to prioritize on a 
work center. The top section displays the WO #, Priority Notes and process details such as parts to go 
and hours to go. If the process is finite scheduled the Process # column will be in Bold.  If the Process is 
finite scheduled, the system will not allow a change in Seq #, Additions or Deletions.  If the user 
attempts do any of these functions a message will display stating: "Work Center 'xxx' has processes 
scheduled in Finite Schedule. Jump to Schedule to make changes to the Finite Schedule." When a Process 
is added to the finite schedule it will also be added to the Assembly Dispatch List reflecting the finite 
schedule Seq #.  If the finite schedule Seq # is reordered the Assembly Dispatch List will reflect the 
change in sequence.  If the Process is deleted from the finite schedule it will also be deleted from the 
Assembly Dispatch List. 

Upper Section Right Click Options: 

▪ Jump to Work Order 

▪ Jump to Schedule 

▪ Jump to Process Maintenance 

▪ Jump to BOM 

The bottom section displays the sales order and customer details.  

Bottom Section Right Click Options: 

▪ Jump to Sales Order 

▪ Jump to Inventory 

Schedule a Process from the Dispatch List 

If there are no processes finite scheduled a process can be added to the Dispatch List. If process have 
been finite scheduled all additions, deletions and changes must be done from Finite Scheduling.  

To schedule a process highlight the work center on the left and then select the Insert Process button 

. A list of unscheduled processes will appear. This list includes the item, process, and work order 
information. It also includes the Job Sequence number from the Sales Order release. This field can be 
used to inform the operators what parts they need to build and in what order they are needed.  The 
Hours To Go and Parts To Go display on the right side of the form and populate based on the highlighted 
unscheduled process. 
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Highlight the process to be scheduled, or use the toggle buttons to multi-select several processes. Select 
the position using one of the options: Add to bottom or Insert into a position number. Select OK to add 
the them to the work center’s dispatch priority list. 

Each process is now scheduled on a specific work center in a specific position. The Dispatch List in 
AssemblyData will be updated to reflect the changes made here. 

Once processes are scheduled on the dispatch list users can move them up or down to change their 
position in the list by dragging and dropping them with the mouse. 
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Process Dispatch List 

From the middle section of the Assembly Track form the user can right click and select Dispatch List 

Priority to access the Process Dispatch List.  This differs slightly from the Assembly Dispatch List. The 
emphasis is on the specific process selected. 
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The Process section contains the Process #, description, Work Center # and Position where it is currently 
scheduled if applicable. 

The Work Centers section lists the process’s qualified work centers. 

The Dispatch Priority List section displays the work order information including priority notes and sales 
order information for processes that are scheduled on the highlighted work center. If the process is finite 
scheduled the Process # column will be in Bold.  If the Process is finite scheduled, the system will not 
allow a change in Seq #, Additions or Deletions.  If the user attempts do any of these functions a 
message will display stating: "Work Center 'xxx' has processes scheduled in Finite Schedule. Jump to 
Schedule to make changes to the Finite Schedule." When a Process is added to the finite schedule it will 
also be added to the Assembly Dispatch List reflecting the finite schedule Seq #.  If the finite schedule 
Seq # is reordered the Assembly Dispatch List will reflect the change in sequence.  If the Process is 
deleted from the finite schedule it will also be deleted from the Assembly Dispatch List. 

Upper Section Right Click Options: 

▪ Jump to Work Order 

▪ Jump to Schedule 

▪ Jump to Process Maintenance 

▪ Jump to BOM 

The bottom section displays the sales order and customer details.  

Bottom Section Right Click Options: 

▪ Jump to Sales Order 

▪ Jump to Inventory 

If there are no processes finite scheduled a process can be added to the Dispatch List. (If process have 
been finite scheduled all additions, deletions and changes must be done from Finite Scheduling). 
Processes can be scheduled similar to the method used in the Assembly Dispatch List. Highlight the work 
center you would like to schedule the process on and then select the Insert Process button. The Assign 

Position form will display to update the process’s scheduled position. 
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This form displays the current work center and position if the process has already been scheduled. It also 
shows the work center the process is to be dispatched to. Select the new position by choosing ‘Add to 
bottom’ or ‘Insert into position’, and then select OK to dispatch the process to the selected work center 
and position. 

This will update the Dispatch List in AssemblyData as well. 
 

Assembly Track Options Menu 

Various options are available from this menu. These options allow quick access to other related modules 
in the software. 

Parameters 

▪ Auto Remove FIRM work orders – With this checked the system will automatically remove completed 
firm work orders from the system.  This is a global setting that can be turned on to look at firm 
work orders. If the firm work orders are completed and no longer scheduled on the finite schedule 
they will be removed during the update schedule process. This global setting can be overridden at 
the work order level. 

▪ Auto Archive Removed Firm Work Orders - This is only available if the 'Auto Remove Firm work 
orders' is checked. During Update Schedule,the system will Archive and Delete the work order if 
this is checked. 

▪ Include JobShop Based Work Orders - Check this box to also auto remove firm work orders for 
JobShop work orders. If the check box is not checked update schedule will not delete any firm, 
completed work orders that are attached to a JobShop project. If a user attempts to delete a 
JobShop work order from the Work Orders module or from Assembly Track, an exception 
message, 'WO is attached to a Jobshop Project' with security on the OK button is raised. 



ASSY Manufacturing Page 179 of 358 

 

▪ Print Labels on Final Assembly – If this option is checked it will be mandatory to print labels during 
Final Assembly. If it is not checked it will be optional to print labels. Note: This is a work station 
specific parameter. 

▪ Location is mandatory during Final Assembly - If checked, when reporting final assembly through 
Assembly Track and AssemblyData, the system will ensure the Location field is populated. If the 
Location field is populated, the system will continue with Final Assembly. If the Location field is not 
populated,  an error message will pop up: 'Mandatory field 'Location' must be entered - operation 
aborted', with an OK button.  When OK is selected, the Final Assembly form remains open for the 
user to enter the location. If unchecked, entering a location is optional. 

▪ Do not set BOM & Inventory inactive - For JobShop 2 - If this is checked the BOM and inventory will not 
be set to inactive when the JobShop project is archived. 

▪ Finite Scheduling tab - Fast Finite Schedule (do not adjust sibling processes)  

▪ With this checked, during auto load scheduling of ASSY processes the system will not attempt to 
move out or recalculate sibling(s) scheduled on another work station. This speeds up the Auto 
load process. If this is not checked Auto Load may be very slow.  

▪ Also, without this checked Update Schedule may be very slow. When this is not checked the 
system will recalculate all the associated dependent processes which can increase the time it 
takes to update the schedule.  

▪ Note: For ASSY work orders the 'Backward Pass Late Work Orders' (Finite Schedule Parameter) 
will not run if this option is not checked. 
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Shop Setup 

This takes the user to the Shop Calendar. See the Shop Setup section in the Introduction to the Basics.pdf 
or the EIQ.chm. 

Rough Cut Capacity 

This opens the Rough Capacity module in the standard format or the Whiteboard view. Rough cut 
capacity is defined at the total “time” consumed by your work orders. It does not assume all work orders 
have been scheduled. The system displays as much data as available, based on the work orders present 
in the system. The system uses the Shop Calendar to determine hours available. ASSY work orders are 
assigned to the work center type based on the Center Type field in the Process.  If the job is not 
scheduled, the MFG cell is based on the BOM.  If the job is scheduled, the MFG cell is based on the 
work center the job is scheduled on. 

Note: Processes attached to a BOM must have center types with the same MFG Cell as the BOM in order 
for the system to calculate the rough cut capacity correctly. However, ASSY1 processes running as part of 
an assembly line (ASSY2) will be evaluated based on the processes center type and will ignore the MFG 
cell of the work center or parent BOM. 

Additional Information: 

Details of the Day is calculated: 

(Process cycle time * Process Qty to complete) + setup hrs 

Then the system breaks this into how many hours are left in each shift and sums the total 

For example: 

Process cycle time = 3 hrs, setup hrs = 1 

Shop calendar has 3 shifts, 24 hrs/day, 5 days/week, each shift is 8 hrs 

Process qty to complete = 37 

(3*37) + 1 = 112 hrs  

Then this value is broken out by each day. Right click on the WO/Process,to see this broken out by shift. 

(For more information please see the Manufacturing manual or the online help). 

Requirements 

Four modules are available from this option: Material Exception List, Daily Projected Requirements, Daily 
Material Staging, and Daily Parts Projection. These are the same exception reporting tools available from 
the scheduling module. (For more information please see the Manufacturing manual or the online help). 

Labor Capacity 
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This brings up the Labor Capacity module in the standard format or the Whiteboard view. This will 
display Labor Capacity for all MFG Types, but the user can select the filter button to only display labor 
capacity for the ASSY MFG Type. You can measure standard labor hours against the required hours to 
meet your schedule. This system can indicate, by week, day and shift, how many hours you normally 
have available and how many hours are currently planned. The planned hours are based on the work 
orders currently in the system. 

For an ASSY MFG Type the user can utilize the shift information from Time and Attendance to populate 
the standard labor hours automatically. From Assembly Track select Options->Labor->Labor Capacity. 
Then select Standard Labor Capacity from the Options menu in Labor Capacity. Select the Filter button to 
show only the ASSY MFG Type. Highlight the MFG Type/Cell/Shift #/Employee Level combination to 

populate hours for and then select the Assign Hours Based on Time & Attendance Calendar button . 
This will populate the standard hours from the Time and Attendance calendar for that record. 

NOTE: In order for this to function the employees must be assigned a Department with a MFG Type and 
an employee level in Employee Maintenance, and be assigned to a Time and Attendance shift. 

The following SQL can be executed in IQAlert on a weekly basis to populate the ASSY1 standard labor. 
(Substitute the correct ASSY MFG Type in the SQL for ASSY2 and ASSY3). 

begin 

  for v in ( select distinct rtrim(mfgtype) as mfgtype, 

                             mfgcell_id, 

                             emp_level_id, 

                             shift 

                        from std_labor 

                       where mfgtype in 

                                (select mfgtype 

                                  from mfgtype 

                                 where standard_mfgtype = 'ASSY1') 

                       or mfgtype = 'ASSY1') 

  loop 

    assy1_misc.assign_snd_labor_week_from_ta( v.mfgtype, 

                                              v.mfgcell_id, 

                                              v.emp_level_id,     
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                                              v.shift );   

  end loop; 

end; 

/ 

(For more information on Labor Capacity please see the Manufacturing online help. For more 
information on the set up please see the online help for Employee Maintenance and Time and 
Attendance). 

Update Schedule 

This option opens the MRP Engine where update schedule is run. 

Note: If if work orders are deleted from Assembly Track while Update Schedule is running capacity 
planning will skip deleted work order and record the event in the Event Log. 
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Labor Scheduling 

This option allows users to schedule employees on specific processes. It provides a view of which 
employee is scheduled on each process. 

Note: This option functions in conjunction with Time and Attendance. Shifts must be created, and 
employees must be assigned to the shifts. 
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Selection Criteria 

The bottom left section is where the selection criteria is entered. This criteria is used to populate the 
Employees section. The Prod Date and Shift default to the current date and shift. Once the information is 

entered select the ‘Apply Criteria’ button . 

Prod Date The production date populates automatically with the system date but can be 
changed to a different date using the drop down calendar. 

Shift The current shift will display. To change the shift, type the information in this 
field. 

Department Select the Department from the pick list accessed by clicking on the ellipsis 
button. 

Mfg Cell Select the Mfg Cell from the pick list to further filter the employees. 

 

Employees 

This section will list the employees that match the entered criteria. The ‘Scheduled On’ section will 
display the WO/Process # the highlighted employee is scheduled on. 

Check the ‘Match process certification’ option to only show employees with a valid certification for the 
selected process. This option requires that the MFG Type’s Process Certification be set to Certified Jobs. 
The system will check to see if the employee is certified for the job description associated to the process 
for the correct certification level. 
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Employee # / First Name / 
Last Name 

These fields display the employee #, first name and last name. 

Shift Hours The number of hours on the shift. 

Scheduled Hours The number of hours the employee is currently scheduled on the shift. This is 
calculated based on the Hours and Operator % in the Scheduled Employees 
section. It is the sum of (Hours x Operator % ) for all processes the employee 
is scheduled on. For example: If the employee is scheduled for 5 hrs at 30% on 
a process and 3 hrs at 75% on another, the Scheduled Hours = (5 x .3) + (3 x 
.70) = 3.6 hours 

Operator % The percentage the employee is scheduled. If this is greater than 100% the 
line will display with red text indicating they are over capacity. 

Scheduled On This section shows the WO #, Process #, Hours and Operator % the 
highlighted employee is scheduled on. 

There are two right click options: 

▪ Jump To Process Maintenance 

▪ Jump To Work Order 

 

Dispatch Lists 

This portion of the form shows the current dispatch list (processes) sorted by the must start date of the 
WO that they belong to. 

Check the ‘Match employee certification’ option to only show processes the selected employee is certified 
to be scheduled on. 

 

Scheduling Labor – To schedule an employee on a process, highlight the employee in the Employees 
section of the form and the process in the Dispatch List that they are to be scheduled on. Then select the 

‘Schedule Employee’ button . The information will populate in the ‘Scheduled Employees’ and the 
‘Scheduled On’ sections of the form. 

Green line item - The line will turn green if the labor requirements have been fulfilled for the process. (If 
the scheduled hours = the required hours). 
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Must Start Must Start Date of the work order the process is associated to. 

WO # Work Order # 

Process # and Description Process # and description. 

Hours To Go The number of hours to go. [Cycle time / multiple of / (yield/100)] * (WO Qty 
– Qty) 

Parts To Go The number of parts left to go. This is the same as the Qty to Complete in the 
middle section of Assembly Track. 

Operator Hours Required - The number of operator hours required for the process. (Hours to 
Go x # of operators required). 

Scheduled – The number of operator hours scheduled. 

Operators Required – The number of operators required for the process. 

Scheduled – The number of operators scheduled on the process. 

Work Center # The work center where the process is scheduled in Finite Scheduling.  If null, 
the work center where the process is scheduled in the dispatch list displays. 

Sales Orders Below the Dispatch List section this form displays the sales order details for 
the highlighted process. This includes: Order #, Customer, PO#, WO Ship Date, 
WO Release QTY, Promise and Request Dates, and Item information. 

The user can right click form this section to jump to the sales order or 
inventory. 

Process Projected Start 
and End Times 

The projected start and end time of the process. 

There are three right click options: 

▪ Jump To Process Maintenance 

▪ Jump To Work Order 

▪ Jump To Work Center 

 

Scheduled Employees 

This section lists the employees scheduled on the highlighted process. 
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Employee # / First Name / 
Last Name 

These fields display the employee #, first name and last name. 

Hours The number of hours the employee is scheduled on the process. This will 
default to the number of required hours if it is less than the shift hours, 
otherwise it will default to the hours in the shift. 

This field can be manually overridden to enter the actual number of hours the 
employee is to work on the process. 

Operator % The percentage of involvement the employee is scheduled. This will default to 
100%. This value can be overridden to a different percentage. This will update 
the Scheduled Hours in the Employees section. 

 

Employee Messages: 

As employees are scheduled, a Time & Attendance employee message will be created so when the 
employee clocks in, the dispatch information will be displayed, along with any other messages that apply 
to the employee.  
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Task Message Parameters – From the Options menu in Labor Scheduling there are two settings: 

▪ Message Display Time – This option allows the user to determine the number of seconds the dispatch 
information will be displayed upon clocking in. This defaults to 30 seconds. 

▪ Print Scheduled Task Message – This allows the employee to print the task message upon clocking in.  
The report that prints is the ASSY1 Labor Schedule report from System Parameters. 
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Finite Schedule for ASSY1 

ASSY1 processes can be scheduled on the Finite Schedule if they are in Assembly Track. Select the Finite 
Manufacturing Scheduling button from the launcher bar. Select the ASSY1 MFG Type or pick a specific 
MFG Cell. The associated work centers will be available to select from. Note: Processes can also be 
scheduled by right clicking from Assembly Track and selecting ‘Finite Schedule This Process’. (See the 
right click options in the Middle Section for details). 

Right click and select ‘Insert Job’. A form listing the WO # / Process # will appear. The available fields in 
this form are: Dispatch ID, WO#, Process #, Process Description, Projected Start Time, Projected End 
Time, Mfg #, WO Must Start Date, Item #, Setup Hrs, Must Start, Ship Date, Group Code, Group ID, 
CSUSER1, CSUSER2, Customer Name, Description, Origin, Priority, Ship To Company, and WO Type. 

The scheduling pool window contains all processes both currently scheduled and unschedule. Each group 
is displayed on a separate tab. Use the Unscheduled tab to see those processes needing to be scheduled. 

By default this will only display processes where the work center is listed as a qualified work center for 
the process. Select the ‘Override work center’ button to view all processes attached to a BOM based on 
the selected MFG Type/MFG Cell in Finite scheduling. 

Highlight the process(es) to be scheduled. Multiple processes can be selected and scheduled using the 
toggle buttons. Select the ‘Add to Bottom’ or ‘Insert into pos #’ option to add the process to the 
schedule. Once a process has been scheduled in the finite schedule module it will display in bold in 
Assembly Track. 

Finite scheduling is color coded based on process production start date vs. process must start date.  In 
the Scheduling window, the must start date will reflect the process must start date.  In the top right 
order of Scheduling is the work order must start date. 
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When an ASSY1 process is scheduled on a work center in finite scheduling, the projected start and end 
times in the middle grid of Assembly Track will be updated based on the start and end times in 
scheduling.  The projected end time in the upper grid is calculated by taking into account all of the 
production start and end times of the processes. 

The Graphic view is also available for ASSY1 Processes. Users can change the GVS WO Caption to include 
the Process # and Process Description. Materials associated to processes are shown on the Material tab 
in the lower right where a Jump to Inventory is available. 
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Additional Scheduling Pool Options 

Days Out Filter - The scheduling pool can be limited to only view jobs where the must start date is so 
many days from today. This filter will help speed up the insert pick list. To filter the list to include only 
work orders for a certain time frame enter in the number of days out in the Days Out Filter field. The list 
will then display only those processes that have a must start date within that period or are past due. For 
example if you set the Days Out Filter to 7, the list will only display processes with a must start date that 
is prior to today through seven days from today’s date. 

Runs the Best - The user can obtain “Runs the Best” information by clicking on the button located in the 

upper left portion of the screen . Doing so will bring up the Runs the Best list for the process. 
Select the drop down arrow next to the runs the best speed button to filter the scheduling pool to only 
show those processes that have the target work center in their runs the best list. 

Authorized Work Centers  

▪ Display Authorized Work Center - Click on the Authorized Work Centers button to display the 
Authorized Work Center list for the highlighted process. This displays all work centers that are 
associated to the EPlant and Manufacturing Type that are associated to the Process on the work 
order. Work centers that are authorized for the BOM will have a check in the Authorized box. When 
this form is accessed from the Scheduling Pool changes cannot be made. The toggle buttons are 
visible but the right click options to check and uncheck are grayed out. To make changes users must 
access it from the Process Maintenance module. 

▪ Filter Authorized Work Center - The user can select the drop down arrow next to the Authorized 
Work Center speed button to filter the scheduling pool to only show those processes that have the 
target work center in their Authorized Work Center list. 

Note: Users can filter on both Runs the Best and Authorized Work Centers at the same time. The 
'Override Center Type' option takes precedence and will override the work centers that are displayed. 

Search – Select the Search button to bring up a pick list of processes. You can also search for any process 
by typing information in white box in the upper portion of the scheduling pool screen. The cursor will go 
to the first record that matches the typed information based on the sort field. You can sort this list based 
on any of the columns. Note that the sort criteria currently set displays as a blue header in the grid 
immediately below. Right click anywhere within the form and select the desired field to sort on. 

Move a process - When moving a process on the schedule the move form will default to show only work 
centers that are qualified to run this process.  Runs the Best work centers will be highlighted in green.  
The user can select the override button to show all work centers.  

Note: The move option will not be available for processes associated to ASSY2 BOMs. 
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Auto Load - Processes can be automatically loaded onto the schedule by using Auto Load function. Auto 
Load for ASSY1 items is based on the process must start date. Work centers do not need to be setup on 
the process in order for Auto Load to work. When running auto load, if Runs the Best or Qualified Work 
Centers are not setup on the process, the system will look at the center type associated to the process 
and schedule the job on a work center with the same center type as the process. If a center type is not 
associated to the process, the system will look for a work center that is an ASSY1 MFG type or like an 
ASSY1 (a user defined ASSY1 MFG type). (This also applies to the ASSY2 MFG Type. For ASSY3 if an 
assembly line type is not specified on the ASSY3 BOM, then the system will look for a work center that is 
ASSY3 MFG type or like ASSY3). 

The auto load routine will look for the best fitting gap where the process will not be late.  If a gap is not 
found, the process will be scheduled at the bottom of the work center. 

Auto Load can be run from the scheduling module or from Assembly Track.  

To run Auto Load from Assembly Track select on of the options from the Auto Load speed button . 

▪ Auto load non scheduled processes - This option auto loads all non scheduled processes for the 
selected work order. 

▪ Remove from schedule and autoloader - This option removes scheduled processes from the schedule 
for the selected work order and auto loads them. This is useful in situation where process 
parameters have been modified. 

▪ Remove from Schedule - This will remove the processes from the schedule for the selected work 
order. Note:  Processes/Work Orders scheduled in the 1st position in Finite Scheduling will not be 
removed from the schedule. 

Scheduling Notes: 

When 'Snap To Last Job' is checked, the system will schedule the processes you are moving, adding, or 
editing to start directly after the process in front of it. Basically, it “snaps” to the back of the previous 
process. This setting is global but can be overridden at the work center level from the Work Centers 
module or from the 'Snap To Last Job' form accessed from the Configure menu in Scheduling.  In 
addition, if 'Snap to Last Job' is enabled for ASSY MFG Types, it is possible for the processes to run "out of 
sequence". 

Safety Lead Time is not considered when auto loading an ASSY MFG Type work orders. 

The ‘Evaluate Negative Consumption’ option in Scheduling must be utilized in order for the system to 
calculate the Must Start times correctly for dependent processes.  If dependent work orders are found 
to be out-of-sync for Must Start dates in Scheduling and the middle grid of Assembly Track, users should 
either remove these work orders from both Scheduling and Assembly Track and then re-load them, or 
alternatively users can manually change the Start Time of dependent orders in the top grid of Assembly 
Track to get the Must Start times back in sync for the dependent processes. 

Processes for ASSY1 work orders that have been added to the Finite Schedule only show the work order 
# in red to show a material exception if the material is on that process and not a different process on the 
work order. 
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When a Process is added to the finite schedule it will also be added to the Assembly Dispatch List 
reflecting the finite schedule Seq #.  If the finite schedule Seq # is reordered the Assembly Dispatch List 
will reflect the change in sequence.  If the Process is deleted from the finite schedule it will also be 
deleted from the Assembly Dispatch List. If the Process is finite scheduled the system will not allow a 
change in Seq # or Deletions from the Dispatch List. 

Update Schedule and Auto Load may take a long time when there are many processes associated to 
work orders. There is a parameter in Assembly Track->Options menu called 'Fast Finite Schedule (do not 
adjust sibling processes)'. With this checked, during auto load scheduling of ASSY processes the system 
will not attempt to move out or recalculate sibling(s) scheduled on another work stations, and it will not 
recalculate all the associated dependent processes which can increase the time it takes to update the 
schedule. 

Move Qty plus the Move Time Hrs will be added to following process even if the full Move Qty was 
reported in Labor Reporting. For example: ASSY1 BOM with 2 processes: Process 1 has a Cycle Time of 1 
Hour, Move Qty of 4, and Move Time of 1, and Process 2 has a Cycle Time of 1 Hour and does not have 
Move Qty or Move Time. Prior to reporting any labor/good parts, the projected start of Process 2 will 
start 5 hours after Process 1 starts (4 * 1 + 1). After reporting 4 good parts and running update schedule, 
the Move Qty + Move Hrs are still added to the following process. 

For ASSY1 work orders scheduled in the first position of a RealTime™ work center the parts to go and 
hours to go are updated based on RealTime™. If the work order is not placed on a RealTime™ work 
center in the first position, the parts to go and hours to go will reduce based upon reporting Good Parts 
on the process in Assembly Track. However, the hours to go will not always match the projected start 
and end times of the process. The hours to go represents the actual time to produce the parts. The 
projected start and end times take into consideration slack time. Slack time is the idle time needed 
before the process can continue. Any time there is a process with a faster cycle time than the one before 
it, there will be slack time gaps in that process. This is because the process has to wait for parts from the 
previous process to be produced before it can continue. See the examples below: 

Example 1 

▪ Shop Calendar - 24 hrs/day 

▪ All processes have the same cycle time of 1 hour 

▪ Hours to go match projected start/end 
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Example 2 

▪ Shop Calendar - 24 hrs/day 

▪ Processes 1, 3, and 4 have a 1 hour cycle time.  Process 2 has a 30 min cycle time 

 

Example 3 

▪ Shop Calendar - 2 shifts; 20 hrs/day  

▪ Shift 1 start: 00:00:00 

▪ Shift 2 start: 10:00:00 

▪ All processes have the same cycle time of 1 hour 

 

Example 4 

▪ Shop Calendar has 1 shifts, 8 hr/day, 5 days a week 

▪ Shift 1 – 00:00:00 – 8:00:00AM 
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Create an ASSY1 BOM with two processes: 

▪ Process 1 - 1 hr cycle time; Move Qty = 1; Move Time = 6 

▪ Process 2 - 1 hr cycle time 

Create a work order: Quantity = 10; Delivery date = 3/29/2021 

Add the work order to Assembly Track 

 

For more information on finite scheduling please refer to the Scheduling section of the help files. 
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Finite Schedule for ASSY2 and ASSY3 

ASSY2  

ASSY2 work centers have each process finite scheduled like ASSY1 processes except only the work 
centers that are attached to the assembly line are available for auto loading. The system first determines 
the Assembly Line based on the first process and then limits the available work centers to those assigned 
to the assembly line. 

For example: 

Setup:  ASSY2 BOM has 3 processes.   

Process            Welding            Painting            Finishing 

Work Centers:   Weld A             Paint A             Finish A 

                        Weld B             Paint B             Finish B 

                        Weld C             Paint C             Finish C 

3 assembly lines exist: 

Assembly Line:  Line A               Line B               Line C 

Work Centers:   Weld A             Weld B             Weld C 

                        Paint A             Paint B             Paint C 

                        Finish A            Finish B            Finish C 

The first process is finite scheduled to work center 'Weld B'. When the user schedules the second 
process, only the work centers associated to the Assembly Line B will be available for scheduling. In this 
example the user would just see 'Paint B'. 

ASSY2 processes cannot be moved. The user must un-schedule the processes and reschedule them to 
the desired work center.   

ASSY3 

For ASSY3, the work orders (not processes) are scheduled on the Assembly Line. ASSY3 process cannot 
be scheduled. 
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RealTime for Assembly Manufacturing 

If the ASSY MFG Type work centers are connected to the RT Server, users can view the information from 
the RealTime Production Monitoring module as with all other MFG Types. 

The various views, such as Part Numbers, Work Orders, etc will include the Process # and Process 
Description. 

Note: For ASSY1 work orders, the Parts to Go, Cycles Left and Hours to Go fields on the RealTime 
Production Monitoring screen will count down based on cycles. 

There are two right click options that are only visible for the ASSY type manufacturing: 

▪ Jump to Process Maintenance - This jumps to the Assembly Process  Maintenance form for the 
process currently running. 

▪ Process Labor Reporting - This will access the Labor Reporting form to enter labor hours, good parts, 
etc. This form includes a field for RT Production Hours. It will only surface when the Process is or has 
run in RT Monitoring. The system will calculate the number of production hours and good parts that 
have taken place since the last time this process was reported on.  On posting the Labor Reporting 
record ILLUM_RT.PRW_TOTAL_UP_PROCESSED and ILLUM_PART.PRW_TOTAL_QTY_PROCESSED will 
be updated. See Labor Reporting for more information. 
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For more information on RealTime refer to the RealTime section of the help files, or access the RealTime 
pdf from MyDELMIAworks. 
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Assembly Track By Group and Associated Modules 

This module displays information similar to Assembly Track but by center type and group.  Once 
released from the Scheduling Sandbox, groups will be populated in the Assembly Track By Group.  This 
screen will allow for the ability to see by group and center type what the status is for any Group, Work 
Order and Process. 

Note: A license is required for this module. 

The basic flow: 

▪ Update schedule is run and work orders are generated. 

▪ In the Unassigned tab of the Grouping ID Assignment module ASSY work orders will be listed. Note: 
Only work orders associated to a BOM with a Grouping Process (Grouping Process box checked on 
the Item Details->Details tab) will display. From this module users can group work orders based on 
their needs. For example, different items all required on the same date and use the same center 
type.  

▪ Once work orders are selected to be in a group the scheduler can adjust the center type if needed.  

▪ Once the information has been entered/verified users select the Apply button to add the group to 
the Assigned tab. 

▪ The assigned groups are then available to add to the Assembly Track Sandbox module. 

▪ From the sandbox schedulers can Publish the group to the Assembly Track By Group module. 

Schedulers will have three main areas to work from: 

▪ Grouping ID Assignment - From this module schedulers will take work orders and group them 
together based on their business rule criteria. 

▪ Scheduling Screen Sandbox -This is a scheduling tool similar to finite schedule and the insert job pool, 
but instead of the work orders being added to work centers, Groups from the assigned tab populated 
during Grouping will be added to a Center Type.  The center type will show groups that have 
already been added to the center type. Existing groups that have had an employee clock into the first 
process ('Initiated Group') are displayed but cannot be moved.  All other groups can be adjusted 
accordingly.   

▪ Capacity Screen -  This module shows bucketed hours based on the final assembly process hours: 
Initiated Group Hours are the hours left on currently started Groups, Planned Group Hours are the 
hours that are existing in the Center Type Schedule but have not been initiated yet, Unscheduled 
Group Hours are the groups in the insert group pool that have not been placed in the schedule yet, 
and Standard Hours are the hours available per center type based on standard labor capacity. There 
is the ability to filter and select certain Center Types to be listed on the Capacity Whiteboard.  Each 
center type will display with the bucketed hours.  A grand total of the selected center types will be 
displayed at the bottom.   

Grouping ID Assignment 
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This module is used to create groups of work orders to be added to the Assembly Track By Group screen. 
This is accessed by clicking on the Group ID Assignments button at the top of the Assembly Track By 

Group module . The screen includes two tabs: 

▪ Unassigned -This will display ASSY work orders that have not been assigned to a group. Only work 
orders associated to BOMs with a process that has the Grouping Process box checked will display. 

▪ Assigned - This will display work orders that have been assigned to a group. 
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Unassigned Tab 

Alphabetical Field Listing for Top Left Section: 
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Bucket Work Order bucket number, if applicable. 

Center Type Default Work Center Type associated to the process marked 'Group Process'. 

Customer Name Customer associated to the work order. 

EPlant ID EPlant ID associated to work order. 

Group Code Group Code ID associated to the inventory item. A Group Code can be 
assigned to inventory items on the Additional tab in the Inventory module. 

Item # Item number 

Item Description Item Description 

Item Ext Description Item's extended description 

Mfg Cell Manufacturing cell associated to the work order. 

Mfg Type Manufacturing Type associated to the work order. 

Mfg# Manufacturing number associated to the work order. 

Multiple Of Exception This box will be checked if the quantity is less than the selling multiples of.  
This is so that orders not equating to a selling multiples of can easily be seen 
and grouped together. 

Must Start The must start date of the work order. 

Origin Indicates where the Work Order was created from. Either from a Sales Order 
(Planned), the Forecast module (Forecast), or Manual. 

Quantity The quantity of the work order. This field will be blue if the quantity is less 
than the selling multiples of.  

Revised Center Type This will display the revised work center type if it has been changed from the 
default. This field can be changed by selecting a different center type from 
the pick list accessed by clicking the ellipsis button in the field. 

Revision Item's revision  

Ship To ID Ship To ID associated to the work order. 

User Fields User 1 and User 2 fields from the BOM. 

WO Type WO Type, i.e. Firm 
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Work Order # Work Order number. This field will be red if there is a material exception on 
the work order.   

Jump To Work Order - Right click and select Jump To Work Order to access the highlighted work order. 

Lower Left Section  

This section will display the sales order information for the highlighted work order. This includes field 
such as: order #, customer, ship to, and release information such as quantity and promise date. 

Grouping Work Orders 

Users can sort the top left grid using any of the fields to help with logical grouping. Use the Shift/Ctrl 
keyboard button or the toggle buttons to select work orders to be grouped together. The 'Days Out 
Filter' can be used to filter the top left grid to only include work orders where the must start date is so 
many days from today. Once the desired work orders are selected use the 'Add to selected work orders' 
green arrow button to add the work orders to the 'Selected Work Orders' side. The work orders that 
have been added to the right side will display in light italicized text in the left grid.  
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Note: Users are prevented from opening the Group ID Assignments form if Update Schedule is running, a 
shared lock warning will appear.   

Note: When the Grouping ID Assignment Form is already open and update schedule is run a pop up will 
appear on the Group ID Assignment form stating, 'Please be advised Update Schedule is currently 
running, this form must be closed'.  Upon hitting OK the form will close.  Update schedule will run 
correctly even if the OK button is not hit.   

Right Grid Field Listing: 

Bucket Work Order bucket number, if applicable. 

Customer Name Customer associated to the work order. 

Group Code Group Code ID associated to the inventory item. A Group Code can be 
assigned to inventory items on the Additional tab in the Inventory module. 

Planned Center Type Planned Work Center Type associated to the process. This will carry over 
from the Center Type field or the Revised Center Type if populated. This can 
be changed for all work orders at once by clicking the 'Assign plan center 

type' button . After selecting this button choose a center type from the 
pick list. The Planned Center Type for all of the listed work orders will change 
to the selected one. 

Prod Hours The work order production hours. This is summed at the bottom of the grid 
and can be used for information to determine capacities. 

Quantity The work order quantity. This is also summed at the bottom of the grid. 

Seq # The sequence number of the work orders. The sequence can be changed 
using the up/down arrows or by dragging and dropping. 

Ship To ID  Ship To ID associated to the work order. 

User Fields User 1 and User 2 fields from the BOM 

Work Order # Work Order number. This field will be red if there is a material exception on 
the work order.  

Description Field - This is an optional field that can be used for any notes to describe the group or for 
messages to the floor such as priority. 

Apply  
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Once the information has been entered and verified select the Apply button to assign the work orders to 
the group. A confirm message will appear stating the Group ID to be assigned to the work orders. Select 
Yes to continue, or No to return to the module with no changes. When Yes is selected the system will 
assign a group ID to the group, move the group of work orders to the Assigned tab, mark the work orders 
Firm, set the workorder number as the lot number for each workorder assigned to the group, and check 
the 'Retain Assigned Lot # for this Work Order' box for the FG Lot # on the work orders. 

Assigned Tab 
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The Assigned tab displays the Group information in the upper grid and the associated work orders in the 
lower grid. 

Upper Grid 
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Assy Track This box will be checked if the group has been added to Assembly Track By 
Group. 

Description The description of the group if one was entered. 

EPlant ID EPlant ID of the group. 

Group ID Group ID.  

Location If using the SuperMarket module the Location is selected during the 
SuperMarket picking and will populate in the Group Section Grid. The 
Location will show in Red until the Supermarket process for the entire group 
is reported in full (100%) and users have tasked out of this group process. 
Once complete and logged out, the location will display in green. It is an 
indicator that the group is available for dispatch.  If there is no location it 
means the group is not ready yet. 

Note: The SuperMarket is a separate module that allows users to pick 
components in the 'Supermarket' (the Warehouse). This module allows the 
ability to Task In to a group and pick the required component parts needed 
for the group of work orders selected.  Users can gather the required parts, 
organize them, report time spent to perform the picking function, and 
backflush the components.  

If not using the SuperMarket, this field can be manually selected on an 
initiated group by clicking on the ellipsis button in the field. It is mostly 
informational only and is not used for backflushing. However, a group will 
not be visible in the 'Assembly Data Dispatch List By Group' unless a location 
is associated to the record. 

Planned Center Type Planned Work Center Type associated to the process. This will carry over 
from the Center Type field or the Revised Center Type if populated. This can 
be changed for all work orders at once by clicking the 'Assign plan center 

type' button . After selecting this button choose a center type from the 
pick list. The Planned Center Type for all of the listed work orders will change 
to the selected one. 

Work Center # Users can dispatch an initiated group ID to a specific work center. Select the 
ellipsis button in the field and choose a work center from the pick list. The 
list will be filtered if a specific center type was entered in the Center Type 
filter field. Once selected the Work center ID is stored in the Assembly Group 
table. 

Users can clear this field which will remove the Work center ID from the 
Assembly Group table. 

This section includes a Search button to access the pick list of groups to enable users to find a specific 
group. 
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Lower Grid Field Listing: 

Bucket Work Order bucket number, if applicable. 

Customer Name The customer associated to the work order. 

Cycles Required Cycles required for the work order. 

Item Information This includes the item #, Item Description, Item Ext Description, and Revision. 

Mfg #, Mfg Type and Mfg 
Cell 

The Mfg #, Mfg Cell, and Mfg Type associated to the work order. 

Must Start The must start date of the work order. 

Origin Indicates where the Work Order was created from. Either from a Sales Order 
(Planned), the Forecast module (Forecast), or Manual. 

Planned Center Type Planned Center Type 

Prod Hrs The number of production hours required for the work order. 

Promise Date and 
Request Date 

The promise and request date from the sales order associated to the work 
order. 

Setup Hrs Setup hours required for the work order. 

Ship Date The sales order ship date. 

Type Default Center Type 

WO Type WO Type, i.e. Firm 

Work Order # Work Order number. This field will be red if there is a material exception on 
the work order.  

The 'Days Out Filter' can be used to filter the grid to only include work orders where the must start date 
is so many days from today. 

Override Level 0 Filter - By default only level zero (top level) work orders are listed in the grid. They will 
display in bold text. Select the 'Override Level 0 Filter' to display all levels. Lower level work orders will 
not be in bold text.  

Jump To Work Order - Right click and select Jump To Work Order to access the highlighted work order. 
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Remove from Group - Select this option to remove the highlighted work order(s) from the group. Work 
Orders scheduled in Assembly Track cannot be removed. Work Orders can be highlighted using the 
Shift/Ctrl keyboard buttons or the toggle buttons in the grid. A Confirm message with a Yes and No 
button will appear stating, 'About to remove selected work orders from Group ID x. Work Orders 
scheduled in Assembly Track will not be removed. Are you sure you want to continue?'. The removed 
work orders will be visible on the Unassigned tab. Note: When removing work order from a Group the 
'Firm' check box will remain checked. 

Assembly Track Sandbox 

The Assembly Sandbox is used by schedulers to insert groups into a schedule based on the center type. 

Select the Assembly Sandbox button  on the Assembly Track By Group module to access the form. 
A pick list of center types will appear to choose from. Once selected the Assembly Track Sandbox will 
open displaying the center type chosen in the top blue bar. The form will be empty the first time it is 
opened. 
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To add groups to the sandbox select the green plus button. A pick list of planned groups that have not 
been released to production yet, with a planned center type that matches the sandbox center type will 
appear. Select group(s) to add using the Shift/Ctrl keyboard buttons or the toggle buttons in the list. 
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Top Section: 

This includes the Group ID and Description, total production hours and quantity for the group, Must Start 
and Scheduled Start dates, and Planned and Current Sequence. 

Assy Track This box will be checked if the group has been published to the Assembly 
track By group module. 

Current Sequence The Current Sequence is the sequence the group currently resides in that has 
been published to the floor. This will be blank until published. 

Group ID and Description The Group ID and Description. 

Must Start   The Start date of the assembly process that has been checked final assembly. 

Planned Sequence The planned sequence will be populated based on the order in which the 
group is added/inserted in the sandbox. 

Prod Hrs The total amount of hours based on the constraining processes by group. 

Quantity The total production quantity to build by group. 

Scheduled Start   This is the same as the must start date unless the scheduler has set a force 
start date on the group. To force a start date select a date from the drop 
down calendar in the field. 

Note: Groups that have been initiated (a process has been tasked into for any work order belonging to 
that group) will display in bold and italics. This indicates that a process within that group has been 
started and no changes can be made. 

Lower Section: 

Displays the work orders that are associated to the Group that the user is selected on in the top grid.  
This shows information specific to the work order such as: Group ID, Work order #, Must start date of 
the work order, Manufacturing #, Center Type assigned during grouping, Item#, Prod Hours, and 
Quantity. 

Options: 

Group ID Assignment - Select this button  to access the Group ID Assignment module. 

Remove Group from Assembly Sandbox - Select this button  to remove the group from the sandbox. 
If it was published to Assembly Track By Group, it will remain there but the Seq # will be removed. 

Calculation Options - From the calculator button drop down arrow there are three options: 

▪ Recalc All Groups 

▪ Recalc Selected Group 
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▪ Refresh Planned Sequence 

Publish - Select the Publish button  at the top of the scheduling sandbox to release all groups that 
have been added to the scheduling sandbox to Assembly Track By Group in the planned sequence 
assigned. 

Labor Whiteboard Capacity By Group 

This module can be accessed from the Assembly Track Sandbox or Assembly Track By group modules. 
The Labor Whiteboard Capacity By Group module is used to show labor requirements based on specific 
filters that can be set. This can be used to help level load the labor.  

Select the  button to access the module. 

To populate the form users must at the minimum select a Start Date and then click the Apply button. 
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Selection Criteria 

Start Date - Select a Start Date from the drop down calendar. This will be used as the first date in the 
whiteboard capacity section. 

Actual Hours - Users can enter actual labor hours to calculate the Delta From Actual. 

Delta From Actual - If an actual value is entered the system will calculate the Delta =  [Actual Hours - 
Start Date Total Hrs (which is Planned + Unsched)]. For example using the screen shot above: Actual 
Hours entered is 100, Total = 66 + 48 = 114, 114 - 100 = -14. The color of the Delta From Actual  value 
will be green if it is a positive number and red if negative. 

Mfg Type - The Labor Whiteboard can be filtered for specific Mfg Types by selecting the plus button in 
the section and then selecting the Mfg Type(s) from the multi-select pick list. If blank all will show.  

Mfg Cell - The Labor Whiteboard can be filtered for specific Mfg Cells by selecting the plus button in the 
section and then selecting the Mfg Cell(s) from the multi-select pick list. If blank all will show.  

Employee Level  - The Labor Whiteboard can be filtered for specific Employee Levels by selecting the 
plus button in the section and then selecting the Employee Level(s) from the multi-select pick list. If 
blank all will show.  

Whiteboard Section 

The first column displays the Center Type, Mfg Types, and Mfg Cells based on the criteria selected. There 
is a column for each date starting with the selected Start Date. In each column there is data for the 
following: 

▪ Initiated – Groups that have had a process tasked into for any work order belonging to that group. 
The Initiated value is the total for all initiated groups in this center type.  As groups are started this 
total will increase and as groups are removed this total will decrease.  

▪ Planned – The labor hours required for groups that are in Assembly Track or the Sandbox (published 
or unpublished). As unscheduled groups are moved up from the insert group pool to the center type 
schedule this value will increase.  If they are moved out of the center type schedule this total is 
decreased.  

▪ Unscheduled – This is the total amount of hours currently sitting in the insert group pool (Assigned 
tab of the Group ID Assignments module) that have not been scheduled into the center type yet. 
Typically Schedulers will attempt to bring this number to zero multiple times during the day as orders 
are grouped. 

Totals 

The Total section summarizes totals for a view period. This includes summaries of the information above; 
Initiated, Planned and Unscheduled. It also includes the total hours, standard hours and delta for the 
date. 

▪ Total = Initiated + Planned + Unscheduled 
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▪ Standard =  The total of labor hours available for the view period based on the selected criteria. This 
is based on the standard labor capacity form (in Scheduling->Labor menu->Labor Capacity->File 
menu). 

▪ Delta  = Standard – Total. If the delta is greater than standard it is shown in red, if the delta is less 
than the standard it will be green. 

Assembly Track By Group 

Once schedulers have published group(s) they will appear in the Assembly Track By Group module. This 
is typically used by floor personnel to view released work orders and their progress. This screen is very 
similar to Assembly Track but has the ability to view by Group and Center Type what the status is for any 
Group, Work Order and Process. It displays the published groups in the top section instead of individual 
work orders, which are displayed in the second section.  

After accessing the module a pick list of groups will display. Pick a group from the list. Once in the 
module users can select a specific center type to filter the information by clicking the ellipsis button in 
the Center Type field. To clear the filter delete the selection from the field. 
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Top Section Field Listing: 

Group ID and Description The Group ID and description of the group. When all work orders for a group 
are complete, the Group ID will no longer display. 

Seq # The sequence number of the group from the Assembly Track Sandbox. 

Must Start Must start date of the earliest work order.  

Initiated Date Shows the date and time stamp of when the first work order of the group was 
tasked into. 

Location If using the SuperMarket module the Location is selected during the 
SuperMarket picking and will populate in the Group Section Grid. The 
Location will show in Red until the Supermarket process for the entire group 
is reported in full (100%) and users have tasked out of this group process. 
Once complete and logged out of the location will display in green. It is an 
indicator that the group is available for dispatch.  If there is no location 
means the group is not ready yet. 

Note: The SuperMarket is a separate module that allows users to pick 
components in the Supermarket (the Warehouse).  This module allows the 
ability to Task In to a group and pick the required component parts needed 
for the group of work orders selected.  Users can gather the required parts, 
organize them, report time spent to perform the picking function, and 
backflush the components.  

If not using the SuperMarket, this field can be manually selected on an 
initiated group by clicking on the ellipsis button in the field. It is mostly 
informational only and is not used for backflushing. However, a group will not 
be visible in the Assembly Data Dispatch List By Group unless a location is 
associated to the record. 

Work Center User can dispatch an initiated group ID to a specific work center. Select the 
ellipsis button in the field and choose a work center from the pick list. The list 
will be filtered if a specific center type was entered in the Center Type filter 
field. Once selected the Work center ID is stored in Assembly Group table. 

Users can clear this field which will remove the Work center ID from  
Assembly Group table. 

% Completed This is calculated by adding together all of the Work orders completed divided 
by the number of work orders in the group. 

User Text 1 User text field for additional information. Right click and select Define User 
Text to change the name of the column. 
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Individual Work Order Section - This section will display the same information that is in Assembly Track, 
except there is an additional column for Sub Group ID (work order Sub Group ID assigned in the Group ID 
Assignment module). Please refer to the Assembly Track Top Section portion of the Assembly 
Manufacturing documentation. 

Processes, Rejects, and Sales Orders Sections - These are identical to the Assembly Track module. Please 
refer to the following sections: Assembly Track Processes Section, Assembly Track Rejects Section, Sales 
Orders. 

Remove Group from Assembly Track - Select the red X button to remove a group from Assembly Track.  
A confirmation message will appear with Yes and No buttons and a 'Do not show next time' check box. 
Security can be placed on this message. When Yes is selected the group is removed from Assembly Track 
and it is also removed from Assembly Data Dispatch List by Group. 

Calculate - Select the calculator button to calculate all groups work orders start and end time.  

Assembly Data - Dispatch List By Group 

This module is similar to the Assembly Data Dispatch List but allows users to view the data for the 
groups. Groups that have been initiated with the location field populated will be visible in the dispatch 
list.  

When accessing this module, by default, a pick list of employees will appear. The Employee pick list does 
not appear when opening the module if the option 'Disable Clock In Employee Pick List' is checked in 
System Parameters>Time and Attendance, and the Search button to access the employee pick list will 
also not be visible. 

If the pick list displays, after selecting an employee from the list the form will display with the Employee 
# and name fields populated. If the pick list does not display the employee can enter their Employee # in 
the field.  
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Top Section 

Employee Information - This displays the employee selected when accessing the module. This includes 
the Employee # and First and Last Name. The employee can be changed by selecting a different one from 
the pick list accessed from the search button.  

Work Center Information - Select a work center from the pick list of active work centers accessed from 
the search button.  

Dispatch List Section: 

Group - This will list the Group(s) associated to the the work center.  

Sub Groups - This will list the sub groups associated to the highlighted group. 

Buttons: 

▪ Dispatch - Select this button to toggle to/from the Dispatch List By Group and the Dispatch List. 

▪ Documents - Select this toggle button to display the Internal and External documents associated to 
the BOM, Customer, Inventory, AKA, Work Center, and MRO. 
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▪ Print Group Traveler - Select this button to print the Group Traveler report. 

▪ Barcoded Label - Prints a barcode label. 

▪ Report Production - Accesses the Report Production feature. 

▪ Final Assembly - Opens the Final Assembly module for the highlighted work order. 

▪ Rejects - Accesses the Rejects module for user input. 

▪ Quick Inspection - Access to the Quick Inspection module 

▪ BOM Tree - Opens the BOM Tree. The process description will display in line with the material at the 
beginning of each material. The BOM Tree will not automatically be exploded for the manufacturing 
quantity. 

▪ Task IN -Tasks the employee listed at the top in to the work order. 

▪ Task OUT - Tasks the employee listed at the top out of the work order. 

▪ Exit - This will exit the module and return the user to the Assembly Data Time Clock screen. 
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AssemblyData 

AssemblyData is a touch screen interface module that utilizes the Time & Attendance login process to 
collect labor against ASSY work orders for individual Processes. This is specifically designed to collect the 
labor records for users with the Time & Attendance module. This section will describe the functions 
available within AssemblyData. 

Note: AssemblyData was designed for use with ASSY manufacturing types, however users are able to 
clock into other manufacturing types as well.  Some of the features in AssemblyData will not apply to 
non-ASSY work orders, such as Line Clearance, Final Reporting and process information. 
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Resizing the Screen - The AssemblyData screen can be resized. When using dual monitors users can set 
the target to indicate multi (for example, "C:\Program Files\IQMS\IQWin32\AssyData.exe" _multi_). 
With this set two windows can be opened to different work centers on the same workstation. 

(Note: 600x800 resolution is not supported). 

Menu 

The Menu button shows the available functions within AssemblyData and provides access to these 
modules. Pushing/Clicking a button will display the appropriate module.  
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More - Press the More button to access additional features. 

▪ Reports - This opens the Reports form to print reports associated to AssemblyData. 

▪ Who is Logged In - This will show all employees logged into all Work Orders that have been released 
via Assembly Track. It will display the employee information, Task Source, WO#, Process, the Time In, 
Elapsed Time, Work Center #, and Manufacturing #. Use the Search button to find a specific 
employee. This form also includes the Form/Table toggle button. 

▪ Login - Opens the Login screen 

▪ Security Inspector - Access to Security Inspector 

▪ Configure AssemblyData - This opens the Configure AssemblyData screen. 

Configure 
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Following are the available configuration options: 

Time Clock 

Show Time Clock at Startup - With this checked the Time Clock will be visible when ShopData is started. 
What will display is dependent on the option selected (see below). If this is not checked the date and 
time will not appear on the ShopData screen. 

Options 

▪ Clock Only – This displays the date and time only. Users cannot clock in when this option is selected. 

▪ Time Clock Only - With this checked the Time Clock screen will display the current date and time and 
allow users to punch in/out for the day. However, if the Task Clock is enabled in System Parameters 
(see below) the Task Clock will automatically appear after the user punches in. 

▪ Time and Job Clock - With this option checked the date and time will appear and the user will be able 
to clock in/out for the day as well as clock in/out to specific tasks. 

▪ Task Clock Only – This option will display the date and time and defaults to the Task Clock screen to 
allow the user to clock in/out of tasks. The Punch In/Out clock is also available by selecting the 
‘Punch-In Clock’ button. 

Task Clock – The Task Clock can also be made visible on this screen. This parameter is set up in Sys 

Setup->System Parameters->Time & Attendance tab. The user can select the Enable Task Clock In/Out for 
all work stations (Global) or override the global setting for the local workstation. If this option is checked 
the user will have access to the Task Clock and be able to clock In/Out of specific tasks. 

Controls 

Print Labels on Final Assembly - If this option is checked it will be mandatory to print labels during Final 
Assembly. If it is not checked it will be optional to print labels. 

Dispatch List shows all processes on certified work centers - When checked the Dispatch List will display 
all processes from the Assembly Dispatch Priority List and any processes that have the work center 
certified in the Process Maintenance. If it is set to No, only work orders in the dispatch list will display. 

Startup  

Quick Inspection Charts - Users can choose to have the system display the Trend, Control, X-Bar charts, 
the X-Bar and Range chart, and/or the P and NP chart when accessing the Quick Inspection module from 
ShopData. To have a chart display on startup check the box next to the option. 

Additional Options 

Selecting the More button again will access the Help menu which includes: Help Contents, Knowledge 
Center, and About. 

Clock – This buttons takes the user to the Time Clock screen. 
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Toolbox – This brings up a box to select the on screen keyboard, keypad, or calendar for touch screens. 
The tool box can be set to ‘AutoHide’ when changing screens, by depressing the top button. If it is not 
selected the tool box will remain on the screen as the user moves from module to module. When the 
user clicks on a field that requires an entry to be made using one of the tools they will become available 
to select on the Tool Box. Note: When using the keypad to enter numeric values there is a +/- button 
available to enter negative values when allowed (such as in Quick Inspection). The value must be entered 
first then the user can select the +/- button to change the sign. 

If the 'Display User ID on Launcher' option is checked in Security Inspector on the Password Policy tab, un 
logging into AssemblyData the username will display in the title bar. 

 

If the 'Display Last Login' setting is checked in Security Inspector -> Password Policy, the last successful 
login will display on the title bar. Also, the following information will display on the About form accessed 
form the Help menu: 

▪ Last Login - Displays the last date and time the user logged in. 

▪ Last Failed Login and Failed Login Tries - Displays the last date and time there was a user failed login 
and the number of failed login tries. The Failed Login Tries will reset after a user logs into the system 
successfully two consecutive times. 
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Time Clock 

The main portion of the screen is the Time & Attendance Time Clock. Users can clock in for the day as 
well as clock into specific tasks (work orders). The time clock functionality within Assembly Data allows 
employees to clock into specific processes associated to ASSY work orders. The actual labor is collected. 
Employees can clock into multiple processes at the same time and the labor hours will be calculated as 
the total time logged into a specific process divided by the number of processes logged into 
simultaneously. 

This document will describe the functionality specific to Assembly Data only. For detailed information 
about Time and Task Clock please refer to the Time & Attendance help files. 

Note: If using the RTBOX user to log into the clock, no roles are required on the RTBox user. 

Configure Assembly Data Clock Options 

This option allows the user to change the configuration of the time clock screen.  

Click on the Menu button then click More, and select Configure Assembly Data. 

Show Time Clock at Startup - With this checked the Time Clock will be visible when Assembly Data is 
started. What will display is dependent on one of the following options selected. If this is not checked 
the date and time will not appear on the assembly data screen. 

Options: 

▪ Clock Only - This displays the date and time only. Users cannot clock in when this option is selected. 

▪ Time Clock Only - With this checked the Time Clock screen will display the current date and time and 
allow users to punch in/out for the day. However, if the Task Clock is enabled in System Parameters, 
the Task Clock will automatically appear after the user punches in. 

▪ Time and Job Clock - With this option checked the date and time will appear and the user will be able 
to clock in/out for the day as well as clock in/out to specific tasks. 

▪ Task Clock Only - This option will display the date and time and defaults to the Task Clock screen to 
allow the user to clock in/out of tasks. The Punch In/Out clock is also available by selecting the 
`Punch-In Clock' button. 

▪ Task Clock by Class - This option allows a user to select a task class and a specific task, and then 
multiple users can clock into that task in row without having to select the class/task again. This is to 
help speed up multiple users tasking into the same class. 

The Task Clock can also be made visible on this screen. This parameter is set up in Sys Setup->System 
Parameters->Time & Attendance tab. The user can select the Enable Task Clock In/Out for all work 
stations (Global) or override the global setting for the local workstation. If this option is checked the user 
will have access to the Task Clock and be able to clock In/Out of specific tasks. 

Labor Assignments 



ASSY Manufacturing Page 228 of 358 

 

The Labor Assignments feature appears on both the Time Clock and Task Clock screens for users who are 
assigned the sbtnLaborAssignments security role within EnterpriseIQ Security Inspector. The Labor 
Assignments screen allows shop floor users to view which work center they are assigned to, allowing 
users to search work centers, employees, and filter work centers by employee.  

 

The left side will display work centers that have work orders scheduled on them. The work center will be 
listed multiple times based on the items and Employee Levels associated to the MFG #.   

Filter Work Centers by Employee - Check this option to only display work centers where the highlighted 
employee is scheduled. 

This section includes the following fields: 

Work Center 

Work Center 
Description 

There is a column for work center number and work center description. 

Item # 

Description 

Ext. Description 

Rev 

The inventory item information for the item(s) scheduled in the first position on the work 
center. There are four columns: Item Number, Description, Extended Description and 
Revision. 

If there is more than one item manufactured using the scheduled MFG #, the work center 
will be listed for each item. 

MFG # The Manufacturing number scheduled in the first position on the work center. 

Work Order The work order number scheduled in the first position on the work center. 

Allow Non-Certified If this is 'N', it indicates that only certified employees associated to the MFG # can be 
scheduled. If this is set to 'Y' non-certified employees can be scheduled. 
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Required The total number of operators required for all employee levels, including setup. The work 
center will be listed for each employee level associated to the MFG #. 

Operators Scheduled The sum of employee hours for the specific work center. (Employee hours are entered per 
employee in the Labor Scheduling module, right side of the form). 

Color Coding in Work Center Section 

▪ Orange -  If the item is associated to an open CAR/CAPA, ECO, MRB, Deviation, or PPAP/Product PQ 
the item number field will be colored orange. 

▪ Yellow -  If the total employee usage is greater than the amount of operators required to run the 
job the 'Total Employee Usage' field will be highlighted yellow. 

▪ Purple - If the total employee usage is equal to the amount of operators required to run the job the 
'Total Employee Usage' field will be highlighted purple. 

The right side of the form will display scheduled employee information: 

Employee Name There are columns for: Employee #, First Name, Middle Name, and Last Name. 

Employee Usage The employees usage for the work center. 

Total Employee 
Usage 

This is the sum of the employee usage for all work centers the employee is scheduled on. 
This is updated automatically whenever an employee is scheduled on a work center and 
allows users to clearly see when an employee’s total usage is equal to or greater than 1. 

▪ This field will be highlighted purple when an employee’s total employee usage is equal to 
1. 

▪ This field will be highlighted yellow when an employee’s total employee usage is greater 
than 1. 

▪ If the total employee usage falls below 1 this field will update automatically and show no 
color. 
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Color Coding in Employee Section  

The font in the Employee Name fields will be color coded as follows to indicate whether employees are 
certified: 

▪ Green - Certified  

▪ Red - Not certified 

▪ Blue - Re-Certification Required 

Total Employee Usage field color coding: 

▪ Purple - The Total Employee Usage field will be highlighted purple when an employee’s total 
employee usage is equal to 1. 

▪ Yellow - The Total Employee Usage field will be highlighted yellow when an employee’s total 
employee usage is greater than 1. 

Note: The Labor Assignment feature is not available when Assembly Data is in Task Clock Only mode.  
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Clocking into a Process 

Once an employee is clocked in they can select the Task Clock to clock into an ASSY work order.  

Select the AS Task Class and then select a work order or dispatch ID from the touchscreen pick list and 
press Select. The pick list includes process and item information to help employees select the correct 
task. Only work orders that have been added to Assembly Track will be available to log into. 

Note: If the System Parameter options for 'Default to Select Task on Task clock In' and 'Task Class is 
included as a prefix to the task barcode' are selected, entering or scanning a barcode with “AS” plus the 
dispatch ID will log the user into the task. 

 

Below is the information on fields that apply to Assembly Data: 

Task Will display the type of Work Order 

Task ID This is the Work Order number 

Clock IN Time employee clocked into the task 

Clock OUT Time employee clocked out of the task 

Description For type WO displays item being produced. 

Process # This will display the process the user clocked into if applicable to the work 
order. 

Total MFG Rejects This applies to ASSY MFG Types. It is the total manufactured parts rejected 
for each process. 
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Note Employees can enter a Note related to the task in the Note field. Select the 
keyboard button to bring up the keyboard form to enter a note. Depending 
on the task reported, the note will be displayed on the labor record for that 
task. 

▪ AS – Displayed in Assembly Track > right click on process > Show Details > 
in the Process Log grid 

▪ WO – For ASSY1/ASSY2/ASSY3 WO's, the note is displayed in Assembly 
Track > right click on process > Show Details > in the Process Log grid 

Work Center # If the process is scheduled on a work center, this field will display the work 
center #. 

Current Progress  The current progress of the process. 

After clocking into the work order the employee will select the specific process they will work on from 
the Select Operations screen. If the employee is clocking into a process to perform the set up, they can 
check the Setup box in the Operations section. This box defaults to not checked. 

NOTE: In order for the Select Operation screen to appear the Separate Pick lists for Projects/Tasks option 
in System Parameters->Time and Attendance tab must be checked.  
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If the process has certification requirements only those employees that are certified will be able to clock 
into the process. If they are not certified an error will appear and the employee will not be clocked into 
the task. The error will state, "‘Document <document name> Not Certified. Employee <employee #> 
(Last name, First name)’." 
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If the Process requires a Line Clearance and the line has not been cleared an error will appear: “Line is 
not cleared for this WO#, Process# and Shift”, and the employee will not be able to clock into the 
process. 

Note: The system will allow an employee assigned to any shift to be able to login to any WO/process 
within the approved date/time range as long as the process has been cleared 

If the process is marked as a Sequential Process and the prior process is not complete the employee will 
not be allowed to login. They will receive an error stating: “Cannot login. Operation # ___ was not 
completed”. 

Note: If the work order is associated to a JobShop project a warning will appear stating, "Work order is 
associated to a JobShop project.  You will be clocked into a ‘JS’ task class.  Are you sure you would like 
to continue?".  If the user selects Yes, the system will change the task class on the fly to ‘JS’ and clock 
the user into the selected process.  If the user selects No, the user will not be clocked into the 
WO/process and they will be returned to the task clock screen. 

Clocking into Multiple Tasks 

While the Task Clock application gives users the ability to clock into multiple tasks simultaneously by 
default, restrictions on this behavior can be implemented from the Time & Attendance section of System 
Setup --> System Parameters. The following settings are available:  

▪ Do Not Allow Employees to Task Clock In to Multiple Tasks - If this option is checked and an 
employee is task clocked into a task, upon clocking into another task, the system will 
automatically clock the employee out of the previous record and will populate the time out in 
TA_LABOR.TIME_OUT with the current time. Checking this option will also expose the 'Allow 
supervisor override' option.  

▪ Allow supervisor override - If 'Do Not Allow Employees to Task Clock in to Multiple Tasks' is 
enabled, this option will appear. When checked, a supervisor may allow an employee to clock 
into multiple tasks. This is done by requiring the user via prompt to enter a supervisor badge 
number prior to clocking them into an additional task.   
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Clocking Out of a Process 

When clocking out of a process, the screen that will appear to the employee depends on the settings 
established for the MFG Type and Process. Below is a flowchart that shows what screen the system will 
bring up: 
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From the Clock Out screen the user will have two options:  

▪ Clock Out - Allows the user to report production and clocks the user out of the process. For this 
option select the Clock Out button at the top or click in the Task ID field and click on the clock button 
to clock out of the task. Employees can also clock out of a task by entering the 'AS' task # in the 
Select Task field and selecting OK.  A confirm pop up will display asking, 'Do you want to clock out of 
this task?' After selecting OK, when clocking out of an Assembly WO (WO, AS, or JS task classes) 
another confirm message will appear asking, 'Report Good Parts/Rejects?' with Yes/No buttons.  If 
Yes is selected, the Enter Good Parts/Rejects form will appear.  If No is selected, the user will be 
clocked out of the task without going into the Enter Good Parts/ Rejects form and the system will 
display a notification 'Operator clocked out at xx:xx:xx'. Note: The prompt asking to 'Report Good 
Parts/Rejects' will not appear if the process the employee is clocking out of has the 'Exclude from 
Task Clock Reporting' checked. 

▪ Report Production - If the MFG Type has the 'Backflush on Clock Out’ option checked this option will 
be available. It allows the user to report production but stay logged into the process. For this option 
select the 'Rep Prod' button at the top. The Enter Good Parts/Rejects form will appear. 
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Note: If the process has the ‘Exclude from Task Clock Reporting’ option checked the 'Report Good 
Parts/Rejects?' confirm message will not appear. 

Note: If the user attempts to clock out for the day from the Time Clock while still clocked into a task, by 
default the task clock in/out screen will appear to allow the user to clock out of the tasks and enter good 
parts/rejects. If the employee selects Close without closing the tasks, a warning will appear, 'Not all good 
parts have been reported against the process. You have not clocked out.' and the employee will not be 
clocked out. If the Time and Attendance System Parameter 'Clock out of all tasks without reporting 
production when punching out of the Time Clock' is checked when punching out of the Time Clock, the 
employee will be automatically clocked out of all tasks and the task clock. 

Good Parts/Rejects 

From the pop up screen the employee can enter the number of good parts/rejects they processed. Enter 
a value in the white box for the number of good parts produced or use the keypad to enter the value. 
The Clear button will clear any entered value. Cancel will take the employee back to the task clock 
without clocking them out. Users can report zero good parts. When there are zero good parts reported 
upon task clocking out using AS or WO task class from Assembly Data or Task Clock for Assy1/2/3 MFG 
types, no hard allocated items will be consumed, even if they are marked as Consume All, but the labor 
records are used in the calculation of the Actual Cost for Labor and Overhead.  

Note: In the scenario where a phantom item is hard allocated and its components are marked ‘Consume 
All’; if a user is reporting zero good parts they will need to set the good parts to 1 and calculate first, then 
change it back to zero so that the phantom components are backflushed in/out on the fly. 

Note: If the Good Parts entered is more or less than the work order quantity an Confirm status exception 
will appear to notify the user. Select OK to proceed or Cancel to return to the Labor reporting form. 
Security can be placed on the OK button to not allow employees to enter more or less than the work 
order quantity. 
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FG Lot # - Enter a Finished Good Lot #. If the ‘Lot # is mandatory’ option is checked for the item then the 
employee must enter a lot # otherwise it is optional. This field will automatically populate with the FG 
Lot # from the work order. The FG Lot # will carry through each process for the same work order. If the 
labor reporting lot # is different than the FG lot #, a confirmation message stating: 'The Labor Reporting 
lot number must match the FG lot number in order to obtain Lot traceability of the backflushed 
components. Are you sure you want to change the Labor Reporting lot number?', with Yes/No buttons. 
Security is available on this form and the buttons. 

Comments can be entered which will appear in the Comments field in the Process Details screen in 
Assembly Track (accessed by right clicking in the middle section of Assembly Track and selecting ‘Show 
Details’). 

Once the good parts quantity is entered and there are no rejects to report select Post and Continue to 
continue clocking out. If the total good parts and rejects is less than the work order quantity a warning 
will appear to notify the user. Select OK to continue or cancel to return to the Good Parts screen. 
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Select Cancel to return to the Task Clock or select the Finish button to complete the transaction. 

An Information message will appear displaying the standard labor hours and actual labor hours. Standard 
Labor Hours = qty of good parts reported * standard labor hours of the process; and Actual Labor Hours 
= time out – time in. 
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Note: If the process on the BOM is designated as 'Final Assembly Reporting, when the user selects OK on 
the Labor Reporting form the Final Assembly Reporting form will appear to enter Good Parts. (See Final 
Assembly for details). 

Additional Options: 

▪ Process Completion Required before logging in to next process: If the process has the Sequential 
Processing option checked the employee will be able to designate whether or not to allow users to 
log into the next process. The system will state: “Process completion required before logging in to 
next process. Allow Login to Next Process?” The employee can select the No if the process is not 
complete or Yes if it is. This defaults to No. 

▪ Process is currently scheduled in finite scheduling: Remove process from finite schedule? This only 
displays if the process is finite scheduled.  If the user checks the Yes box the process will be 
removed from finite scheduling and returned to the scheduling pool. Security can be placed on the 
Yes option. 

▪ Tote Label: Select the 'Tote Label' button to print a Tote label. The report used is based on the default 
assigned to the EPlant in MFG Types, or if none the one assigned to the MFG Type, or if none the one 
assigned in System Parameters->Reports and Forms. This report must be a Crystal label.  Enter the 
Box Quantity and Label Quantity, or use the calculate label quantity button.  When the label is 
printed the system will populate the data in the Master label table including the following additional 
fields: LAST_SNDOP_ID, NEXT_SNDOP_ID, PROCESS_LOGIN, and PROCESS_SHIFT. (Note: Currently 
the Tote label must be a Crystal label). Note: The Tote label button can be hidden through security. 
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Maintenance, Repair and Overhaul Equipment Cycles Update – When good parts and rejects are entered 
for a process, the total cycles of tools associated to the process will be updated in MRO. If a Line 
Clearance is required, only the tool(s) selected during the Line Clearance will have their cycles updated. 
This only applies to attached equipment with a unit of measure of Cycles. Note: When good parts are 
voided or when the rejected mfg parts are voided, the cycles of the MRO equipment will be reduced. 

Rejects – Entering During Log Out 

The first screen that appears upon selecting the Rejects button enables the user to choose the type of 
reject transaction, either Reject Components or Reject Mfg Parts. 



ASSY Manufacturing Page 243 of 358 

 

 



ASSY Manufacturing Page 244 of 358 

 

Rejecting Components 

To reject components, select the Reject Components option and then select the Next button. From the 
Rejects screen the user will see all the components associated to the work order they are clocking out of. 
Only processes with components will display. If a Non-Material item is attached to a process, the item is 
not displayed in the Reject Components and/or Reject MFG part screen, and cannot be rejected through 
Assembly Data. Components will be grayed out if they are for processes that are beyond the process the 
employee is clocking out of. If the employee is clocking out of the final process all the components will 
be available to enter rejects for in case it was missed during an earlier process. 

Enter the reject quantity and reject code. When entering a reject for components used on an earlier 
process the system will allow a positive quantity. Both 'Reject Qty' and 'Reject Code' must be assigned. 

To access the Reject Code pick list select the  button in the Reject Code field. If specific reject 
codes have been associated to the process only those will be visible otherwise all reject codes will be 
listed. In addition to the qty and code a Reason can be entered. To access the keyboard to type a reason 

select the  button in the reason field. 
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Multiple rejects records can be created for each component if required to provide different reject 
reasons. To create another reject record select the + button. To delete a record use the – button. Once 
the reject information is entered select the Next button to continue with the clock out. 

From the Location section users can select the specific location/lot to remove the rejected components 
from. This is optional unless the 'Component Reject Location is mandatory' option is checked for the 
Manufacturing Cell (System Parameters->Lists->Manufacturing Cells). If the option is not checked the 
location section will display 'Locations - Optional'. If it is checked it will display 'Locations - Mandatory'. If 
checked and a location/lot is not selected an error will appear stating: 'A component reject location is 
mandatory. Please select a location'. 

▪ For Non-Serialized Inventory Control (SIC) components, select the ellipsis button in the Location field 
and a pick list of locations associated to the component will display. Select a location/lot from the 
list. The quantities of the rejects will be removed from the location(s) chosen (negating the 
hierarchy). 

▪ If the component is SIC, select the ellipsis button in the Location field and a pick list of locations 
associated to the component will display. Once a location is selected, then the labels linked to that 
location will display for the user to choose from. 

Note: Rejected components cannot be over reported or under reported on the location level in relation 
to the totally reject quantity. 

The employee can select the Cancel button to discontinue with the clock out and be returned to the 
main Assembly Data screen. 

The next screen will indicate the system is ready to execute the transaction. Three buttons are available 
on this screen: 

▪ Back – This will return the user to the Rejects screen 

▪ Finish – This will complete the clock out and create the labor record. Rejects will be posted to the 
transaction log for the components and labor and overhead is also recorded. 

▪ Cancel – This will cancel the reject transaction and take the employee back to the Task Clock. 

Reject Mfg Parts 

To enter reject information for the manufactured part select the ‘Reject Mfg Parts’ option and enter the 
number of rejects and select the reject code on this screen: 
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Select the Next button to continue. The Reject Component screen will appear to enter rejects for the 
components as described above. When a value is entered in the Reject Mfg Parts field the system will 
automatically calculate the quantity of components associated to the process based on the parts per, 
and that value will be displayed in the Reject Qty field for the attached components. The same reject 
code selected for the Mfg Parts will also be carried over. Both values can be overridden. 

Once the components reject information is entered, select the Next button to continue. The FG Lot # will 
be displayed for the user to view/edit.  

This information will be populated in the translog, and the  ‘ADJUST WIP’ transaction type will be 
available for posting in PIT for both the current and previous processes’ components. 

Rejects reported in Assembly Data for both AS and WO tasks will display in Assembly Track in the Rejects 
section. If rejects are entered in error, they may be voided by right clicking in that section and selecting 
'Show Details'. Then right click and select 'Void Reject Entry'. See Void Rejects for details. 
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Line Clearance 

The Line Clearance module is used to clear the assembly line for processes. This must be done for 
processes that have the Line Clearance Required option checked prior to an employee clocking into a 
process. 

Only Supervisors can perform the line clearance procedure. Supervisor status is established in Employee 
Maintenance by checking the Supervisor option on the Misc. tab. Line clearance information will be 
stored in a history table (SNDOP_CLEAR_LINE) which stores each time a process was cleared, including 
the date/time, shift ID, supervisor, and process. 
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➢ To clear an assembly line, select the Line Clearance button in Assembly Data. The following 

screen will appear: 
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➢ Then scan the supervisor (Employee) ID. Or select Enter to select the employee from the 

supervisor pick list. 

➢ Scan the work order number or use the pick list to find the work order and press Select. 

➢ Scan the Shift ID or use the pick list to find the desired shift. Once selected the shift start 

and end date/times in the Approved Date/Time Range fields will fill in automatically.  The 
dates and/or times can be changed by selecting the Change Date button and entering the 
correct information in the pop up form. 
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The line will be cleared between these dates for the shift selected.  

➢ Select Next to continue. 
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➢ Check the ‘Cleared’ check box to clear the line for each process.  Processes that require a 

line clearance will display in bold. Those that do not will be grayed out and cannot be 
cleared. Processes that have already been cleared will have the box already checked. 

Multiple processes can be cleared at the same time. 

➢ From this screen users can access internal and external documents associated to the 
Process, BOM, or Inventory item by selecting the Documents toggle button in the lower left 

portion of the screen. 

➢ Certify - Employees can be certified for a process from the External document screen by 

selecting the Certify button . Highlight the employee to be certified and select the 

Certify!  button. 
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To return to the Line Clearance screen select the Documents button again. 

➢ Once the line has been cleared the user can select the Update and Exit button to complete 

the line clearance and return to the Time Clock screen, or select the Next button to proceed 
to the Associated Tools screen. 

 

From the Associated Tools screen the supervisor can select the specific tool(s) that should be used to 
perform the process. The list will display the MRO equipment that has been associated to the Auxiliary 
Equipment listed on the Assembly Process. (See Auxiliary Equipment for more information). The system 
will store which MRO equipment ID’s were actually used in the line clearance process and can be used 
for history reporting. If a tool is not chosen, the system will still allow an employee to sign into the work 
order. 

➢ Once all the information has been added select the Update & Exit button to return to the 

main screen. 
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Final Assembly in AssemblyData 

The Final Assembly function is used to report good parts. This is the same function that is available in 
Assembly Track. This will add the items to inventory and create a record in the transaction log with a 
Trans Type of ‘Finish Process WIP’ and a reason of ‘Final Assembly’. With matching Lot #s for good parts 
during Labor Reporting and Final Assembly, Lot traceability includes backflushed components in Lot # 
Tracking after reporting Final Assembly. 

Note: If the process on the BOM is designated as 'Final Assembly Reporting, when the user selects OK on 
the Labor Reporting form the Final Assembly Reporting form will appear with the work order and item # 
populated to enter Good Parts. However, from AssemblyData only a supervisor (Employee Maintenance-
>Supervisor option is checked) can enter the number of finished goods that have been completed; unless 
the 'No supervisor required for Final Assembly' option is checked for the MFG Type.  

Note: When a supervisor is required, the system will capture the supervisor's badge number in the 
TRANSLOG table. 

Select the Final Assembly button from the module bar in AssemblyData and the following screen will 
appear: 
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➢ Enter the supervisor number if required. 

➢ Enter the work order number, or select the check button to bring up a list of all ASSY work 
orders. (Note: It is not necessary that the work order be added to Assembly Track to be 
visible in Final Assembly as it is when logging in). 

➢ Highlight the desired work order and enter the 'Good Parts'. (Note: Zero or a negative 
number is allowed). If zero good parts is entered a warning will appear stating, ‘Zero good 
parts have been entered.  Continue?’. If the user selects Cancel they cannot proceed to the 

next form. If OK is selected, the system will continue. If the quantity of good parts entered 
is greater than the work order quantity a warning will appear stating, 'Total Good Parts is 
greater than WO Qty'. Security can be placed on these warnings.  

➢ Upon finishing Final Assembly if ‘Work Order is Complete’ was unchecked, nothing is posted 
to translog, so in PIT the cost of the consumed components remain in WIP.  If ‘Work Order 
is Complete’ is checked during Final Assembly, the system will write a 0 quantity entry in 

Translog. Regardless of the quantity entered, the system will clear the SNDOP_DISPATCH 
buckets so that in PIT, the cost of the consumed components, labor, and OH of those parts 
not reported in final assembly would be credited from WIP and debited into Variance. 

Note: When a negative value is entered the Post Inventory Transaction (PIT) will display a negative debit 
value instead of a positive credit value. This is because the system does not have IN and OUT in this 
form. It only looks for an IN therefore a negative entry calculates the same as a positive number resulting 
in a negative debit rather than a positive debit.  The journal entry will be correct, the negative debit 
value is converted to a positive credit value. 

➢ Enter a FG Lot # if desired. (If the ‘Lot # is Mandatory’ option is checked for the item the 

supervisor must enter a lot number). 

➢ A Final Assembly Report can be printed by selecting the ‘Print Final Assembly Report’ box. 
The report that prints is the one that has been assigned in System Parameters->Reports and 

Forms->AssemblyData report. 

➢ There is also a Reports button that can be used to print reports added to this menu. 

➢ Check the 'Work Order is Complete' box if the work order is finished. After selecting the 
Finish from the Prepare Labels screen the user will be asked if the work order should be 

deleted or not. If it is not deleted it will still be visible in Assembly Track but it will be 
highlighted in yellow to indicate it is complete. 

➢ Select the Next button. The Prepare Labels screen will appear.  
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➢ Prepare Labels by entering the number of labels and the quantity of good parts associated 

with each label. The system will keep track of the balance of items that still need a label in 
the Balance field. If the ‘Print Labels On Final Assembly‘ Parameter is checked (in Configure 
AssemblyData,Controls tab), or if the item is serialized, the user must enter labels for the 

good parts and the balance must equal zero or they will receive an error: “Total labels qty 
does not match good parts - unable to continue”. If the parameter is not checked creating 
labels is optional. The Search pick list will display any existing MASTER_LABEL records for 

the selected work order that have not been dispositioned or shipped.  An existing serial 
number can be selected from the pick list and upon finishing Final Assembly, the system will 
reprint the label and disposition into inventory. (Note: Serial numbers with prefixes can be 

scanned). 

➢ Location - Users can optionally select a location for the items to be dispositioned to. Select 

the pick list button and select a location from the list. A new location can be associated to 

the item by selecting the New button on the pick list. This will bring up the 'Assign New 
Location' (location list) form. This will override the Disposition Hierarchy mentioned below. If 
the parameter 'Location is mandatory during Final Assembly' is checked (Options menu in 

Assembly Track), if the Location field is not populated, an error message will pop up: 
'Mandatory field 'Location' must be entered - operation aborted', with an OK button.  When 

OK is selected, the Final Assembly form remains open for the user to enter the location. If 
unchecked, entering a location is optional. 

➢ Select the 'Finish' button and a confirmation box will appear. Select OK to continue and post 

the transaction. Or select Cancel to return to the Final Assembly screen. 

Note:  If the quantity of good parts entered is greater than the work order quantity a warning will 
appear with an OK and Cancel button stating, 'Total Good Parts is greater than WO Qty'. Security can be 
placed on these warnings. 

➢ The items will be put into a location based on the Disposition Hierarchy below unless a 

location was selected manually. 

When reporting Final Assembly for ASSY1 and ASSY2, the following hierarchy is for dispositioning the FG 
item into inventory: 

If the process IS scheduled in Finite Scheduling: 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Dispo IN of the work center associated to the last process 

5 Dispo IN of the dispatch list work center associated to the last process 

6 MFG Cell Dispo locations 

7 MFG Type Dispo. Designators 

8 FIFO 
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9 Temporary 

If the process IS NOT scheduled in Finite Scheduling: 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Dispo IN of the dispatch list work center associated to the last process 

5 MFG Cell Dispo locations 

6 MFG Type Dispo. Designators 

7 FIFO 

8 Temporary 

Note: The Hard Allocated location applies in situations where a manufactured item is used in a higher 
level process and is hard allocated to the higher level work order. 

If  a location was not selected manually, when reporting Final Assembly for ASSY3 (Backflush Each 
Process is NOT checked), the following hierarchy is for dispositioning the FG item into inventory and 
backflushing the material out of inventory. 

1 Hard allocated to the work order 

2 Mfg # default designator 

3 Default designator 

4 Designated assembly line IN/OUT location (if the work order is scheduled in Finite Scheduling) 

5 MFG Cell Dispo locations 

6 MFG Type Dispo OUT location 

7 FIFO 

8 Temporary 

Note for VIN Generator users: If the work order is associated to MASTER_LABEL records with a VIN 
number, the user will not be able to enter a FG Lot #.  After entering a quantity and clicking Next, 
preparing labels is mandatory (even if the item is a non-serialized control item).  The user can either 
search for an existing serial # or add a label.  Upon posting Final Assembly, the item is dispositioned 
into inventory with the VIN # as the lot #.  The Smart Code, Cost, and Price from the CRM Quote will be 
populated under lot control.  The weight of the item will also be populated under lot control. (For more 
information on VIN Generator please see the Vehicle Identification Number Generator 
https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf TechNote). 
 

https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf
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Rework Reporting in Assembly Data 

In Assembly Data select Rework Reporting module to report Rework Mfg Type items using the 
Production Reporting by Work Order (PRW) module. When this option is selected the work order pick list 
filtered on the REWORK Mfg Type will appear. Select the item to be reported from the pick list and the 
PRW form will open at the Start tab. This option is also available in Assembly Track (right click option in 
the top section. (The screen shots below are from Assembly Track but are the same in Assembly Data 
except for touchscreen). 

Start 
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This tab will display the Work Order #, Work Order Qty, and Remaining Qty, and the Item information 
based on the selection made from the pick list. To change the work order or item select the ellipsis 
button in the fields and select from the corresponding pick list. The Clear button will remove all of the 
data that was entered to start the production report over. 

Select the WO Completed box if the work order is complete. After clicking on the 'Finished' button on the 
Summary or Costing tab if this box was checked and the work order is marked Firm, the system will ask if 
the user wants to delete the WO, “WO# xxxxx has been marked completed.  Delete this WO?” If the 
work order is not marked firm, it will remain on the schedule for the system to take care of automatically 
when update schedule is run again. 

Right Click 'Jump To' Options available on the Start tab: 

▪ Jump To Work Order 

▪ Jump To Inventory 

▪ Jump To BOM 

▪ Jump To Work Center 

Once the information is complete, select the Next button. 

Quantity 
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From this tab users will enter the quantity reworked. The Lot # will automatically populate with the 
current lot of the MFG#. A Lot # can be manually entered or the user can select the 'Set Next FG lot #' 
button to have the system apply the next lot number. If the WO Completed box is checked, if the 
quantity being reported is less than the WO quantity when clicking ‘Next’, a warning will appear: 
‘Quantity reported is less than the work order quantity.’ This warning has a ‘Do not show again’ option. 
Security can be placed on this warning. 

Prod Hours 

Select the Work Center from the pick list accessed by clicking on the ellipsis button in the field. Then 
enter the production hours.  
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Labor 

Specific employees can be associated to the production report record. Select the + button to add a labor 
record. Then select the ellipsis button in the 'EmpNo' field and select an employee from the pick list. The 
Prod Hours field will populate with the Prod Hours entered on the previous tab. This value can be edited 
to record the actual labor hours associated to the specific employee. Multiple labor records can be 
created by selecting the + button again. 
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Rejects 

Rejects for attached components or for the manufactured product can be entered from the Rejects tab. 

 

From the Mode field select the ellipsis button and choose: Reject Components or Reject Mfg Parts from 
the pop up form. 
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Reject Mfg Parts 

When the Reject Mfg Parts option is selected enter the quantity of rejects in the Mfg Parts field, and 
select the Reject Code from the pick list accessed from the ellipsis button. The eraser button next to this 
field can be used to clear the selected reject code. The system will automatically calculate the reject 
quantity for the components based on the Mfg Parts reject quantity, but it can be overridden by entering 
a different value in the Reject Qty field for the specific component. The Reject Code will default to the 
same code that was selected for the manufactured item but can be changed by selecting a different code 
from the pick list. Additional information can be entered by typing in the Reason field. 

Reject Components 

Select this option to reject the components without rejecting the manufactured item. The components 
associated to the BOM for the manufactured item will display in the middle section. Highlight the item to 
be rejected and enter the quantity in the Reject Qty field in the bottom section of the form. Select the 
reject code from the pick list and enter a reason if desired. 

Disposition 

The Disposition tab the system will do an OUT transaction from the non-conform location and an IN to a 
location based on the disposition hierarchy. (Note: If the disposition IN location is marked as non-
conform then the item will remain in non-conform status, if this is not desired be sure that the IN 
location based on the hierarchy is not marked as non-conform). The transaction will show up in Post 
Inventory Transactions (PIT) as a transaction type of disposition. The system uses the costs associated to 
the costed BOM. If it is desired that the costs come from the Rework BOM you must recalculate it and 
roll those costs. 
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Summary 

The Summary tab displays the information that was entered in the production report, such as serial #'s, 
labor, locations, rejects, and backflush information. 
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Once the information is reviewed, the transaction can be posted by selecting the Post button. A confirm 
message will display stating, "Are you sure you want to post this production report?" If Yes is selected, a 
'Disposition' type transaction will be made. Selecting No will return the user to the summary tab without 
posting the transaction. If the relieved quantity differs from the Materials Involved quantity by 10% or 
more, a warning will appear when posting the Production Report. If information needs to be edited prior 
to posting select the Back button to return to the previous tab(s). 

From the Summary tab users can right click and choose to copy and paste the summary, or print it (print 
or print preview). 

Costing 

This tab displays the Costing information for the item. This functions just like the Process Cost module on 
the Process Cost tab on the EIQ Launcher Bar.  For a complete discussion on the process costing 
module please refer to the Introduction to Process Costing topic in the Standard Cost section of the help 
files. 
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Finish 

Once the the production report is complete, select the Finish button and select Yes to the confirm 
message. The user will be returned to the Start tab. 

Reverse Disposition  

There is a Reverse Disposition check box on the Start tab to perform a reverse disposition. If this is 
checked, the Quantity tab for non-SIC items will display the 'Enter Quantity' tab only. For SIC items the 
Scan Serial tab will only display. The Disposition tab will  relieve the manufactured product and add the 
materials involved based on the work order.  

1 Select the work order and check the Reverse Disposition box.  

2 Select Next to access the Quantity tab. If there is more than one production report for the work 
order another pick list will surface to select the specific Production Report ID to reverse. 

3 Once the Quantity screen appears, for non-SIC items the user will enter the quantity of production to 
reverse in the 'Good Parts' field, and enter a lot # if applicable. 

4 For SIC items the Scan Serial tab will only display. Select the search button to access the list of serial 
numbers associated to the work order. Select the serial number(s) and press OK. 
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5 The Disposition form will show the manufactured product coming out of inventory and the materials 
involved will be added to inventory. During the reverse disposition users should not enter any 
reverse consumed materials. All this information will automatically come in based on the original 
disposition, including if they were hard allocated. 
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Pallet Builder 

The Pallet Builder module allows the user to scan a master label serial #; when scanned and validated 
against the currently running work center’s work order, the application will disposition the serial # and 
add it to the correct pallet. The disposition reason in translog will be 'Floor Disposition'. This module 
supports multiple pallets in the event that a family tool is running and will match the label to the correct 
part. Multiple pallets can also be created for a single part. 

Setup 

A pallet label must be set up so a label will print when the pallet is filled to capacity. 

By default BOL Data must be setup for items in order for the system to calculate the correct amount of 
parts per package and package per pallet. However if the 'Do Not Force BOL Data' (in ShopData 
Configuration->Pallet Builder->Global setting) is set to Yes, the system will look to the setting of the 
option Override BOM Information on the inventory item's BOL Data settings. If that setting is checked, 
the system will use the information in the BOL Data screen for packaging information in Pallet Builder. If 
it is not checked, Pallet Builder will use the packaging information on the BOM instead. If the' Do Not 
Force BOL Data' option is set to No, Pallet Builder will always look at the BOL Data packaging 
information. 

BOL Data 

From the inventory item screen, go to the Inventory item in EnterpriseIQ, open the Options menu and 
select ‘BOL Data’. From within BOL Data, enter the appropriate number of Items Per Package and Items 
Per Pallet. Items Per Package refers to the number of items in a box, while the Items Per Pallet refers to 
the number of total items to a single pallet. 
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Pallet Builder will use the following calculation to determine the number of boxes per pallet: (Items Per 

Pallet / Items Per Package) = # of boxes per pallet  

Label 

The pallet label used will be the label set in Label Maintenance as a ‘Manufactured’ label type and 
‘Pallet’ label kind. In the event that the user has multiple ‘Pallet’ kind labels with specific customers 
associated to them, the system will use the customer-specific label if the customer on the label matches 
the customer set as the Default Customer on the inventory item. (The Default Customer is set in the 
Inventory module Additional tab).  

Pallet Builder Settings in ShopData  

From the Pallet Builder settings in Configure ShopData there are several options relevant to Pallet 
Builder. 

Local Settings: 

▪ Printer - Prompt on Pallet Complete - If checked, this will notify the user that the pallet is complete. If 
the Auto Print Pallet button is depressed in the pallet Builder module, the application will 
automatically prompt the user to print a pallet label as soon as the pallet is completed. The 
parameter default is not checked. 

▪ Control  

▪ Warn for Non-Conform Scan - When enabled, this setting will surface an error message popup 
immediately after scanning a serial # located in a non-conform location. The message will state, 
'Serial # XXXXXXXXX is in a Non-Conforming Location. Would you like to continue?'. If OK is 
selected the system will add the scanned serial as normal. If NO  is selected the system will 
continue building the pallet as normal without losing any previous scans, but it will not include 
the non-conform located serial # that was just scanned. 

▪ Dispo on Pallet Complete - This will eliminate individual transactions being made for each scan, 
reducing the total number of records in translog. With this setting active, one transaction is done 
when the pallet is completed. 

▪ Prompt Pallet Quantity - If the 'Dispo on Pallet Complete' parameter is checked this option will be 
available. When checked, a form will surface when selecting the Pallet Complete button allowing 
the user to fill in the pallet quantity. It will have the total scanned value, which may be 
overridden by the user. The application then takes the quantity entered, divided by the number 
of serials, and updates the quantity of each child label prior to dispositioning them all at once. 
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Global Settings: 

▪ Do Not Force BOL Data - If this is checked, the system will then look to the setting of the option 
'Override BOM Information' on the inventory item's BOL Data settings. If that setting is checked, the 
system will use the information in the BOL Data screen for packaging information in Pallet Builder. If 
it is not checked, Pallet Builder will use the packaging information on the BOM instead. If the' Do Not 
Force BOL Data' option is set to No, Pallet Builder will always look at the BOL Data packaging 
information. 

▪ Allow Mixed Lots - When the option is checked, child serials of mixed lots are allowed on a single 
pallet. The system follows the same transaction rules as when building mixed lot pallets from 
scanners, and ensures child serials added to a pallet have a Lot # when 'Lot # is mandatory' is 
selected on the item. Note: When the 'Allow Mixed Pallets' in WMS Profiles is set to Y, and the 
system determines that the pallet is mixed, each child label will be dispositioned one at a time to the 
correct location/lot. Additionally, when the 'Allow Mixed Lots' Pallet Builder setting is checked and 
the pallet is a mixed lot, the pallet label's Lot # will be nulled as soon as the label is entered and the 
pallet becomes mixed. 

Building Pallets 

The following section will discuss the various controls within the Pallet Builder application as well as 
instructions for building pallets.  

Pallet Builder Controls:  

Load Pallet Allows the user to view a pallet that was already created against the work center. 
A popup will appear where the user can enter a pallet or case serial #. This can be 
used to view the pallet in order to reprint a pallet label.  

Pallet Complete If the ‘Auto Print Pallet’ functionality is not activated, the user can click the ‘Pallet 
Complete’ button to print a label for the pallet.  

Reprint Label This allows the user to reprint the selected pallet label. The user must use the 
‘Load Pallet’ button and enter the pallet serial # to view the pallet and reprint the 
label.  

Auto Print Pallet When this button is depressed, the application will automatically prompt the 
user to print a pallet label as soon as the pallet is completed.  

Remove Carton Users can select the Remove Carton button to remove the highlighted carton 
from the pallet. When this option is selected a popup form will display with three 
options: 

▪ Adjust (Out Transaction) - Removes the label from the screen and removes the 
item(s) from inventory with a transaction code. A pick list of transaction codes 
will appear to choose from. 

▪ Scrap (Out Transaction) - This also removes the label and item from inventory 
but with a reject code. The Rejects form will appear to choose a reject code. 

▪ Disassociate (No Inventory Transaction) - This removes only the label with no 
transaction. The item remains in inventory. 
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Get Current BOM When a new work order is added, the Get Current BOM turns red and signals the 
user that a new BOM was setup. This button should be toggled when the current 
BOM showing in the Items/Pallets section does not match the BOM that’s 
currently running in first position in Finite Schedule for the work center. The 
system will refresh this button every 15 seconds. 

Note: If there are pallets in progress a warning with Yes and No buttons will 
display: 'Warning: The current Pallet Builder configuration has pallet(s) in 
progress. Do you want to force 'Get Current BOM' and apply the next 
configuration? Current Configuration: [ WC#: #, BOM#: xxx, Item#(s):xxx, Next 
Configuration: [ WC#: #, BOM#: yyy , Item#(s): yyy' 

From within the Pallet Builder module, set the desired ‘Auto Print Pallet’ setting (on or off), and enter 
the first serial number into the ‘Scan Serial #’ field and click the ‘Go’ button.  

Once the first box serial # is entered, a pallet serial # will be generated as well. The user can continue to 
add additional boxes to the pallet utilizing the same method used to enter the first box #.  
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If the 'Warn for Non-Conform Scan' setting in ShopData Configuration for Pallet Builder is set to Yes, if a 
serial number in a non-conform location is scanned an error message will display stating, 'Serial # 
XXXXXXXXX is in a Non-Conforming Location. Would you like to continue?'. If Yes is selected the system 
will add the scanned serial as normal. If No is selected another message will display, 'Non-Conforming 
serial #XXXXXXXXX was prevented from being scanned to the pallet', and the system will continue 
building the pallet as normal without losing any previous scans, but it will not include the non-conform 
located serial # that was just scanned.  

By default if a serial is scanned that does not match the lot number a message will display, 'Serial 
#XXXXXXXXX, Lot #yyy, does not match Lot #zzz'. If the 'Allow Mixed Lots' is set to Yes (in ShopData 
Configuration->Pallet Builder->Global setting), child serials of mixed lots are allowed on a single pallet. 
The system follows the same transaction rules as when building mixed lot pallets from scanners, and 
ensures child serials added to a pallet have a Lot # when 'Lot # is mandatory' is selected on the item. 

If the 'Use SN Labels to control MTO Dispositions' parameter is checked (System Parameters -> Purchase 
Order and Sales Order Setup tab, during Pallet Builder floor dispositions by SN if the 
MASTER_LABEL.ORD_DTL_ID is populated the system will lookup the order line item to see if it is marked 
MTO. If it is marked MTO the disposition will be processed as an MTO.  It will not look at the Work 
Order for the MTO designation if this parameter is checked. 

Note: If an error occurs while adding a serial number to a pallet, the scan transaction is canceled and the 
serial number will not be added.  

Print 

Instead of scanning an existing label that has already been printed, select the 'Print' button to create a 
new label and generate a new pallet label in one step. The system will attach the newly printed box label 
to the pallet label automatically.  

The Print Label form will display to print the new label. 
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Note: If the Pallet Builder option 'Dispo on Pallet Complete' is checked, the Shift Disposition options 
(Disposition Labels Current Shift and Disposition Labels Multiple Shifts) will not be visible as they do not 
apply. 

Note: The 'Labels Quantity' field in the Print Label form cannot be edited.  It defaults and remains at 1.  

Multiple Pallets 

Multiple Pallets can be created for a single item. A new pallet can be created by selecting the + button in 
the Pallets section. A new tab will display with 'Pallet # Empty'. Serial numbers can then be scanned to 
the new pallet and a pallet serial # will be generated. 
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Additional Pallets can also be loaded to the screen using the Load Pallet button. 

An empty pallet can be deleted by selecting the - button. The - button is not available for a pallet with 
attached serial #'s. 

User Defined Field 

Each pallet can have a value populated in the User Defined Field. The name of the User Defined Field can 
be set by selecting the right click option 'Define Label Text' and entering text in the New Value field. The 
list of selections is created by right clicking on the drop down arrow and selecting 'Edit User Defined List'. 
The list can be a drop down or pick list based (where an SQL is assigned). 

For example, the pick list based option could be used to allow users to visually identify for whom the 
pallet is being loaded. An SQL could be created that would query the CNTR_SCAN_PALLETS and link back 
to the work order to display a list of all customers assigned to the releases section of a work order via the 
link back through sales orders to customers. 

Remove Carton 

Users can select the Remove Carton button to remove the highlighted carton from the pallet. When this 
option is selected a popup form will display with three options: 
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▪ Adjust (Out Transaction) - Removes the label from the screen and removes the item(s) from 
inventory with a transaction code. A pick list of transaction codes will appear to choose from. 

▪ Scrap (Out Transaction) - This also removes the label and item from inventory but with a reject code. 
The Rejects form will appear to choose a reject code. 

▪ Disassociate (No Inventory Transaction) - This removes only the label with no transaction. The item 
remains in inventory. 

Pallet Complete 

Once the maximum number of boxes has been added to the pallet, an indicator will display on the screen 
indicating that the pallet is complete. At this point the user can toggle the ‘Pallet Complete’ button in the 
upper left portion of the screen to print a pallet label.  

 



ASSY Manufacturing Page 279 of 358 

 

If the ‘Auto Print Pallet’ function was activated, a prompt to print a pallet label will automatically appear 
when the user adds the last box to the pallet. If the user does not have the ‘Auto Print Pallet’ 
functionality enabled, the same prompt will appear when the user toggles the ‘Pallet Complete’ button.  

 

Note: If a family tool is running, Pallet Builder supports multiple pallets. It will match the label to the 
correct part when scanned.  
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Consumed Materials  

If the 'Auto Backflush on RT Scan to Inventory' is checked in Production Reporting Parameters, materials 
are automatically backflushed when the serial number is entered or scanned to the pallet. If 'Dispo on 
Pallet Complete' is turned on within Pallet Builder Settings, materials are not backflushed until the pallet 
is completed.  
 

Internal/External Docs 

From the module toolbar select the Internal or External document button. The document buttons will 
allow the employee to view the internal and/or external documents for the Processes, BOM, and 
Inventory item associated to the work order they are logged into. The Routing Notes associated to the 
process will also be available by selecting the Routing Note button. 

➢ To access the documents select one of the document buttons on the module tool bar. 
(Regardless of the one selected the employee will have the ability to view both types from 
the screen). 

➢ Enter the employee number in the Logged In tasks screen. The work orders the employee is 
logged into will be listed. 

 



ASSY Manufacturing Page 281 of 358 

 

➢ Highlight the work order and select OK. The screen will open to display the documents. 

The emphasis will be on the document type selected in the menu.  In either case the user can toggle to 
the other type of documents by selecting the corresponding button.  

 

Documents associated to the Process, BOM, and Inventory item are all available from this screen. To 
access a document from one of those modules simply select the correct button on the left side of the 
screen. 

All documents tab functionality that is found throughout EnterpriseIQ is available in AssemblyData, such 
as printing, adding, and editing. 
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Quick Inspection 

This option will be available to customers with the EnterpriseIQ SPC module. From this option users will 
be able to perform a SPC Quick Inspection for various types of records such as a Inventory Item, 
Processes, MRO/Tooling item, or Work Center. The user will first select the Type from the pop up box. 
Next enter the employee name using the employee or team member list. (Check the 'Do not show next 
time' box if you would prefer to not see this option). If the 'Enable electronic signature sign off' option is 
checked in System Parameters->Company File Information->Application tab the employee will be asked 
to enter their username and password. 

The corresponding pick list will display depending on the type of inspection selected. For example, when 
selecting Process, after entering the employee information a pick list of the work orders scheduled in 
Assembly Track will appear first, and then a pick list of processes attached to the BOM associated to that 
work order. Select the SPC Quick Inspection and then the SPC screen will appear. Select the correct item 
from the list and the list of Quick Inspections associated with the item will be listed. Select the inspection 
to be performed. The gage/device selection box will appear, select a gage/device or cancel to use the 
first one. Users can check the 'Do not show next time' box on this screen also to not have this pop up 
appear each time. Once past this screen the SPC Quick Inspection screen will appear.  

Note: If there are open CARs, MRBs, ECOs, Deviations, or PPAPs a status exception will be raised 
requiring authorization to proceed. 
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When creating a Quick Inspection record in AssyData, the information for Mfg#, Work Order #, or Work 
Center # will only be populated on the Quick Inspection group information section if the item is running 
on the work center selected at the top of the screen.  Otherwise, the values will be null and can be 
edited as needed. If the work order # required option is selected for the Inspection Group, the user will 
be required to select a work order # from the pick list. 

Select the 'Group Information' toggle to switch from viewing the group information and the sample 
details, to just the sample details. 

Speed Button Options: 

▪ Charts - Select the Charts button to select a chart for viewing (X-Bar, X-Bar and Range, and P and NP). 
Select the 'Enable Multiple Charts' option to be able to view multiple charts at one time. 

▪ Print Labels _Opens the Print Labels form 

▪ Print Reports - Accesses the registered reports menu for reports associated to the Quick Inspection 
module. 

▪ Carry Over Inspection Detail - Depress the 'Carry Over Inspection Detail' button to carry the details 
from the current quick inspection to a new record. When a new record is created using the + button 
the system will carry over the following information: Manufacturing #, Work Order #, Receipt #, PO #, 
Vendor #, Vendor Company, Note, User Text 1-3, FG Lot#, and Serial#. This will prevent the inspector 
from having to manually enter the information when performing multiple inspections on the same 
material and lot. 

For additional information on the SPC Quick Inspection please see the SPC help file. 
 



ASSY Manufacturing Page 285 of 358 

 

Inventory Transactions and Locations 

This module allows users to view location information for items and perform in and out inventory 
transactions similar to the Transaction and Locations module in EnterpriseIQ.  

Select the Inventory Transactions and Locations button on the module bar to access this module. The 
inventory pick list will appear. Choose the desired item from the list. 

The screen will display the locations associated to the selected item with color coding just like in 
EnterpriseIQ. 
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Functions available in the AssemblyData Inventory Transaction and Location module: 

New Location 

Select the New Location button to associate a new location to the item. Select the location from the 
arrow down list by scrolling down to the location or type in the first character of the location and the 
system will 'hyperbrowse' to the location, or select the search button to access the pick list of locations. 
Once you have chosen a location, enter in the Lot Number of the material, if applicable. In the case of a 
manufactured item the user may enter the lot number or touch the arrow icon and the program will 
bring over the current lot number from the BOM. 

The new location can be specified as a Default Disposition location.This is used during auto dispositioning 
in production reporting. If an item has a default location set up it will be used when adding or removing 
inventory during auto dispositioning. To set the location to be a default designator click on the check box 
next to the Associate with Mfg# or select the Set as Default Designated Location box next to this field. 
Both options can also be selected. These fields are discussed in greater detail in the Disposition Options 
section in the Production Reporting chapter. 

Press [OK] to finish the entry and link the location to the inventory item. 

Lot Date  - The Lot Date field can be used to enter the date of the lot for locations with a lot number. 
Select the calendar button in the field to access the pop up calendar to select the Lot Date. Lot Dates can 
also be entered during PO Receiving through EIQ or RF. If the item has a value in the shelf life field other 
than zero on the Additional tab in inventory, when the difference between the system date and the lot 
date exceeds the shelf life the location will automatically be marked in red indicating it is expired. Costs 
Associated to Locations. 

Delete Location 

Highlight the location to be deleted then select the Delete Location button. Confirm the deletion by 
pressing Yes.  If the location has a quantity, the Remove from Location screen will appear otherwise the 
location will deleted. From the Remove from Locations screen, accept or edit the Quantity to be 
removed. The user can enter a Reason, Transaction Code, or other Options. See Removing Material from 
Inventory below for more information. Once removed the location will no longer show in the list of 
locations associated with the inventory item. 

Add to Location 

Highlight the location that material will be added to then select the Add To Location button. The Add to 
Location screen will appear. 
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Enter the Quantity to be added to the location. To enter a quantity press the quantity field to open the 
quantity pop up form. (If adding an item of class PL, the option to enter a Regrind Quantity will also be 
available). Press the show keypad button and enter the quantity to be added. 

Select a Transaction Code from the pick list, if desired.  

Enter the Transaction Date. The date will default to the system date and time but the user has the option 
to change it by selecting a different date from the drop down calendar or touch screen calendar form 
accessed by pressing the calendar button next to this field. 

Enter a Reason for the transaction (optional) by clicking the drop-down arrow in the field and selecting a 
Reason from the drop-down list that appears. Please note that the Reasons list is editable by right-
clicking the drop-down arrow and selecting 'Edit User Defined List'.  

Remove from Location 

Highlight the location that material will be removed from then select the Remove from Location button. 
The Remove from Locations screen will appear. 
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Enter the Quantity to be removed from the location (if removing an item of class PL, the option to enter a 
Regrind Quantity will also be available). To enter a quantity press the quantity field to open the quantity 
pop up form. Press the show keypad button and enter the quantity to be removed. 

Select a Transaction Code from the pick list, if desired.  

Enter the Transaction Date. The date will default to the system date and time but the user has the option 
to change it by selecting a different date from the drop down calendar or touch screen calendar form 
accessed by pressing the calendar button next to this field. 

Enter a Reason for the transaction (optional) by clicking the drop-down arrow in the field and selecting a 
Reason from the drop-down list that appears. Please note that the Reasons list is editable by right-
clicking the drop-down arrow and selecting 'Edit User Defined List'.  

Scrap - If the material to be removed from inventory is going to be scrapped, press the No button to 
change it to Yes. Then select the Scrap Code from the pick list in the Scrap field. When entering scrap the 
system will look up the manufacturing cell on the BOM and only surface the reject codes with a cell that 
matches the BOM. Reject codes with no manufacturing cell will also display. When entering scrap where 
the BOM does not have a cell, the system will only surface the reject codes with no cell associated to 
them. Scrap transactions are written to the rejects table.  

Move To Location 

The Move To Location option allows users to move a quantity from the highlighted location to another 
location. 

Highlight the Location to be removed from then select the Move to Location button. 

Select a Target Location from the pick list of locations associated to the item, or select the New button to 
associate a new location. When the new button is selected the Master Location pick list will appear to 
choose from.  

For Non-Serialized items, once a target location is selected a pop up form will appear to enter the 
quantity to be moved and optionally a reason. 
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For Serialized Items, a form will appear for the user to choose the label(s) to move. 

 

Show Linked Labels - For Serialized Items users can select the Show Linked Labels button to view the 
labels associated to a specific location. The form displayed will look similar to the one above. 
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Work Order Materials & Components 

This module is only available if licensed for 'Advanced WMS'. 

From this module users can see the Work Center, Mfg #, and Item information as well as the material 
requirements for the work order in the first position on specific work centers. It also provides the ability 
for users to request material that is not part of the BOM to be moved to the work center's Dispo Out 
location. 
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The left section includes the following fields: 
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Work Center This displays the Work Center number and Description.  

This section also includes the work center's Dispo Out Location (set in the Shop Floor 
Disposition Parameters in the Work Center module); and the Inventory Zone Code 
associated to the location. 

Work Order # The work order number running on the work center. 

Mfg # The Mfg # and Description. 

Cycles and Hours 
to Go 

The current cycles and hours to go. 

FG Lot # The FG Lot Number. 

Cust # The customer number and name associated to the work order. 

Process # The process number and description associated to the work order if applicable. 
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Staging Qty in Hrs This is the number of hours the system will use to determine the staging quantity of 
materials required. This defaults to 8 hours but can be changed from this field or a 
specific value can be assigned to a work center that will override the default. 

To change the value associated to the work center select 'Shop Floor Disposition 
Parameters' from the Options menu in the Work Center module. Enter a value in hours in 
the 'This work center' field in the Staging Qty (hours) section. 

 

The Default can also be changed from the parameters form that will affect all work 
centers. 

To change the staging hours value from this ShopData module select the button in this 
field and select a value from the pop up keypad and push OK. This will also change the 
value in the  'This work center' field in the 'Shop Floor Disposition Parameters'. 

Item Information This section includes the Item #, Description, Rev, and Ext Description for the 
manufactured  item(s). 

Materials Section 

The materials listed in this section will be those that are in the Dispo Out Location associated to the work 
center and the materials required to run the specific work order. If an item has the 'Exclude from Work 
Order Materials and Components' option checked on the Additional tab in Inventory it will not show 
here. The materials are color coded based on their status. 
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▪ Green - Material is required for this work order and the On Hand is equal to or greater than the 
Staging Quantity. 

▪ Yellow - Material is required for this work order but the On Hand is not equal to the Staging Quantity. 

▪ Red - Material is not required for this work order. 

The fields in this section include: 

Item Information Item #, Item Description, and Ext Description 

On Hand The on hand quantity of the item in the Dispo Out Location. 

Staging Qty The required quantity for staging based on the staging hours. 

Total Required The total required to complete the work order. 

Transaction Request 

Users can double click an Item in the Material/Component grid to request a 'Staging Request' or 'Pickup 
Request'. The default transaction will default to Pickup (Out) if the item does not belong to the work 
order that is running (Red).  It will Default to Staging (In) if the item is yellow or green.    
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The form will display the Work Order and Item information. It will list all FGMulti records associated to 
the work center location, as each record may have a specific serial number and/or lot #. 

Select the 'Staging Request' button (green arrow) to request the items to be sent to the work center. The 
quantity defaults to amount required for the work order. 

Select the 'Pickup Request' button (red arrow) to request the items to be picked up from the work 
center. The quantity defaults to the amount in the location that is not needed for the work order. 

The quantity can be changed by selecting the button next to the field and entering a different value using 
the keypad. 

Press OK and the transaction request will display in the Pending Transactions Alert section of the 
module. 

Pending Transactions Alert 

In this section users can view existing requests, or request materials that are not part of the BOM. 

To add a request: 

Pending Transactions Alert 

In this section users can request materials that are not part of the BOM. 

➢ Select the + button and a pick list of inventory will display. 

➢ Find the item in the list and press Select. 

➢ The item will be added to the lower section. 
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The pending transaction alert record will be in red text if there is a problem with the transaction plan 
(i.e. could not find a matching rule or insufficient qty or locations). This will enable users to visibly see 
right away there is a problem.  Users can right click on the record and select 'Inventory Transaction 
Plan' to review the plan. 

Pending Transaction Alert section Field Listing: 

Priority When adding a transaction from the Pending Alert section this field will default to High 
but can be changed by selecting Med or Low from the drop down list. When adding a 
transaction using the Transaction Request form it defaults to null, but can be changed 
using the drop down list. 

Qty This is the quantity of items requested. This will default to one but can be changed by 
selecting the button in the field and entering the desired quantity in the pop up Keypad. 

Transaction # This is the transaction number assigned by the system. 

Item Information Item #, Item Description, Class,  Item Ext Description, and Rev 

Kind This will display 'Staging' in green. 

Alert Description The system will populate the Alert Description with “User Requested XXX to LLL”  where 
the XXX is the Inventory description the LLL is the Location. 

Time Stamp The date and time the request was made. 

Refresh button - A Refresh is available in the upper part of the screen that when pushed will refresh the 
screen. The screen will automatically refresh based on the entry in Realtime Monitor>Plant Parameters> 
Screen Refresh Time. 

A table is populated with the information necessary to process the transaction alert along with the date 
and time the alert was submitted. When a transaction alert is initiated, the work center’s disposition 
'out' location’s zone is written to the transaction alert table. When a new transaction alert is added to 
the table, a notice will display to all WMS users that are assigned to the inventory zone. When a user 
acknowledges the alert and completes the transaction, that transaction alert row is moved to a history 
table along with the date and time that the transaction was completed.  
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MRO Work Order 

View or Create MRO Work Order 

This module allows the employee to view or create a Maintenance, Repair and Overhaul work order for 
the work centers associated to the processes that they are currently logged into. 

➢ To access an existing MRO work order or create a new one, select the Create MRO Work 
order button and enter the employee ID. A list of work orders the employee is logged into 

will appear. 

➢ Highlight a work order and select OK. MRO work orders associated to the work center(s) 
linked to the process associated to the selected work order will appear, if there are no MRO 

work orders the pick list will be empty. 

View Existing MRO Work Order: 

➢ To view an existing MRO work order highlight it in the pick list and press Select. The MRO 

work order screen will appear with the details of the work order, tasks, and Scheduling 
information. 
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The Work Order screen will display the basic information about the work order. The fields with data in 
the above screen shot are automatically filled in by the system. The Work Order Date and Start Date 
default to the date/time the work order was created. The WO Type defaults to Emergency. The user can 
make adjustments to the fields or add information in the ones without data. 

Other options: 

Select the corresponding speed button to access one of the following: 

▪ Filter – This will filter the pick list to display only open, only closed, or both types of work orders. 

▪ Print – This option will print a single work order or a range of work orders. 

▪ Search – This brings up a pick list of existing work orders. 

Tasks 

To view the Task information, select the ‘Tasks’ button. From this screen the user can associate labor 
and material to the task, create notes, and close task(s) once completed, by using the speed buttons. 
There is also a Quick Inspection button which will access the Quick Inspection module for the equipment. 
If the equipment has not been added to the Inspection Setup module a warning will appear stating, 'The 
selected MRO Equipment has not been configured for SPC'. 

Task Details - The Task Details such as General, Checklists, and User Fields can be displayed/hidden by 
selecting the double blue arrow button. When displayed, information such as Code and Comment can be 
entered on the General tab. If the task has a checklist associated to it users can select the Checklist 
button to enter the status of the checklist items. This form functions similar to the MRO work order form 
within the MRO Module. 

Close Work Order - After selecting Close Selected, or Close All the Close Work Order screen will appear.  

Task Values: 

▪ Closed Date - Use this field to enter the actual date and time the task was completed. The 
information will default to the current date and time. Click on the drop down calendar to select the 
date. Use the up/down arrows or type in the time the task was completed. The date and time can 
also be changed by selecting the 'Date' speed button at the top of the form and entering the 
information in the pop up box. Changing the date is available regardless of which Task Unit 
Count/Task Reset Option that is selected. 

▪ New Total Units - This is the Current Total Units less the Starting Units. This value can be changed by 
typing over the calculated value. The value in this field will carry over to the Total Units for the task 
on the Tasks tab on the main screen. If the task is not associated with an equipment the user will not 
be able to edit the field. 

▪ Starting Units - This is the starting units on the task when the work order was created. 

▪ Current Total Units - This field will display the current total units for the task found on the Tasks tab 
on the main screen. 
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▪ Incomplete - Click the Incomplete? button to change it to Yes if the task was not completed. The task 
line will be yellow. Labor and inventory can still be entered. Marking a work order incomplete will 
reset the New Total Units to zero by default when the reset when closing or zero when closing task 
unit count parameters are used. Users can manually adjust the New Total Units, if it is not desired 
that they return to zero. Both the starting units and current total unit information is available. 

Select the Disposition Attached Inventory and Attached Labor buttons to enter the labor and disposition 
inventory from the corresponding forms. 

Note: The 'Include Materials Backflush' option is disabled when dispositioning manufactured inventory 
through a MRO work order, preventing the backflush of the manufactured item components.  

(For additional information on entering this data please see the MRO help file available by selecting 
Help->Contents from within the MRO module). 

Create New MRO Work Order: 

To create a new MRO work order select New from the Select Work Order pick list. Since the system 
knows the Process the user is logged into, if there is only one work center setup under Qualified work 
centers associated to the process, the system will use that work center to create the MRO work 
order.  If more than one work center is setup under Qualified work centers, a pick list of those work 
centers will appear so the user can select the work center to create the MRO work order for. 

Once a work center is selected or if there is only one work center, a pop up box will appear to enter a 
Free Form task description. The employee can enter the hours and people to perform task the task, if 
known. 
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Select OK and the MRO work order will automatically be generated and will appear. If desired the user 
can select the Printer icon with a destination of email to send it to the individual responsible for 
performing the maintenance. 
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Heijunka 

Heijunka is a Japanese term that refers to the overall leveling, in the production schedule, of the volume 
and variety of items produced in given time periods. Heijunka is what most lean companies are working 
towards as they try to be able to make just what the customer wants in the time or when the customer 
wants it. In Heijunka, the company is trying to do two things. One is to level production by volume and 
the other is to level the production by product type or mix of products. Heijunka takes the total volume 
of orders in a period and levels them out so the same amount and mix are being made each day. In 
short, what you are trying to do is to build a level schedule everyday by taking the actual customer 
demand, determine the pattern of volume and mix, and building your level schedule. 

A tool used to help level both the mix and volume of production is a Heijunka box.  A Heijunka box has 
a column of kanban slots for each pitch interval, and a row of kanban slots for each product type.  
Kanban are placed into the leveling box in the desired mix sequence by product type. 

To enable Heijunka scheduling, check the ‘Heijunka/KanBan Scheduling’ option in System Parameters > 
Application tab.  Once this option is checked, the user will need to log out of EnterpriseIQ and log back 
in to see the Heijunka Box icon on the Manufacturing tab.  The Heijunka Box icon will also be available 
in EIQ and AssemblyData. 
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Field Information: 

Name Name of the Heijunka Box. 

Description Description of the Heijunka Box 

Mfg Cell The Mfg Cell of the Heijunka Box. 

Work Center Type The work center type of the Heijunka Box. 

Demand Period The Run scope of the Heijunka family.  The Mfg # run scope must be equal to the 
Heijunka run scope.  Once a BOM is part of a Heijunka family, the run scope on the BOM 
cannot be changed.  

EPEI Every Product Every Interval - The smallest possible lot size for a part in a process is a 
reflection of the “production interval” or “EPEI”. This interval defines the maximum 
frequency that you can produce each part without running out of capacity because of too 
many setups on all parts. It is an expression of how frequently each item produced in a 
process can actually be run without incurring a capacity penalty.  This value is calculated 
or a user defined EPEI formula can be created and assigned. 

Formula Name - The EPEI formula assigned to the Heijunka Box.  If left blank, the system 
uses the default EPEI formula 

EPEI Stats: 

▪ Last Recalc 

▪ Daily Avail (min) 

▪ Daily Load (min) 

▪ Daily Setup (min) 

▪ EPEI 

▪ # Change Over 

Fixed Pitch The frequency at which finished goods are withdrawn from a pacemaker process as well 
as the corresponding amount of schedule released to that process. 

The default formula for Fixed Pitch = (Std Container Capacity * longest cycle time of the 
items) * 3 

Formula Name – The Fixed Pitch formula assigned to the Heijunka Box.  If left blank, the 
system uses the default Fixed Pitch formula. 

Report Production 

Production can be reported from this screen for manufactured items. If a card is yellow users can double 
click on the item # to access the Report Production form. 

Top Section Fields: 

▪ Pacemaker – only applicable for manufactured items  
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▪ Item # - Displays the Item #, Description, Ext. Description, Class, Rev, and UOM of the item.  

▪ Backflush – only applicable for manufactured items 

Non Serialized Items:  

The Enter Quantity tab will only be visible for non-serialized items. To report production enter a quantity 
in the Good Parts field, and enter a lot number if applicable. A Manual/Backflush In transaction will occur 
for the quantity of good parts entered. The Backflush check box will be checked if the 'Scanner Print 
Label/Backflush' check box is checked for the item in Kanban Control in EIQ. It cannot be check or un-
checked from this form. 
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Serialized Items: 

Scan Serial  is available for SIC items.  Select the search button to access the pick list of all SN#s for 
this item that have not been dispositioned.  A Manual/Backflush In transaction will occur for the 
quantity associated to the serial number. 

 

Print Labels tab  

This is only applicable for manufactured items. The default information will populate in the other fields 
as with all labels. Make any necessary changes on the General tab or User-Defined tab and select the OK 
button to print the label. A Manual/Backflush In transaction will occur for the quantity associated to the 
label. 
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Barcoded Labels 

The Barcoded Labels module allows the user to create labels for the inventory item associated to the 
work order they are currently logged into, or reprint a tote label. 

Create Label: 

Select the Barcoded Label button on the module toolbar, and then select the Tasks button. 

➢ Enter the employee ID and a list of work orders the employee is logged into will appear. 

➢ Highlight a work order and select OK. The Print Inventory Barcoded Labels screen will 
appear for the item associated to the selected work order: 
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➢ If necessary update the information in the fields on the General and User-Defined tabs, 

enter the labels quantity, and then select the Print Label button to print the labels. 

The New Label button gives the user access to the Label Maintenance form. 

Reprint Label: 

Select the Reprint Label button to reprint a Tote Label. 

Scan the serial number and select OK. The Tote label for the specified serial number will print. 
 

Serial # Tracking 

Serial Number Tracking is used to view label information for specific Serial Numbers. 

EnterpriseIQ uses a master label table to manage the data from the creation of labels. Every label 
created through EnterpriseIQ adds a record to this table, and each record/label is assigned a unique 
serial number. 

The information stored within this table is based on when the label was created. It is essentially a record 
of the label itself, though other tables are actually used to create the label. Note that data elements such 
class, itemno, description, serial number and FG_lotno are part of this table. This provides easy access to 
the pertinent manufacturing data included in the box or package containing the label. 

The serial number is stored as a character string (typically nine digits), preceded by leading zeros. It is 
based on the unique ID number automatically assigned during the creation of the label. 

To view the label data based on the serial number select the Serial # Tracking button from the Menu in 
AssyData. A pop up form will appear to enter the serial number. To enter a serial number select the 

 button next to the field to access the keyboard. Or select the search button to access the pick list 
of serial numbers. The pick list includes fields such as: serial #, item information, print date, quantity, and 
VIN #.  
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Once entered select OK. 
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The Serial Number Tracking form will appear displaying the details about the label. The transaction log 
details for the serial number will be visible for packages that have been dispositioned with labels.  

Container Labels - If the label is a pallet label the form will display information for the pallet, containers 
on the pallet, and if foreign serial numbers were used to fill the containers those will show also. 
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Dimensional Inventory - This tab will display the Dimensional Inventory information for the serial # for 
serialized inventory control (SIC) items. The information on this tab is not editable. (The tab is visible for 
non-SIC items as well but will not have information). See Printing Labels for more information on 
Dimensional Inventory. 

User-Defined - This tab displays the user fields from the Print Label form. The information on this tab is 
not editable 

VIN Tracking - This tab will be available for users licensed for VIN Generator.The information comes from 
the VIN_HISTORY table which is populated based on the table below. 

Note: The VIN History table will not populate the VIN # unless the Config Code is populated in inventory 
on the Manufacturing tab.  

Field Name in 
system 

(if applicable) 

Column Name in data 
base 

When the field is 
populated 

VIN Number VIN_NO VIN Generation 

Serial # SERIAL VIN Generation 

Config Code SMART_CODE VIN Generation 

 ARINVT_ID VIN Generation 

Item # ITEMNO VIN Generation 

Rev REV VIN Generation 

Class CLASS VIN Generation 

Description DESCRIP VIN Generation 

Ext Description DESCRIP2 VIN Generation 

Mfg # MFGNO VIN Generation 

 STANDARD_ID VIN Generation 

Weight CONFIG_WEIGHT VIN Generation, can be 
edited 

GAWR GAWR VIN Generation, can be 
edited 

GVWR GVWR VIN Generation, can be 
edited 

Tire Size TIRE_SIZE VIN Generation, can be 
edited 

Rim RIM VIN Generation, can be 
edited 

PSI PSI VIN Generation, can be 
edited 
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Single/Dual SINGLE_DUAL VIN Generation, can be 
edited 

Vehicle Attributes VEHICLE_ATTRIB VIN Generation 

Spare Tire SPARE_TIRE VIN Generation, can be 
edited 

Number of Axles NUM_AXLES VIN Generation 

Model Year MODEL_YR VIN Generation 

 ARCUSTO_ID VIN Generation 

Company ARCUSTO_COMPANY VIN Generation 

Order # ORDERNO VIN Generation 

Updated with Packing 
Slip generation 

 ORD_DETAIL_ID VIN Generation 

PO # PONO VIN Generation 

Work order Number WORK ORDER_ID VIN Generation 

 LM_LABELS_ID VIN Generation 

 CRM_QUOTE_DETAIL
_ID 

VIN Generation 

Sales Value UNIT_PRICE VIN Generation 

Sales List Price LIST_UNIT_PRICE VIN Generation 

Dispo Date DISPO_DATE Reporting Final Assy or 
RT Scan to Inventory 

Lot # FG_LOTNO Reporting Final Assy 

Location LOC_DESC Reporting Final Assy 

 SHIPMENT_DTL_ID Packing Slip creation 

Config Choices ARINVT_CARGO.DATA
1  

VIN Generation, can be 
edited 
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Note: When a VIN label is generated/printed it contains customer and sales order information, and it also 
generates a master_label record with the same detail.  When a RF/WMS user has the Verify order 
option=Y and ships the label toward a different order and customer the ARCusto_ID, ARCusto_Company, 
OrderNo, Ord_Detail_ID, PONo, and CRM_Quote_Detail_ID fields in master label and VIN_History tables 
are updated. 
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Repack To and Repack From Information 

If the label has been repacked to or from another serial number that information will display in the 
'Repacked To SN#' and 'Repacked From SN#' fields in the upper section.  Only the first serial number 
will appear in the top section. An additional grid displays at bottom of the form for 'repacked to' serials. 
This will list multiple serial numbers when applicable. Right click in the lower grid and select 'Jump to SN' 
to jump to the repacked to serial number. The Serial Number tracking form will open to the highlighted 
serial number. 
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Right Click Options from the Upper Section 

▪ Drill Down by Lot # - This option opens the Lot Number Tracking form for the item associated with the 
label. 

▪ Jump to Inventory - Jumps to the inventory module for the item associated to the label. 

▪ Jump to BOM - Jumps to the BOM for the item. If the item is not associated to a BOM, the BOM pick 
list will appear. 

Speed Button Options 

▪ Search Serial # - This brings up the form to enter the serial number to search for. 

▪ Reprint Label - This option will reprint the label.  

Reprint a Range of Labels 
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Enter the From and To serial numbers using the keyboard accessed by clicking the button next to the 
fields, and select Apply. The labels will be listed in the lower section displaying the label details such as 
Item #, Description, Qty, Shipped, etc. 

Default Label - Toggle the search button and select a label format to use for reprinting all selected labels. 
Once a default label format is selected, a pop up message will display stating, "Do you wish to update all 
the labels in the range?". Click Yes to update all of the selected labels with the selected label format. 
Clicking No will return the user to the reprint form with no changes. A different label can be selected for 
a specific serial number by clicking on the ellipsis button in the Label field in the lower section. The pick 
list of labels will appear to choose from.  

Setup CRW Printer - This allows users to select the CRW printer for reprinting the labels. This alleviates 
the user from having to select a printer for each Crystal label. Select the ellipsis button to bring up the 
Print form to select a printer.  If a printer is selected, when clicking on Reprint, the system will use the 
specified printer for printing all of the CRW labels.  

To reprint all of the listed labels select the Reprint button. 

If a default label is not selected, and the option in System Parameters -> Label Setup->Reprint Original 
Label is checked the system will reprint the label based on the Master_Label.LM_Labels_ID. If it is not 
checked the system will reprint the label based on the label hierarchy. 

Foreign Serial Numbers 

Foreign Serial numbers are serial numbers from labels typically from purchased items. Foreign serial 
numbers may contain up to 50 alphanumeric characters. Foreign serial numbers can be linked to boxes 
with labels bearing EnterpriseIQ generated serial numbers. This link is done through the Scan Line 
module. (Please refer to the Scan Line TechNote for more details). Once in place, the system can be used 
to trace foreign serial numbers back to the box and pallet used during packing and shipment. To trace a 
Foreign Serial number, select the 'Foreign' box on the Serial Number form and enter the foreign serial 
number. The system will display the boxes/pallets that are associated with that foreign serial number. 

Void Labels 

This option will allow the user to void a range of labels. The label can only be voided if it has not been 
dispositioned or used in a shipment. This function will remove the label permanently from the master 
label table. 

Select the Void button from the search form. Enter the range of labels in the from and to fields and 
select Apply. The selected labels will appear in the lower section. If the label cannot be deleted it will 
appear in red. 
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Select the Void button to complete the process. To exit without voiding the labels select Cancel. 
 

Kanban Supermarket 

This button provides users direct access to the Kanban Cards. 

Select an item from the pick list and the Kanban Supermarket form will appear. The form displays the 
Kanban cards. The screen shot below shows the fields when the item is marked as a serialized inventory 
control item. Non-serialized items will not have the Serial #, Location, Qty, Lot #, or Inventory Status 
fields. 
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To create Kanban cards select the Insert (+) button. Continue this process to create the recommended 
card count quantity. Each Kanban card will be assigned a unique card number which is used in RF 
Scanning. Select the Print button to print each card. (The report used is assigned in System Parameters-
>Reports and Forms). These cards are attached to the container of material. When first created the 
status of the cards are inactive. The status of the cards are changed using IQRF. The status can be either 
On Hand or On Order. As the status is changed the color code is changed on this form. Green indicates 
on hand status and yellow indicates on order status. The user name of the person who last changed the 
status will populate in the Last User ID field. 

Kanban Cards Grid 

▪ Cards – Displays whether the card is in the Kanban Rack or Inventory. 

▪ Status – When Kanban cards are first created, the status of the cards are inactive.  The status of the 
cards can be changed either manually or through IQRF/WMSIQ.  The status can be either On Hand, 
On Order, or Pending Accumulation.  As the status is changed the color code is changed and the 
card moves back and forth between the Kanban rack and Inventory. Green indicates on hand status, 
yellow indicates on order status, and blue indicates pending accumulation. 

Note: The status can be changed manually within this form but when done this way it will not update 
the PO releases, therefore it is not recommended. Only use IQRF.   

▪ Last User ID – the last user ID when the Kanban card’s status is changed. 

▪ Card # - The card number. 

▪ Additional fields for Serialized items:  Serial #, Location, Qty, Lot #, and Inventory Status. 

Kanban Card Speed buttons 

▪ Print Card(s) – Allows the user to print the cards. 

▪ Assign label to the kanban card – Allows the user to assign an existing label to a kanban card. 

Kanban Supermarket Options: 

The same functionality available from Kanban Control exists in Kanban Supermarket, such as reporting 
production and assigning serial numbers to cards. For a complete discussion of these options please 
refer to Kanban for Purchased Items or Kanban for Manufactured Items depending on the type of item. 
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Rejects 

The Rejects module allows the employee to enter rejects for manufactured parts or components 
associated to the work order they are currently logged into. Supervisors can enter rejects for any process 
that is logged into. 

Select the Rejects button on the module toolbar. 

➢ Enter the employee ID and a list of work orders the employee is logged into will appear, or if 

a supervisor ID is entered than all logged in processes will appear. 

➢ Highlight a work order and select OK. Select Reject Components or Reject Mfg Parts. 
 

Reject Components in Assembly Data 

The Rejects screen will appear displaying the components associated to all of the processes (Materials 
tab in Assembly Process Maintenance module), and items that are substituted or added to an assembly 
work order through hard allocation, will be displayed in the lower components section. Employees can 
reject components for prior processes than the one the employee is logged into. If any of the 
components are associated to processes beyond the logged in process they will be grayed out and the 
employee cannot reject those components at this time. Note: If the process does not have attached 
components the employee will receive an error: “Unable to report rejects - selected process has no 
attached components”. 
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➢ To enter rejects highlight the correct process/component, select the + button, and enter the 
Reject Qty in the field.  Enter the reject code or select the button in the Reject Code field to 

access the pick list of reject codes to select from. If specific reject Codes are assigned to the 

process, only those codes will be available to choose from. If no specific reject codes are 
assigned to the process then the user will see all based on the EPlant logged into. Optionally 
enter a Reason. Select the keyboard button in the field to access the touch screen keyboard. 

From this form users can select the specific location/lot to remove the rejected components from. This is 
optional unless the 'Component Reject Location is mandatory' option is checked for the Manufacturing 
Cell (System Parameters->Lists->Manufacturing Cells). If the option is not checked the bottom section 
will display 'Optional'. If it is checked it will display 'Mandatory'. If required and a location/lot is not 
selected an error will appear stating: 'Missing mandatory location - operation aborted'. If the Qty 
entered for the location(s) does not equal the Reject Qty an error will display: 'Location total qty is out of 
sync with the rejects qty - operation aborted'. 

▪ For Non-Serialized Inventory Control (SIC) components, select the ellipsis button in the Location field 
and a pick list of locations associated to the component will display. Select a location/lot from the 
list. The quantities of the rejects will be removed from the location(s) chosen (negating the 
hierarchy). 

▪ If the component is SIC, select the ellipsis button in the Location field and a pick list of locations 
associated to the component will display. Once a location is selected, then the labels linked to that 
location will display for the user to choose from. 

Note: Rejected components cannot be over reported or under reported on the location level in relation 
to the totally reject quantity. 

➢ Select Next, verify/edit the FG Lot #. If the Lot # is changed a Confirm message will display, 

'The labor reporting lot number must match the FG lot number in order to obtain lot 
traceability of the backflushed components. Are you sure you want to change the labor 
reporting lot number?'. Select Yes to continue or No to not continue posting. There is also a 

'Do not show next time' check box. 

➢ Select Finish to execute the transaction. A Manual out transaction will be recorded in the 
transaction log for the component. 
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Reject Mfg Parts in AssyData 

To enter reject information for the manufactured part for ASSY1, 2, and 3 items select the ‘Reject Mfg 
Parts’ option and enter the number of rejects and select the reject code on this screen: 
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➢ Select the Next button to continue. The Reject Component screen will appear to enter 

rejects for the components as described above. When a value is entered in the Reject Mfg 
Parts field the system will automatically calculate the quantity of components associated to 
the process based on the parts per, and that value will be displayed in the Reject Qty field 

for the attached components. This value can be overridden. If the ‘Exclude Backflush’ option 
is checked for the component (Attached Materials-> Details tab on the BOM), then the 
system does not automatically create a reject entry for the components, however, the user 

can enter component reject information in manually. 

➢ If the selected reject code has a non conform location associated to it (Reject Codes list) the 
system will do an IN disposition transaction with a reason of 'Non Conform Mfg Rejects' for 

the quantity rejected into the location associated to the reject code. (This does not update 
the Floor Dispo column in the production report). Once the reject is posted a form will 
display to enter the FG Lot #, Non Conform Code and prepare labels. Enter the FG Lot # in 

the field if desired. If the item has the 'Lot # is mandatory' option checked in inventory it is 
required. Select the Non Conform Code from the pick list accessed by clicking on the ellipsis 
button in the field. This will be the non conform code associated to the non conform location 

in inventory. Labels can be prepared by manually entering in the number of labels and 
quantity per label, or existing label serial numbers can be selected from the pick list. 
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➢ Once the components reject information is entered, select the Next button to continue. 

➢ Select Finish to post the transaction. 

➢ For users licensed for the Quality modules, a pop up message will appear asking, "Would 
you like to create an MRB?" If Yes is selected a pick list of existing MRBs will appear to add 
the item to, or select the New button to create a new MRB. If No is selected the material will 

be toggled to non-conform without being associated to an MRB. Security can be placed on 
this message.  

Note: The logged in user ID will populate in the REJECTS table in order to track who reported rejects. (In 
shop floor applications like AssyData that are shared among more than one user, the user recorded is the 
user logged into the application, not who entered the transaction). 
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Dispatch List in AssemblyData 

Select the Dispatch List button on the module toolbar to view processes on the selected Work Center.   

Note: There is a Control option available in Configure AssemblyData called Dispatch List shows all 

processes on certified work centers. When toggled to Yes the Dispatch List will display all processes from 
the Assembly Dispatch Priority List and any processes that have the work center certified in the Process 
Maintenance. If it is set to No, only work orders in the dispatch list will display. 

The processes that appear in the Dispatch List depends on how the process is set up and the control 
option described above.: 

▪ If the option 'Dispatch List shows all processes on certified work centers' is checked, processes that 
are in Assembly Track will be visible on Work Centers with the corresponding Center Type. 

▪ If a Qualified Work Center is associated to the Process then the process will only be visible to those 
Work Centers in AssemblyData.   

▪ If the process is added to the Dispatch List within Assembly Track then the process will only be visible 
to the Work Center the process was dispatched to. 

This screen displays similar fields that are found in the Assembly Track module such as Progress %, Hours 
to Go, and Priority information. The Processes must be part of the work orders that are on the top grid of 
the Assembly Track module to be visible in the Dispatch List. The order of the work orders is based on 
the Dispatch Priority List in Assembly Track. If no work orders have been scheduled in the dispatch list 
they will be in order based on the work order’s Must Start Date. 
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To select a Work Center use the pick list button to access the pick list of work centers, or the scroll 
buttons to scroll through the work centers to find the desired one. The pick list includes work center #, 
description, type and Mfg Cell. It also has the Advanced filter feature. Note: The chosen work center is 
remembered in the registry so it will automatically come up the next time the Dispatch List module is 
selected. 

Along side the work center field the Service Out and Service In dates are displayed. If service dates have 
been entered in the Maintenance, Repair and Overhaul module for the work center, those dates will 
appear in these fields. 

Filters 

There are two filter option to filter the records displayed in the lower section: 

▪ Inventory Group - User can select an Inventory Group to filter the records displayed based on the 
Inventory Group associated to the Item. Select the ellipsis button to access the pick list to choose an 
inventory group. 

▪ Days Out Filter - This filter allows users to enter the number of days to filter the records displayed 
based on the must start date. Select the ellipsis button to access the keypad to enter a days out 
value. 

Below is an alphabetical list of the fields that are visible in the Dispatch List. These are some of the same 
fields that are in the Assembly Track module. Users can sort the columns in AssemblyData. 

EPlant ID This is the EPlant ID associated to the work order. 

Hours To Go [Cycle time / multiple of / (yield/100)] * (WO Qty – Qty) 

Item# This is the item number associated with the work order. 

Item Description The description of the item number associated with the work order. 

Logged In This box will be checked if an employee is clocked into the process. This will allow 
the employees to see what jobs/processes are being worked on. 

Lot # Lot # 

Mfg # This is the Mfg # (BOM) associated to the work order. 

Must Start This is the calculated must start date for the work order. 

On Hand The On Hand quantity for the item. 

Previous Process This includes the Process #, Description and quantity Completed of the previous 
process. 

Priority Note 1 & 2 The priority Notes from the work order. These cannot be edited from here. To 
make changes to the Priority Note field(s), right click and jump to the work order. 

Process Details The process operation number and description. 

Process Seq Process sequence number. 
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Progress Progress % = (Qty / WO qty) * 100 

Note: The progress percentage takes into account any rejected mfg parts and 
updates the progress percent for each process where more components will be 
needed. (See the Progress % details in the Middle Section table for Assembly Track 
for a calculation example). 

Progress bar colors - compares the actual parts per hour versus the standard parts 
per hour. 

Actual parts per hour = qty / sum(time out – time in) for that process / # of 
Processes the employee was logged into simultaneously 

Standard parts per hour = 1 / [Cycle time / multiple of / (yield/100)] 

If actual is 100% or greater than standard, then the bar is green 

If actual is 95 – 99% of standard, then the bar is yellow 

If actual is less than 95% of standard, then the bar is red 

Qty Sum of the process quantity (from table: TA_LABOR.process_qty) for the specific 
WO/Process. 

Qty to Complete The number of items to be completed. 
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Rejects The number of Mfg Parts rejected. 

Release Date The first release date from the sales order. 

WO # This is the work order number generated by the system to produce the items 
required to meet demand. 
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WO Print Date The date the work order was  last printed. This will be updated when the work 
order is printed from a speed button no matter where the speed button is. 

WO Printed By The user who last printed the work order. 
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Additional Options: 

▪ Hide Records - Select the Filter button to hide records where the Progress is 100% or greater. 

▪ Hide Sequential Processes - Click the second filter button to hide processes where the process before 
it in the routing is set to sequential and is not 100% complete. This applies across work centers. For 
example, if there is 'process 1' on work center A which is not 100% complete and 'process 2' on work 
center B, with the filter button on, work center B will not display 'process 2'. 

▪ Search Work Order # - Select the Search Work Order button to access the pick list of work orders for 
the current work center's dispatch list. 

▪ Print WO Traveler - Select the printer speed button to print the traveler for the highlighted work 
order. 

▪ VIN Generator - This will access the VIN Generator module. (See Vehicle Identification Number (VIN) 
Generator https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf TechNote for 
more information). 

Report Quantity - Select the Options button or right click and select this option to report Good 
Parts. When this is selected, a pick list of employees will appear. Select the employee and enter 
good parts. Labor hours will be displayed and calculated as the qty * standard labor hours. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/VIN-Generator.pdf
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Comments or a FG Lot # may be entered if desired. Select Post and Continue to go to the next 
screen. 

 

By default the system will use the disposition hierarchy when backflushing components (when 
the Finish button is selected), however users can optionally select the location(s) that inventory 
will be removed from. To select the location(s) click on the 'Consumed Materials' button.  
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Note: The Consumed Materials button is not available when clocking out of a task, it is only available 
when reporting good parts from the Dispatch List. 

From the Report Consumed Materials form select the ellipsis button in the Location field and 
select the location from the pick list. Enter the quantity in the Qty field. 
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For Serialized Inventory Control (SIC) items select the insert record button on the navigator bar to 
access the Select Labels form to choose the labels to disposition. Highlight the labels to 
disposition. If the user selects the ellipsis button in the location field rather than selecting the 
insert record button a message will appear stating, 'This is a serialized component - use navigator 
to add new labels(s) or delete selected record.Continue to next process'. 

 

 If Final Assy Reporting is designated on the process, the system will bring up the Final Assembly 
screen after posting the good parts. If the prior process is marked sequential processing, and is 
not completed, a pop up error stating, ‘Cannot Report Quantity. Process # xxx was not 
completed’ will appear, and the employee will not be able to report a quantity.  
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▪ Documents - Click the Documents button to access the Documents form, which also allows the user 
to access Internal and External documents and Routing Notes. The system will display a red ‘*’ next 
to the Documents icon indicating there are documents attached to the BOM, Process, Inventory item 
associated to the Work Order, or documents associated to the line item on the Sales Order. When 
selecting the Sales Order button a pick list of sales orders associated to the work order will appear. 
Select a sales order from the pick list and select Internal or External to view the documents. 

 

'Jump To' Right Click Options: 

▪ Jump to MPS Time Phase 

▪ Jump To BOM 

▪ Jump to Where Used 

Note: The target forms will not be converted to a touchscreen equivalents due to their high complexity. 
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Inventory Availability 

This module functions just like Inventory Availability module accessed from EIQ on the Sales/Distribution 
tab. From the Menu in Assembly Data select Inventory Availability. A pick list of inventory items will 
appear. Select the item from the list and then the following form will appear: 
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  Search Inventory - This speed button brings up the inventory pick list. 

 Search AKA Inventory - This speed button brings up the AKA inventory pick list. 

 EPlant - This speed button is used to filter for a certain EPlant if applicable. 

 Calculate Material Exceptions, Ideal vs Existing and Daily Material Requirements - This will recalculate 
material exceptions just as it does in Material Exceptions.  

A query is generated that returns the following grid. The top section includes item details such as Class, 
Item #, and Description, UOM and EPlant ID. 

The middle grid displays the current On Hand, ICT On Hand, Outsource On Hand, Ship Staging On Hand, 
Non Allocate On Hand, and Non Conform On Hand for the item and broken down based on Division(s). 

On Hand  Total of all inventory on hand for the division. 

ICT On Hand Intercompany In Transit (type #1) 

Outsource On 
Hand 

Items in transit to Outsource vendor (In Transit type #2) 

Ship Staging On 
Hand 

On Hand quantity for items that have been shipped but are awaiting verification (In Transit 
type #3) 

Non Allocate On 
Hand 

Non Allocate on Hand 

Non Conform On 
Hand 

Non Conform On Hand 
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Lower Section Tabs 

The information in the lower section will display the Current and Projected information based on the 
highlighted line in the middle section. It will display the details based on the division associated to the 
line. For example, for records where there is no division the system will only display records with no 
division. Select the 'Evaluate Inventory Available' (calculator) button to view the Available to Promise 
(ATP) details.  For the Item Summary Level, the Available to Promise calculation will use the Total On 
Hand available in the all warehouses less any VMI. It is calculated: (Total on hand for all warehouses + 
scheduled WO’s for specific warehouse) – (Backlog for specific warehouse).  

By clicking on the tabs in the lower section, you can view either the Current information or the 
Projected. Projected takes into account scheduled information, while Current only looks at actual sales 
releases. You can optionally view either Projected or Current information graphically. The tab the user 
was on last will be remembered in the registry. 

Note: The Projected tab does not display (Intercompany Transfer) ICT sales orders and they are not part 
of the calculation, however ICT orders will display on the Current tab. 

Unit of Measure (UOM) - Users can change the UOM to one of the UOM factors that are defined for the 
inventory item.  Select a UOM from the drop down list and then select the 'Apply UOM' button. This 
drop down list will show if the factor is designated for Sales Orders or Purchase Orders. The information 
in the lower section will change based on the selected UOM. 

Date Date an activity is scheduled to occur. In the case of sales orders, it is the date of release. In 
the case of scheduling, it is the date of production 

On Hand The current balance given that the previous event occurs. The On Hand quantity includes the 
Non-Allocated quantity. 

Note: If the item is running and a floor disposition is done, the on-hand will increase by the 
floor dispositioned amount, and the first Scheduled row will decrease by the floor disposition 
amount. 

IN If the items will be coming IN to inventory, via scheduled production, the daily projected 
amount will be shown here. This information is also visible in the Daily Parts Projection 
module (Scheduling-Requirements menu). 

This amount will be reduced by any floor dispositions that increased the associated On Hand 
value. 

OUT If the items will be going OUT of inventory via the sales release, this amount is shown here 

Balance At the end of the day, this is the projected inventory balance. Note that this value becomes 
the starting value for the next On Hand record 
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Source For manufactured items this field indicates whether the activity is based on the schedule 
(SCHEDULED), sales releases (BACKLOG), or awaiting inventory verification (STAGING). 

You can double click on a Backlog source to see the sales order information that includes the 
Order #, Ship Qty, Request and Promise date, Forecast attribute, and more. 

Double click on a Scheduled source row to access the work order information.  

Dependent Demand will display with a source of Required. 

For purchased items this field indicates whether the activity is based on the PO or REQUIRED. 

You can double click to quickly drill down to the purchase order or work order information.  

Available to 
Promise 

Available to Promise, also known as ATP, is a value that calculates by the day whether you 
have excess inventory that can be promised to your end user. 

This value is different from the daily on hand balance, as it must look into the future and 
determine if there is demand for the item that will consume the current inventory. 

For example, you may have several sales releases that demand X number of parts. If you only 
have enough on the floor and just enough in production to cover the demand, then your 
available to promise will either show zero or a negative number. 

However, if you have excess inventory and plan to make more beyond the actual demand, 
the system will indicate on what day in the future you can promise the inventory. 

The formula for ATP is: (On Hand - Non-Allocate + Scheduled WO's) - (Out in Staging + Backlog 
from Sales Orders).  

When Filtered for a Warehouse the calculation is: 

(Total on hand for all warehouses + scheduled WO’s for that warehouse) – (Backlog for that 
warehouse). 

Note: VMI is not included in on hand for the ATP calculation. (It is included in the value in the 
On Hand column described above). 

Note: The On Hand quantity can be reduced by the quantity in In-transit and/or Non 
Allocatable locations by checking the desired options on the Options menu. 

Right Click Options 

Right click in the top grid and the following functions are available: 

▪ Jump to Transactions/Locations - Select this to jump to the Transactions module for the highlighted 
item. 

▪ BOM Tree - This function brings up the BOM Tree information. This information shows all of the 
required components that make up the item. 
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Reports 

Select the Module Bar to access the list of options. Select Reports and the Registered Reports screen will 
appear with the reports that were added through Assembly Track. This screen functions the same as all 
reports menus throughout the system. 
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Reporting for All ASSY MFG Types Using IQRF 

For the ASSY MFG Type items the scan backflush option in IQRF can be used to report good parts or final 
assembly. To report good parts, scan a ‘Z’+dispatch ID.  To report final assembly, scan a ‘W’+ work 
order #, and upon posting a label is printed for the entire quantity. 

Reporting Good Parts 

Scan a Z + the dispatch ID associated to the process. Enter the Good Parts, Labor Hrs, Lot #, and a 
comment if desired. Select 1-Post to complete the transaction. The information reported in RF will be 
visible from Assembly Track. 

   

Reporting Final Assembly: 

Scan a W+the ASSY work order number. Enter the Good Parts and Lot #. Select 1-Post to complete the 
transaction. Once the post option is selected a label is printed for the entire quantity. 

   

Note for ASSY3: If the Backflush Each Process is unchecked for the ASSY3 mfg type the system will not 
backflush the material attached to the process; if it is checked, materials will be backflushed. 
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Transaction Information 

Below is a brief description of the transactions that occur during reporting for ASSY items. 
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Note: The system will use standard costs or actual costs depending on which option is selected on the 
System Parameters setting on the Inventory Setup tab. 

Note: When Actual or Standard Costing is enabled, when the following PIT transaction Types are 
prepared: Process WIP, Finish Process WIP, Adjust WIP, Process Reverse Backflush, they will affect the 
quantity in the ARINVT_WIP table. If the prepost or posted GJE are deleted or reversed and PIT is set to 
Unprocessed = Y, the quantity in the ARINVT_WIP table will be updated. After preparing the GJ Entries 
through PIT the system will populate/update the ARINVT_WIP table in order to keep track of the WIP 
transactions for costing purposes. If costs are re-evaluated the WIP Account is debited with the 
difference between the new and old std cost * quantity in WIP and the system will credit the inventory 
cost revalue acct with the same amount. 

Note: When posting Process WIP, Process Reverse Backflush, and/or Adjust WIP transactions when using 
Actual Costing, the Labor and Overhead records are not created for the ARINVT_WIP table.  Records 
are still created in Standard Costing. 
 

Labor Reporting Transaction 

Time & Attendance posting based on Clock In/Out in AssemblyData or Labor Reporting in Assembly Track 

This does not affect the manufactured item’s inventory; Manufactured inventory is not affected until 
Final Assembly. 

An IN transaction with a type of ‘Process WIP’ is created in translog for the manufactured item with a 
transaction quantity of zero. Dependent transactions are created for attached components, labor and 
overhead. In Post Inventory transaction (PIT) the transaction for the consumed components will fall 
under the Process WIP transaction type. The transaction will be a debit to the work in process account 
and a credit to the item’s Dispo GL account. 

 

Debit Credit 

    WIP    Inventory Dispo GL  

   components, pkg, etc) 

Note: The default WIP Process account is set up in System Parameters->GL Setup tab. This can be 
overridden at the inventory level from the Modify GL Accounts feature accessed from the Options menu. 

Good parts (Process_Qty) will be captured in TA_LABOR as well as the labor hours and production date. 

The source = WO, and the Source ID = the WO #. 

The Cost Element hierarchy for labor when reporting Process WIP as follows: 

1 Employee Maintenance > Misc. tab 
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2 Assembly Process Maintenance > Standard Cost tab 

3 MFG Type > Labor/Overhead tab 

4 "Labor" (text) 
 

Reject Components Transaction 

During Labor Reporting components can be rejected (see Report Rejects). This will be a Manual 
Transaction Type in PIT. Components are backflushed. 

The system will debit the account associated to the reject code if there is one otherwise it will debit the 
variance account. 

Debit Credit 

Variance or GL Acct 
associated to Reject 
Code 

Inventory Dispo GL (components, pkg, 
etc)    

 

 
 

Void Rejected Component: 

PIT Manual Transaction Type. Components are added back into inventory (Manual/Backflush transaction 
type). (This is done from the Rejects portion of Assembly track – right click and select show details. Right 
click again and select Void reject Entry – see Void Rejects). 

 

Debit Credit 

Inventory Dispo GL  

(components, pkg, etc) 

Variance or GL 
Acct 
associated to 
Reject Code 
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Reject Mfg Parts during Labor Reporting 

PIT ‘Manual’ Transaction Type. Components are backflushed. 

The system will debit the account associated to the reject code if there is one otherwise it will debit the 
variance account. 

 

Debit Credit 

Variance or GL 
Account 
associated to 
Reject Code 

      Inventory Dispo GL  

     (components, pkg, 
etc) 

 

For Previous Process: 

Debit Credit 

Variance    WIP 

Note: For a previous process the credit cannot hit the GL Acct on the Reject Code because the previous 
process MFG Part never hits the reject table therefore there is no link back to use that Reject Code GL 
Acct.  
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Void Rejected Mfg Parts: 

When voiding rejects from the Rejects portion of Assembly track. (Right click and select show details. 
Right click again and select Void reject Entry – see Void Rejects). The transaction depends on the method 
used when rejecting the Mfg part: 

 

Debit Credit 

  Inventory Dispo GL  

 (components, pkg, etc) 

Variance or GL 
Acct associated to 
Reject Code 

          

               

For Previous Process: 

Debit Credit 

    WIP Variance  

 

Note: For a previous process the credit cannot hit the GL Acct on the Reject Code because the previous 
process MFG Part never hits the reject table therefore there is no link back to use that Reject Code GL 
Acct.  

For example: 

Assume 2 processes A and B;  

Process A consumes X 

Process B consumes Y 

If the user rejected B through labor reporting, voiding will result in:      

    

Item  Trans. Type    In/Out   Inventory is affected 

 ----    ------------          -------    --------------------- 

   Y     MANUAL           IN       Yes                   

   X     ADJUST WIP    IN       No     
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Only Rejects get updated. 

 

If the user rejected B as a reject through show details, voiding will result in:   

             

Item  Trans.  Type    In/Out   Inventory is affected 

 ----      ------------         -------    --------------------- 

   Y     ADJUST WIP    IN       No                    

   X     ADJUST WIP    IN       No                    

Rejects and quantity completed are updated. 
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Void Good Parts (Reverse Backflush) 

This option is available from the middle grid, right click from the Process Details screen. (Right click and 
select show details. Right click again and select Void->Void Good Parts – see Void Options). 

PIT 'Process Reverse Backflush ’ Transaction Type. 

▪ Displays Labor and Overhead transactions in translog. The Transaction Type is ‘Reverse Backflush’ 
and the Transaction Reason by default is ‘Void ASSY1 Good Parts’. 

▪ Puts consumed components back into inventory (IN transaction, Trans Type is Reverse Backflush). 

▪ Creates an OUT transaction with transaction quantity of 0 for the manufactured item, and creates a 
disposition transaction for the components as a credit to the work in process account and a debit to 
the item’s Dispo GL account. 

▪ Updates ta_labor.process_qty for the manufactured item. 

 

Debit Credit 

 

Inventory Dispo GL  

     (components, pkg, 
etc) 

 

     WIP 
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Report Existing As Rejects (Adjustment): 

This option is available from the middle grid, right click from the Process Details screen. (Right click and 
select show details. Right click again and select Void->Report Existing As Rejects – see Void Options). 

PIT ‘Adjust WIP’ Transaction Type. 

 

Debit Credit 

Variance  WIP 

 

▪ Adds a record to rejects. 

▪ Updates ta_labor.process_qty and reject_qty. 

 
 

Void Rejected MFG Part (Report Existing As Rejects): 

PIT ‘Adjust WIP’ Transaction Type. 

 

Debit Credit 

WIP  Variance 

 
 

Final Assembly 

An IN transaction is created in translog for the manufactured item with a Trans Type of ‘Finish Process 
WIP’ and a reason of ‘Final Assembly’. 

The Disposition is based on the hierarchy: 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Designated work center location 

5 MFG Cell Dispo locations 

6 MFG Type Dispo. Designators 
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7 FIFO 

8 Temporary 
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Final Assembly Reported in Assembly Track 

An entry will be visible from Post Inventory Transactions as a Finish Process WIP transaction type. The 
work in process account will be credited. 

 

Debit Credit 

FG Inventory  WIP 

 Labor Absorbed 

 Overhead Absorbed 

 

Final Assembly Reported in AssemblyData 

TA_LABOR is not posted automatically after reporting labor/good parts.  Labor is posted through Time 
& Attendance Task Clock In/Out Maintenance. 

Before Labor is posted: 

Final Assembly – PIT Finish Process WIP Transaction Type 

 

Debit Credit 

FG Inventory  WIP 

 Variance (mfg items) 

 

 

After Labor is posted: 

Final Assembly – PIT Finish Process WIP Transaction Type 
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Debit Credit 

FG Inventory WIP 

Labor Absorbed 

Overhead Absorbed 

 

Note: When using a substitute ASSY BOM, the system will not calculate the standard cost based on the 
substitute BOM. It calculates the standard cost based on the default BOM. When a substitute BOM is 
used for an ASSY1/2/3 BOM, upon reporting Final Assembly, the variance will be forced to the default 
Finish Process WIP Variance GL account in System Parameters. If this account is not filled in, the default 
Production Variance Account is used.  

Note: The Process Cost/Actual Cost may be higher if components are rejected on the process because 
the cost of the rejected component will be part of the actual cost on the FG item. If the reject should not 
be part of the actual cost than the component can be rejected through Transactions and Locations or PO 
Receiving. 

The Translog cost element for OVERHEAD is populated according to the following hierarchy: 1) The 
element for OH on the Process (on BOM), 2) If that is not populated, the system will use the overhead 
cost element on the ASSY MFG Type. 

 
 

Final Assembly Reported in Assembly Track: 

An entry will be visible from Post Inventory Transactions as a Finish Process WIP transaction type. The 
work in process account will be credited. 

 

Debit Credit 

FG Inventory WIP 

Labor Absorbed 

Overhead Absorbed 
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Final Assembly Reported in AssemblyData: 

TA_LABOR is not posted automatically after reporting labor/good parts.  Labor is posted through Time 
& Attendance Task Clock In/Out Maintenance. 

Before Labor is posted: 

Final Assembly – PIT Finish Process WIP Transaction Type 

 

Debit Credit 

FG Inventory WIP 

Variance (mfg items) 

 

NOTES: 

The Variance accounts will be hit only if the ‘Include Overhead and Labor variance’ option is checked in 
System Parameters. 

If the PIT Finish Process WIP transaction is posted before labor is posted from Time and Attendance, 
then a manual adjustment will need to be done to correct the WIP account as the Labor and Overhead 
will be posted there. 

After Labor is posted: 

Final Assembly – PIT Finish Process WIP Transaction Type 

 

Debit Credit 

FG Inventory WIP 

Labor Absorbed 

Overhead Absorbed 
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Actual Cost Example 
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